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C H A P T E R  1  

How to find help 

1.1  Use the quick reference booklet 

A quick reference booklet is included in the box containing your SuperNova 

software. This book contains information on getting started with SuperNova, 

covering the popular hot keys you use with this software. 
  

1.2  Hotkey Helper 

SuperNova contains a large number of hot keys for accessing useful 

features or product settings via a quick simple keypress. SuperNova's 

Hotkey Helper function helps you find the correct hot key combination for a 

specific feature or product setting when you can't remember what the hot 

key is.  

For example, if you have a speech edition of SuperNova, you may want to 

find the hot key combination for announcing the contents of Excel's formula 

bar aloud. So instead of opening the SuperNova application-specific help 

file for Excel and reading through all of the available hot keys, or entering 

SuperNova's Key Describe Mode, CAPS LOCK + FORWARD SLASH, and 

then pressing various key combinations until you find the correct hot key, 

you can instead open SuperNova's Hotkey Helper window, by pressing 

LEFT SHIFT + CAPS LOCK + F2, or by selecting the "Hotkey Helper" 

menu item from SuperNova's CAPS LOCK + F1 help menu, and typing the 

word formula in the search edit box in the Hotkey Helper HTML window in 

order to view a list of all of the hot keys related to working with formulas. 

If you start a Hotkey Helper search with the ^ symbol (SHIFT+6 on your 

keyboard, and sometimes referred to as a freestanding circumflex, or hat, 

or up arrow symbol), SuperNova's Hotkey Helper will search application 

names rather than hot key descriptions. So the search phrase ^acrobat 

will list all of the available hot keys in Adobe Reader. 
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You can use SuperNova's standard web browsing keys to review the 

contents of your search in SuperNova's Hotkey Helper HTML 

window. 

 
  

1.3  Get help using an application 

SuperNova includes help on how to use many popular applications. 

Help includes: 

 How to configure the application for best performance. 

 How to complete many common tasks using only the keyboard. 

 A list of popular hot keys. 

While SuperNova is running, you can open the SuperNova Help from within 

your application. When you open the SuperNova Help menu, the first item 

will link to specific information about using SuperNova with the current 

application. 

To do this: 

1. Press CAPS LOCK + F1. 

A context menu opens. 

2. DOWN ARROW to select the name of your application. For example, 

Microsoft Word 2007 and then press ENTER. 

SuperNova opens an HTML Help window, which contains  the help 

content. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
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1.3.1  Move within Help topics 

You can use Arrow Keys to move around within topics. In addition, you can 

use the following web page navigation commands to move around within 

help topics. Visit the Internet Explorer section of the SuperNova manual for 

a complete list of hot keys for moving around web pages. 

 Move to the next heading, H. 

 Move to the previous heading, SHIFT + H. 

 Move to the next link, TAB. 

 Move to the previous link, SHIFT + TAB. 

 Move to the bottom of the current document, CONTROL + END. 

 Move to the top of the current document, CONTROL + HOME. 

 Read from here to the end of the document, press the Read From 

Here hot key. 

Read From Here 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Start Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Stop Read From Here NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

SPACEBAR 

or ESCAPE 

or CONTROL 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
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1.3.2  Move between Help topics 

You can use the links at the top of each topic to go to the next or previous 

topic. 

To do this: 

1. Press CONTROL + HOME to move to the top of the document. 

2. Press TAB to move by link until you hear "Previous Topic Link" or "Next 

Topic Link". You can press SHIFT + TAB to move back to any links you 

may have skipped. 

3. Follow the link you have chosen by pressing ENTER. 

You can use the "Home" link to move to a page containing links to all topics 

relating to the current application. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
  

1.3.3  Switch between Help and your application 

You can remember your place in the SuperNova Help by keeping the 

SuperNova Help Browser window open. You may find it useful to switch 

between the SuperNova Help Browser window and your application 

window several times while carrying out help instructions. 

To do this: 

1. From the SuperNova Help window, press ALT + TAB to switch back to 

your application. 

2. Carry out any actions in your application. 

3. Press ALT + TAB to return to your position in the Help window. 

When you have finished using SuperNova help, you can press ALT + F4 to 

close the Help window. 
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1.4  Get Help from the SuperNova Control Panel 

Your SuperNova Control Panel provides two ways of getting help. 

 The Help button. 

 The Help menu. 
  

1.4.1  Use the Help Button 

The Help button in the SuperNova Control Panel is context sensitive.  

When you press this button, SuperNova opens the relevant section of the 

manual containing an explanation of the SuperNova settings in view. 

If the SuperNova Control Panel is not open, you can open it using LEFT 

CONTROL + SPACEBAR. 

You can press the Help button in any of these ways: 

 Left clicking the "Help" button on the Control Panel with the mouse. 

 TAB to the "Help" button and press SPACEBAR. 

 Press F1. 
  

1.4.2  Explore the Help menu 

The Help menu provides access to the complete SuperNova manual. The 

complete manual is particularly useful when you need to lookup a particular 

piece of information. 

1. If the SuperNova control panel is not open, you can open it using LEFT 

CONTROL + SPACEBAR. 

2. When in the SuperNova control panel, press ALT + H to open the 

"Help" menu. The first item in the menu is "SuperNova Manual". 

3. Press ENTER to open the SuperNova manual. 
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Use the following keys to navigate the SuperNova manual: 

 Choose a section, UP and DOWN ARROW Keys. 

 Expand and collapse individual sections, RIGHT and LEFT ARROW 

Keys. 

 Open a topic, ENTER. 

 Move between the contents and the open topic, F6. 
  

1.5  Get support for SuperNova 

1.5.1  Find help on the Dolphin website 

The Dolphin website offers a comprehensive range of support materials to 

help you get the most out of your Dolphin product. A variety of 

documentation is available, from handy tips and tutorials, to more technical 

knowledge base articles offering solutions to less common problems.  

To do this: 

1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Support" link from the main navigation menu. 

3. Choose one of the options available to you: 

 Manuals and user guides. Dolphin's training Manuals and Quick Start 

Guides will help you get to grips with our products quickly and easily. 

 Tips & Tutorials. Handy step by step online tutorials covering the main 

product features. 

 Knowledge Base. The Knowledge Base is a searchable database 

containing a wealth of information and solutions to issues you might 

have with your Dolphin product. 
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1.5.2  Contact your Dolphin Dealer for support 

If you purchased your Dolphin software from a registered Dolphin dealer, 

you can contact the dealer directly to receive the most appropriate localized 

support. If you do not know the contact details for your dealer, you can 

obtain these from the Dolphin website. 

To do this: 

1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Dealers" link from the main navigation menu. This will 

open the "Dealer Locator" page. 

3. Select your country from the list then choose the "Submit" button. This 

will open a page displaying a list of Dolphin Dealers for that country. 

4. Review the results to locate the contact details for the dealer from which 

you purchased your Dolphin product. 
  

1.5.3  Contact Dolphin UK Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone: +44 (0)1905 754765. 

 By telephone (UK Local Rate): 0345 130 5454. 

 By Fax: +44 (0) 1905 754 559. 

 By Email: support@yourdolphin.com. 
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1.5.4  Contact Dolphin USA Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone (Toll free): 888 519 4694 

 By telephone (International): +1 609 803 2173. 

 By email: support.us@yourdolphin.com. 
  

1.5.5  Find your product version number and your product serial 
number 

In the SuperNova "About" dialog box you can find information about: 

 Your SuperNova version number. 

 Your personal SuperNova serial number. 

 A copy of the SuperNova software license agreement. 

To open this dialog box: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + H. This will open the "Help" menu. 

3. DOWN ARROW to "About" and press ENTER. This will open the 

"About" dialog box. 
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1.5.6  Get further product training 

Dolphin has a network of approved trainers who are available to offer you 

high quality training either within your home or in your place of work. Our 

trainers can personalize the training to your individual requirements 

allowing you to maximize your independence, while taking into account 

your level of technical knowledge. You can contact Dolphin to find a 

Dolphin approved trainer in your area. 

To do this: 

 By telephone: +44 (0)1905 754577. 

 By Email: info@dolphinuk.co.uk. 
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C H A P T E R  2  

Install and Set Up 

2.1  Start SuperNova 

SuperNova will start automatically after you log onto your computer unless 

you have stated otherwise during the installation process. 

You can manually start SuperNova after log on by using the SuperNova 

shortcut key. 

Press CONTROL + SHIFT + S. 

If you have installed a new version alongside your existing version then the 

new version will be automatically given the following shortcut key: 

Press CONTROL + SHIFT + D. 

You can also launch SuperNova by selecting the SuperNova shortcut in the 

Windows Start menu. This is in the Programs, Dolphin sub-menu. 
  

2.2  Run SuperNova for the first time 

You will be guided through the activation process the first time you run 

SuperNova after installation. 

The activation process will guide you through unlocking and activating your 

software. 
  

2.3  Learn your hot keys 

You can use the SuperNova Key Describer to help you get familiar with 

your keyboard layout and SuperNova hot keys.  
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An application will not see or act on any keys pressed when you use Key 

Describer. 

To turn on or off "Key Describer": 

Key Describer Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on or off Key Describer CAPS LOCK + 

SLASH 

CAPS LOCK + 

1 

 
  

2.4  Quit SuperNova 

To quit SuperNova: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + F. This will open the "File" menu. 

3. DOWN ARROW to "Quit SuperNova" and press ENTER. A message 

window will appear asking you to confirm you want to quit. 

4. TAB to the "Yes" button and press SPACEBAR. 
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C H A P T E R  3  

SuperNova Control Panel 

3.1  Introducing the SuperNova Control Panel 

 
  

The SuperNova Control Panel is the place that contains all of the settings 

for SuperNova. 

You can find SuperNova's settings in the Control Panel's menu bar and the 

button bar. 

The menu bar, which is the horizontal bar positioned below the title bar 

containing options to drop down menus, provides access to all the settings 

available in SuperNova. The button bar, which is positioned below the 

menu bar and contains large easy to access buttons, provides access to 

SuperNova's most commonly used settings. 

The final part of the SuperNova Control Panel is the status bar. The status 

bar, which is the horizontal bar at the bottom of the SuperNova Control 

Panel, provides information about the Settings files you are using. 
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You can switch from a full-sized to a compact version of the control panel 

using the restore down and maximize buttons in the title bar of the control 

panel. 
  

You can open the SuperNova Control Panel in several ways.  Use the one 

which suits you best. 

To open the SuperNova main Control Panel: 

Press LEFT CONTROL + SPACEBAR. 

This opens the full Control Panel as a dialog box. 

Alternatively, using the mouse, to open the SuperNova Control 

Panel: 

Click the SuperNova icon in the Windows Notification Area. 

To open the SuperNova Control Panel as a simple menu: 

Press CAPS LOCK + SPACEBAR or RIGHT CLICK the SuperNova 

icon in the Windows Notification Area. 
  

 
  

3.2  Keyboard commands to get around the SuperNova 
Control Panel 

The following tables provide a list of keyboard commands to help you get 

around the SuperNova Control Panel. Note that these keyboard commands 
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are also standard Windows commands that you can use throughout 

Windows. 

Keyboard Commands for the menu bar. 

Function Hot key 

Move focus to the menu bar ALT 

Move focus across the menu bar LEFT ARROW or 

RIGHT ARROW 

Open the menu item that has 

focus 

DOWN ARROW or 

ENTER 

Move to and open a menu bar 

item 

ALT + Underlined letter 

Move through an open menu DOWN ARROW or UP 

ARROW 

Open a submenu RIGHT ARROW or 

ENTER 

Close a submenu LEFT ARROW or 

ESCAPE 

Select a menu item ENTER 

 

Keyboard Commands for dialog boxes 

Function Hot key 

Move to the next control TAB 

Move to the previous control SHIFT + TAB 

Press a button, toggle a check 

box or select an option 

SPACEBAR 

Move directly to a control ALT + Underlined letter 

Open the next tab in a multi tab 

dialog box 

CONTROL + TAB 

Open the previous tab in a multi 

tab dialog box 

CONTROL + SHIFT + 

TAB 

Cancel ESCAPE 
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3.3  Settings in the SuperNova Control Panel 

All the SuperNova options can be accessed through the menus in the 

SuperNova Control Panel.  The following list summarizes the purpose of 

the menus. 

 File menu: 

The "File" menu contains options for selecting your user profile as well 

as managing your SuperNova Settings files. This includes creating, 

editing, importing and exporting settings files. The "File" menu also 

contains the command to quit SuperNova. 
  

 Visual menu. 

The "Visual" menu contains the options to control magnification, screen 

colors, highlighting and other visual effects. You can also access many 

of these settings through the SuperNova button bar. 
  

 Speech menu. 

The "Speech" menu contains the options to control what SuperNova 

announces. This includes voice settings like the speed and volume of 

the voice, plus options controlling what SuperNova says when you are 

typing, reading and working with text. 
  

 Braille menu. 

The "Braille" menu contains options to control what is output to a Braille 

display. This includes the Braille table, language and text attributes. 
  

 Media menu. 

The "Media" menu contains options for scanning, searching for books, 

reading online news articles, listening to radio stations and playing 

podcasts. 
  

 General menu. 

The "General" menu contains options that control SuperNova's behavior 

including startup preferences, update settings, Control Panel 

appearance and SuperNova keyboard and hot key assignments. 
  

 Help menu. 
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The "Help" menu provides shortcuts to useful resources including the 

SuperNova Manual, online resources and the "About" option. The 

"About" option provides you with your customer ID number plus the 

edition, version and build of SuperNova you are currently running. 

Ensure you have this information at hand if you require technical 

assistance. 
  

3.4  Change the appearance of the SuperNova Control Panel 

You can make many changes to the SuperNova Control Panel. For 

example, you can hide the button bar, hide the status bar, stop the Control 

Panel appearing when you run SuperNova and remove it from the 

Windows Taskbar. 

For information about changing the SuperNova Control Panel, see the 

"General Control Panel dialog box". 
  

3.5  Close the SuperNova control panel 

You can close the SuperNova Control Panel in several ways. 

To do this: 

Press ESCAPE. 

Or, 

Click the minimize icon in the SuperNova Control Panel title bar. 

When you do this, the SuperNova Control Panel disappears and the focus 

goes back to the application you were previously running. SuperNova 

continues to run. 

NOTE: If you press ALT + F4 or click the close button in the 

SuperNova Control Panel title bar, then SuperNova will assume you 

want to quit the program. Before quitting, a message window 

appears asking you to confirm the action. 
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C H A P T E R  4  

Magnifier 

4.1  Turn magnification on or off 

 

You can turn on or off magnification using the "Visual" options in the 

SuperNova control panel or by using hot keys. If you are using a 

touchscreen device, you can also turn magnification on or off by doing a 3 

finger  double tap. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on magnification LEFT 

CONTROL + 

NUMPAD 

ENTER 

ALT + 0 

 

If you're using multiple monitors and have the "Allow different magnification 

levels on each monitor" check box enabled in SuperNova's "Multiple 

Monitors" settings dialog box, then when you press the magnification on/off 

hot key it will turn the magnification on or off only on the monitor that your 

mouse pointer is currently on. 
  

4.2  Change magnification size 
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You can change the power of magnification from 1.2x to 64x. You can 

change the magnification size using the "Visual" options in the SuperNova 

control panel or by using hot keys. If you are using a touchscreen device, 

you can also change magnification by doing a 2 finger pinch or 2 finger 

stretch. 

Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 

Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

 

If you're using multiple monitors and have the "Allow different magnification 

levels on each monitor" check box enabled in SuperNova's "Multiple 

Monitors" settings dialog box, then when you press the increase or 

decrease magnification hot keys it will increase or decrease the 

magnification only on the monitor that your mouse pointer is currently on. 
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4.3  Change Magnifier view 

 

You can choose different ways to view the screen using the SuperNova 

Magnifier.  This includes the following viewing options: 

 Full Screen. 

This view fills the screen with a magnified portion of the "real" 

Windows screen. 

 Fixed Window. 

This view shows the magnified region of the screen in a small static 

window. You can change the size and position of the window. 

 Magnifying Glass 

This view behaves like holding a magnifying glass to the screen. You 

view the magnified region of the screen in a small moving window. 

You can change the size and position of the window. 

 Resizing Glass 

This view behaves similar to the Magnifying Glass except that the 

magnified window will automatically resize itself to the size of the 

current focus. This view is useful if you use the keyboard to navigate 

Windows and feel more comfortable seeing the unmagnified screen in 

the background. 

 Split Screen. 

This view splits the screen into two regions: a magnified window and 

an unmagnified window. You can choose where the magnified window 

appears and the size of the magnified window. The border between 

the magnified and unmagnified screen is shown as a black line. This 

mode is popular when also using an integrated CCTV package. 

You can change your viewing style by using the "Visual" options in the 

SuperNova control panel or by using hot keys. 

Magnifier Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Change Magnifier view LEFT 

CONTROL + 

NUMPAD 7 

ALT + SHIFT + 

M 

Change orientation when in 

Split Screen view 

LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Note that you can change the size and color of the border around the Fixed 

Window, Magnifying Glass, Resizing Glass and Split Screen views. You 

make this change in the "Visual Advanced Options" dialog box. 
  

4.4  Change size and position of the magnified window 

You can change the size and position of the Fixed Window, Magnifying 

Glass and Split Screen window. You make the change using a 

magnification modification mode. 

To adjust the size and position of the Fixed Window view: 

1. Choose "Fixed Window" as the Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Use the Arrow Keys to position the window on the screen. You can also 

do this by holding down the Z key and move the mouse. 

4. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

5. Press ESCAPE to exit magnification modification mode. 
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To adjust the size of the Magnifying Glass view: 

1. Choose "Magnifying Glass" as the Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

4. Press ESCAPE to exit magnification modification mode. 

To adjust the size of the Split Screen view: 

1. Choose the Split Screen orientation that you are going to use as the 

Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the Z key and move the mouse. 

4. Press ESCAPE to exit magnification modification mode. 
  

4.5  View other parts of the screen 

Only one part of the screen is visible when using magnification. To view the 

other parts of the screen, you can move the mouse pointer around the 

screen or use SuperNova hot keys. 
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Moving around the screen using SuperNova hot keys is described as either 

panning, moving, move to or jumping. 

 Panning. 

Panning moves the magnified area across the screen at a constant 

speed in the direction you specify. The speed of movement can be 

increased or slowed depending on the keys pressed. 

To pan across the screen press RIGHT CONTROL plus an Arrow 

Key. Hold down RIGHT CONTROL to keep panning. Press the same 

Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed 

up the panning. Press the opposite Arrow Key to slow down.  

Use the other Arrow Keys to change direction. Release RIGHT 

CONTROL to stop panning. 

 Moving (accelerated panning). 

Moving works in a similar way to panning, except that the speed of 

the panning will automatically accelerate up to a certain top speed 

while you have the keys held down. 

To move the magnified area press and hold down RIGHT CONTROL 

+ RIGHT SHIFT together with an Arrow Key. When you let go, 

moving will stop. 

 Move To. 

You can also move the magnified area directly to various parts of the 

screen. The following table lists the hot keys that will allow you to 

move the magnified area to a screen position. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Top left RIGHT 

CONTROL + 

NUMPAD 7 

No Assignment 
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Top RIGHT 

CONTROL + 

NUMPAD 8 

No Assignment 

Top right RIGHT 

CONTROL + 

NUMPAD 9 

No Assignment 

Left RIGHT 

CONTROL + 

NUMPAD 4 

No Assignment 

Center RIGHT 

CONTROL + 

NUMPAD 5 

No Assignment 

Right RIGHT 

CONTROL + 

NUMPAD 6 

No Assignment 

Bottom left RIGHT 

CONTROL + 

NUMPAD 1 

No Assignment 

Bottom RIGHT 

CONTROL + 

NUMPAD 2 

No Assignment 

Bottom right RIGHT 

CONTROL + 

NUMPAD 3 

No Assignment 

  

 Jump Movement. 

Movement around the screen is also possible in steps. This is 

different to panning as the magnified window does not scroll smoothly 

but rather moves in steps.  

Magnifier Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Up LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 8 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

UP ARROW 

Down LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 2 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

DOWN 

ARROW 

Left LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 4 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

LEFT ARROW 

Right LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 6 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

RIGHT 

ARROW 

Save and Restore Screen Position 

Also available is the opportunity to save a screen position. This will then 

allow you to return to the same position with the press of a hot key. 

To save a screen position: 

1. Move the magnified window to the required position. 

2. Press RIGHT CONTROL + NUMPAD 0 to save the position. 

To move the magnified window back to the saved position: 

Press RIGHT CONTROL + NUMPAD PERIOD to return to the saved 

screen position. 
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4.6  Get an overview of the magnified window position 

You can see the position the magnified window is on the screen by using 

Magnifier Overview. You switch in and out of Magnifier Overview using a 

SuperNova hot key. 

To enter and exit Magnifier Overview: 

Press LEFT CONTROL+ BACKSLASH. 
  

4.7  Create static magnified windows to display information 

You can create static magnified windows to keep a particular area of the 

screen permanently displayed. This lets you see important information that 

may frequently change as you use your application.  

SuperNova calls these windows "Hooked Areas". Hooked Areas can have 

their own magnification size and will be visible even if you turn off the 

SuperNova Magnifier. 

Examples: 

 You can hook the system tray clock to make it easy to see the time. 

 You can hook the place on a word processor's status bar that reports 

the current page number to make it easy to see what page you are 

currently working on. 

 You can hook the Formula Bar in a spreadsheet to make it easy to 

see if the current cell contains a formula or text. 

You can create a Hooked Area by using the mouse pointer or by using the 

keyboard. 
  

4.7.1  Create a Hooked Area using the keyboard 

To create and change the position and size of a Hooked Area window 

using hot keys requires the use of magnification modification mode. 
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To create and adjust the size and position of a Hooked Area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 5 

to create a new Hooked Area and automatically enter magnification 

modification mode. If using the Laptop Hot Key set, press LEFT 

CONTROL + LEFT SHIFT + ALT + H to create a new Hooked Area and 

automatically enter Magnification Modification Mode 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

2. Use the Magnifier hot keys to change the size of the content inside the 

Hooked Area. 

3. Use the Arrow Keys to position the window on the screen. You can also 

do this by holding down the Z key and move the mouse. 

4. Press LEFT SHIFT + Arrow Keys to alter the content inside the Hooked 

Area. You can also do this by holding down the C key and move the 

mouse. 

5. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

6. Press ESCAPE to exit magnification modification mode. 

During the creation process you will probably find it is only through 

repeated adjustment of size, position and content within the Hooked Area 

do you get the desired result. 
  

4.7.2  Modify a Hooked Area using the keyboard 

To modify an existing hooked area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. 

If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will 

enter magnification modification mode with the currently selected 

Hooked Area identified by a flashing border. 

2. If you have multiple Hooked Areas then you can cycle between the 

Hooked Areas by pressing LEFT CONTROL + NUMPAD 6 if using the 
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Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop 

Hot Key set. 

3. Use the available Magnifier hot keys and Magnification Modification 

Mode hot keys to adjust the size, location or content of the Hooked 

Area. 

4. Press ESCAPE to exit Magnification Modification Mode. 

 
  

4.7.3  Delete a Hooked Area using the keyboard 

To delete an existing hooked area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. 

If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will 

enter Magnification Modification Mode with the currently selected 

Hooked Area identified by a flashing border. 

2. If you have multiple Hooked Areas then you can cycle between the 

areas. To do this press LEFT CONTROL + NUMPAD 6 if using the 

Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop 

Hot Key set. 

3. Press DELETE to remove the Hooked Area. 

When the Hooked Area is deleted the focus will move to the next Hooked 

Area. If no Hooked Areas remain then Magnification Modification Mode will 

be automatically exited. If additional Hooked Areas remain that you do not 

want to modify then press ESCAPE. 
  

4.7.4  Create a Hooked Area using the mouse 

You can create Hooked Areas through the "Create Hooked Areas" dialog 

box. To open this dialog box, open the "Visual" menu and select the menu 

item "Advanced Options". Then in the "Hooked areas" property sheet of the 

Advanced Options dialog box press the "New" button. 

In the "Create Hooked Areas" dialog box you will need to: 
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1. Provide a unique description for the hooked area. 

2. Select or unselect the "Track focus" check box. 

Track focus determines whether the content of the hooked area is 

fixed or shows the current focus. Select this check box and the 

contents of the hooked area will track the focus. If this check box is 

selected then the "Choose screen area to hook" button will be 

disabled as an area of the screen is not being defined. 

3. Select the "Choose screen area to hook" button to define the screen 

area to display.  

4. Use LEFT MOUSE BUTTON with mouse movement to create a new 

area. Press ENTER or the RIGHT MOUSE BUTTON to accept, 

ESCAPE to cancel. 

5. Select or unselect the "Smoothing" check box. 

6. Select the "Move the hook window" button to position the hooked area 

and to set the magnification size. 

The magnification size can be set using the normal hot keys. Use 

mouse movement or the CURSOR KEYS to move the hook. Press 

ENTER or the LEFT MOUSE BUTTON to accept, ESCAPE to cancel. 

7. Select the "OK" button to confirm and save the new Hooked Area. 

You can view a list of your created Hooked Areas in the "Hooked Areas" 

tab, in the "Visual Advanced Options" dialog box. You can also sort, modify 

and delete existing Hooked Areas in the "Hooked Areas" tab. 
  

4.7.5  Show or hide Hooked Areas 

You can show or hide Hooked Areas using a SuperNova hot key. This can 

be useful if you do not want the Hooked Areas to be visible all the time but 

rather as and when information from other areas of the screen is required. 

Magnifier Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on Hooked Areas LEFT 

CONTROL + 

NUMPAD 3 

LEFT 

CONTROL + 

F5 
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C H A P T E R  5  

Screen colors, highlights and mouse pointers 

5.1  Make the screen easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Color Schemes, which can change the 

contrast, brightness and colors on the screen. 

You can choose a pre-set SuperNova Color Scheme or create a custom 

scheme. A Color Scheme is applied to the whole screen and will work even 

when the Magnifier is turned off. 

You can choose a Color Scheme through the "Visual" options in the 

SuperNova control panel. You can  also toggle off or on a Color Scheme 

using the "Visual" options in the SuperNova control panel or by using hot 

keys. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on or off your Color 

Scheme 

LEFT 

CONTROL + 

NUMPAD 0 

ALT + SHIFT + 

C 

To create a custom scheme you must select "Custom" before you can 

choose "Configure..." from the list of Color Schemes. Choosing 

"Configure..." opens the "Configure Custom Color Scheme" dialog box. The 

dialog box contains different controls depending on the settings you choose. 

This includes brightness, contrast, tint and color replacement settings. 
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If you're using multiple monitors and have the "Independent colors" check 

box enabled in SuperNova's "Multiple Monitors" settings dialog box, then 

when you press the Color Scheme on/off hot key it will turn the Color 

Scheme on or off only on the monitor that your mouse pointer is currently 

on. 
  

5.2  Make the focus easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Highlighting, which makes different 

types of focus easier to see by attaching a visual marker to the focus. 

Types of focus include: 

 Mouse (the pointer controlled by the mouse). 

 Cursor (the beam cursor used in edit areas). 

 Line (the line the beam cursor is positioned). 

 Focus (the focus in dialog boxes and menus). 

You can choose a pre-set SuperNova Highlighting Scheme or create your 

own personal custom scheme. You choose a scheme through the "Visual" 

options in the SuperNova control panel. 

To create a custom scheme you must select "Settings" from the list of 

Highlighting Schemes. When you choose "Settings" SuperNova 

automatically switches to the "Custom" scheme before opening the 

Highlighting Options dialog box. SuperNova also uses the previous 

scheme's values to make the default values for the new custom scheme. 

Tip: If you see no visual effect when choosing a scheme then check 

to ensure "Highlighting" is turned on. You can turn Highlighting on by 

selecting the "Highlighting" option in the "Visual" menu or by 
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selecting the "Highlighting" button in the "Visual" tab of the 

SuperNova control panel. 

  

5.3  Make the pointer easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Mouse Pointers, which allows you to 

change the size and color of the pointer on the screen.  

You can choose a pre-set SuperNova Mouse Pointer scheme or create 

your own personal custom scheme through the "Visual" options in the 

SuperNova control panel. 

The pre-set schemes include: 

 Large Red 

 Large White 

 Large Yellow 

The selecting of the "Windows Standard" scheme will change the pointer 

scheme back to the Windows defaults. 
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C H A P T E R  6  

Voice settings 

6.1  Turn the voice off or on 

 

You can turn off or on the voice using the "Speech" options in the 

SuperNova control panel or by using hot keys. 

To turn off the voice until you turn on the voice again: 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn voice on and off LEFT 

CONTROL + 0 

LEFT 

CONTROL + 

ALT + 0 

Mute voice LEFT 

CONTROL 

CONTROL 
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6.2  Change volume 

 

You can change the volume of the voice using the "Speech" options in the 

SuperNova control panel or by using hot keys. 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Increase volume LEFT 

CONTROL + 

EQUALS 

LEFT 

CONTROL + 

ALT + EQUALS 

Decrease volume LEFT 

CONTROL + 

MINUS 

LEFT 

CONTROL + 

ALT + MINUS 

 
  

6.3  Change reading speed 

 

You can change the reading speed of the voice using the "Speech" options 

in the SuperNova control panel or by using hot keys. 

Speech Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Increase reading speed LEFT 

CONTROL + 

LEFT SHIFT + 

EQUALS 

LEFT 

CONTROL + 

ALT + PAGE 

UP 

Reduce reading speed LEFT 

CONTROL + 

LEFT SHIFT + 

MINUS 

LEFT 

CONTROL + 

ALT + PAGE 

DOWN 

 
  

6.4  Change voice 

 

Speech synthesizers often come with different voices to choose from. Each 

voice will have its own intonation, created within the speech parameters 

available. 

To change voice: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Voice and Language 

Configuration" page. 

5. TAB to the "Voice" list and use the Arrow Keys to select a voice. 
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6. If you want to have different voices for different speech contexts, TAB to 

the "Same as Screen Reader" check box and press SPACEBAR to 

deselect this option. Then, TAB to each category and use the Arrow 

Keys to select a voice. 

Note: A speech context is a special attribute of the text to be spoken 

which indicates where it came from or what SuperNova feature you are 

using. 

7. TAB to the "OK" button and press SPACEBAR. 

SuperNova saves the changes and closes the dialog box. 

If you are unable to find a voice you find comfortable to listen to then try 

another synthesizer or try creating your own voice using the options in the 

"User Defined Voices" page in the "Voice Preferences" dialog box. 
  

6.5  Change reading voice language 

 

SuperNova can automatically change the synthesizer language to match 

particular alphabetic scripts to make screen reading a more fluent 

experience. You can automatically switch between many scripts including 

Latin, Arabic, Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and 

Russian (Cyrillic). 

Where SuperNova is unable to determine the script language, for instance, 

where the same alphabet is used by different languages, you can use a hot 

key to select the synthesizer language you want to use to read the passage 

of text. 

Note that not all synthesizers support this feature. To learn more about 

supported synthesizers and available synthesizer languages please contact 

Dolphin or your local Dolphin dealer. 
  

6.5.1  Enable automatic language switching 

1. Press LEFT CONTROL + SPACEBAR. 
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The SuperNova control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Voice & Language" page. 

5. TAB to the "Enable automatic language switching" check box and press 

SPACEBAR to select this option. 

6. If you want to prevent the speech changing when punctuation and 

numbers are encountered through passages of text, TAB to the "Speak 

numbers & punctuation with previous character's language" check box 

and press SPACEBAR to select this option. 

7. TAB to the "OK" button and press SPACEBAR. 

SuperNova saves the changes and closes the dialog box. 
  

If you are using a non-European version of SuperNova and require text to 

be automatically read using a European language, then, in addition to the 

steps above, in the "Voice & Lnaguage" page, de-select the “Same as 

screen reader” check box and select the European language you want to 

use from the “Screen language” list. 

You can also change the "Screen language" option by using the Language 

Up or Language Down hot key. This allows you to change synthesizer 

language without the need to leave the document you are reading. 
  

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Language Down LEFT 

CONTROL + 

PERIoD 

No Assignment 
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Language Up LEFT 

CONTROL + 

COMMA 

No Assignment 

 
  

6.6  Change speech synthesizer 

SuperNova works with many different speech synthesizers. Supporting 

such a variety of speech synthesizers means you can pick a synthesizer 

and voice that you find comfortable, clear and responsive to use. To see 

what speech synthesizers are available please visit the Dolphin website or 

contact your local Dolphin Dealer. 

To change to another speech synthesizer: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Synthesizer Configuration" page. 

5. TAB to the "Select Synthesizer" button and press SPACEBAR. 

The "Select Synthesizer" dialog box opens. 

6. Use the Arrow Keys to select an alternative speech synthesizer. 

7. TAB to the "OK" button and press SPACEBAR. 

SuperNova closes the dialog box and speaks using the new 

synthesizer.  

If you find the voice not to your liking then you can move into the "Voice 

and Language Configuration" page to choose a different voice. You 

could also move to the "User defined voices" page to customize the 

parameters of the existing voice. 
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8. TAB to the "OK" button and press SPACEBAR. 

SuperNova closes the "Voice Preferences" dialog box. 
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C H A P T E R  7  

Reading and typing 

7.1  Read character 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read character at the current 

focus position 

NUMPAD 4 CAPS + LEFT 

ARROW 

 
  

You can learn more about the current character by repeating the press of 

the hot key. 

 x2 announces the phonetic character description. 

 x3 announces the character's attributes including font name, size and 

style. 

 x4 announces the unicode value of the character. 
  

7.2  Read word 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read word at the current 

focus position 

NUMPAD 5 CAPS LOCK + 

RIGHT 

ARROW 
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You can learn more about the current word by repeating the press of the 

hot key. 

 x2 spells the word. 

 x3 spells the word using the phonetic alphabet. 
  

7.3  Read line, read line to cursor and read line from cursor 

You can read the current line, read up to the cursor position on the current 

line and read from the cursor position on the current line. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read line at the current focus 

position 

NUMPAD 6 No Assignment 

Read up to the cursor 

position on the current line 

LEFT SHIFT + 

NUMPAD 1 

CAPS LOCK + 

HOME 

Read from the cursor position 

on the current line 

LEFT SHIFT + 

NUMPAD 2 

CAPS LOCK + 

END 

 

 

You can learn more about the current line by repeating the press of the hot 

key. 

 x2 reads the line including announcements of capital letters and 

spaces. 

 x3 spells the line. 
  

7.4  Read selected text 

You can read the text you have selected in your document with a hot key. 
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Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read selected text NUMPAD 1 CAPS LOCK + 

SHIFT + 

DOWN 

ARROW 

 
  

You can learn more about the current selection by repeating the press of 

the hot key. 

 x2 spells the selected text including announcements of capital letters 

and spaces. 

 x3 spells the selected text using the phonetic alphabet. 
  

7.5  Read focus 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read current focus NUMPAD 0 CAPS LOCK + 

UP ARROW 

 
  

You can learn more about the current focus by repeating the press of the 

hot key. 

 x2 spells the focus including announcements of capital letters and 

spaces. 

 x3 spells the focus using the phonetic alphabet. 
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7.6  Read control 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read control NUMPAD 

PERIOD 

No Assignment 

 
  

You can learn more about the current control by repeating the press of the 

hot key. 

 x2 reads the control including announcements of capital letters and 

spaces. 

 x3 spells the control using the phonetic alphabet. 
  

7.7  Read window 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read WINDOW NUMPAD 9 CAPS LOCK + 

B 

 
  

You can learn more about the current window by repeating the press of the 

hot key. 

 x2 spells the focus including announcements of capital letters and 

spaces. 
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7.8  Read status 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read status information (e.g. 

status bar) 

NUMPAD 2 CAPS LOCK + 

PAGE DOWN 

 

 

You can learn more about the current status by repeating the press of the 

hot key. 

 x2 spells the status including announcements of capital letters and 

spaces. 

 x3 spells the status using the phonetic alphabet. 

You may have additional commands added to this hot key for different 

applications. Please refer to the help for the application to learn more. 
  

7.9  Read shortcut key 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Describe shortcut key LEFT SHIFT + 

NUMPAD 

PERIOD 

CONTROL + 

CAPS LOCK + 

LEFT ARROW 
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You can learn more about the current shortcut key by repeating the press 

of the hot key. 

 x2 spells the shortcut key using the phonetic alphabet. 
  

7.10  Read date and time 

You can announce the current time and date with a SuperNova hot key. 

The time and date comes from your computer clock. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read time and date LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 

SLASH 

CAPS LOCK + 

F12 

 
  

7.11  Check where you are 

You can learn where you are by pressing the "Where Am I" hot key. 

Pressing The hot key gives different information depending on your current 

location.  

Examples: 

 The "Where Am I?" hot key tells you the window title, document name 

and current line in a word processor. 

 The "Where Am I?" hot key tells you the window title, property sheet 

name, group name and the name of the current control in a dialog 

box. 

Speak Key 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Where Am I? NUMPAD 7 CAPS LOCK + 

PAGE UP 

 
  

7.12  Read continuously 

Read From Here is a special reading mode available in SuperNova. 

You can use Read From Here to continuously read a document. Reading 

will continue until the end of the document or until you press a hot key to 

stop the reading. The pressing of a hot key to stop SuperNova reading will 

move the cursor to the last word spoken. 

You can change the speed of the voice during Read From Here and 

navigate backwards and forwards through the content of a document as it's 

being spoken. Note that this requires the document area being read to 

support Dolphin Cursor navigation by unit in order to move by line, 

sentence, paragraph and heading, etc. Examples of supported document 

areas include Microsoft Word documents and Microsoft Outlook e-mails. 

Read From Here 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Start Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Pause/Unpause Read From 

Here 

SPACEBAR SPACEBAR 

Stop Read From Here NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

SPACEBAR 

or ESCAPE 

or CONTROL 
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Stop Reading and switch 

focus 

LEFT SHIFT + 

SPACEBAR 

LEFT SHIFT + 

SPACEBAR 

Read From Here next line DOWN 

ARROW 

DOWN 

ARROW 

Read From Here previous 

line 

UP ARROW UP ARROW 

Read From Here next 

paragraph 

P P 

Read From Here previous 

paragraph 

LEFT SHIFT + 

P 

LEFT SHIFT + 

P 

Read From Here next 

sentence 

S S 

Read From Here previous 

sentence 

LEFT SHIFT + 

S 

LEFT SHIFT + 

S 

 
  

7.12.1  Read From Here with the Dolphin Cursor 

Read From Here is also available when using the Dolphin Cursor. This 

allows you to continuously read information that you may not otherwise be 

able to read including web pages, dialog boxes, lists and menus. 

You can also turn on or turn off the Dolphin Cursor when you stop Read 

From Here. Turning on the Dolphin Cursor will place the Dolphin Cursor on 

the last word spoken. The application does not move focus to the new 

position.  

Read From Here 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Stop Read From Here and 

turn on or turn off the Dolphin 

Cursor 

NUMPAD 

MINUS 

SPACEBAR 
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7.12.2  Enhance Read From Here 

Enhance Read From Here creates an alternative reading environment for 

you when you use the Read From Here command. 

In this reading environment, a magnified window shows the current text 

being spoken as moving text without line breaks at the top of the screen. 

The rest of the screen is unmagnified, providing an opportunity to check the 

visual layout of the document as continuous reading progresses. 

To turn on or off this option, you can either choose the "Enhance Read 

From Here" item in the "Speech" menu in the SuperNova control panel or 

you can use a SuperNova hot key. 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Enhance Read From Here LEFT 

CONTROL + 

CAPS LOCK + 

1 

No Assignment 

Notes: 

 This hot key does not start the continuous reading process. You 

continue to control continuous reading by using the Read From Here 

hot keys. 

 Enhance Read From Here works only when using magnification. If the 

Magnifier is turned off this reading mode will not initialize. This is 

because the magnified window at the top of the screen is proportional 

to the magnification size you are using. 
  

7.13  Read using the mouse 

You can set SuperNova to start or stop continuous reading with a mouse 

click. You can also set SuperNova to read text under the mouse pointer. 
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7.13.1  Click and read 

If this is the first time you are using Click and Read From Here then you will 

have to turn on this option. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Read From Here" and RIGHT ARROW to open its 

sub-menu. 

4. DOWN ARROW to "Click and Read From Here" and press ENTER to 

select this item. 

5. Press ESCAPE to close the SuperNova control panel. 

You can start Read From Here by pressing the MIDDLE MOUSE BUTTON. 

This will start the reading from the mouse pointer position. Repeating the 

button press will stop SuperNova reading. 
  

7.13.2  Read text under the mouse pointer position 

To read text under the mouse pointer position: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the "Announce text under mouse" check box and press 

SPACEBAR to select this item. 
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5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

6. Press ESCAPE to close the SuperNova control panel. 

Text below the mouse pointer position will now be read by SuperNova. 
  

7.14  Change what is spoken when typing 

You can have: 

 Each character you type spoken. 

 Each word you type spoken. 

 Each character and word you type spoken. 

 Nothing spoken when typing. 

You can make this change through the SuperNova control panel. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Character Echo" and press ENTER. This will open 

the "Character Echo" dialog box. 

4. Select what you want spoken when typing from the options available. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

You can also change the Character Echo value using a SuperNova hot 

key. 

Speech hot key 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Character echo cycle CAPS LOCK + 

SEMI COLON 

CAPS LOCK + 

2 

 
  

7.15  Announce capital letters 

You can announce capital letters by changing settings in the SuperNova 

control panel. Note that the SuperNova settings will vary depending on the 

synthesizer you are using. 
  

7.15.1  Turn on capital announcement 

You can turn on capital announcement by selecting the "Capitals" check 

box in the "Text Style Announcements" dialog box or by using a SuperNova 

hot key. 

To select the "Capitals" check box: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Text Style Announcements" and press ENTER. 

This will open the "Text Style Announcements" dialog box. This is a 

dialog box with multiple tabs. 

4. If you want capital announcements in edit areas, in the "Edit Areas" tab, 

TAB to the "Capitals" check box and press SPACEBAR to select this 

item. 

5. If you want capital announcements in prompt areas like dialog boxes, 

message windows and worksheets, CONTROL + TAB to open the 

"Prompt Areas" tab, then TAB to the "Capitals" check box and press 

SPACEBAR to select this item. 
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6. Repeat the previous steps for all other areas and modes where you 

want to have capital announcements. 

7. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

To use the SuperNova hot key: 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Capitals on / off CAPS LOCK + 

QUOTE 

No Assignment 

Note that this hot key changes the "Capitals" check box status in the "Text 

Style Announcements" dialog box corresponding to your current focus 

position. 

Examples: 

 Press the hot key in an edit area and only the status of the "Capitals" 

check box in the "Edit Areas" tab of the "Text Style Announcements" 

dialog box will change. 

 Press the hot key in a menu and only the status of the "Capitals" 

check box in the "Menus" tab of the "Text Style Announcements" 

dialog box will change. 
  

7.15.2  Turn on capital announcement when reading lines 

By default, if you turn on capital announcement in edit areas then 

SuperNova will announce capitals when you are typing and when you are 

moving across a line of text. To also announce capitals when you are 

reading a line, for example, when you press DOWN ARROW to move focus 

onto a new line, you must also select the "Announce capitals when reading 

lines" check box. 

To do this: 
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1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the "Announce capital letters when reading lines" check box and 

press SPACEBAR to select this item. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

7.15.3  Using sounds to indicate capitals 

By default, SuperNova will describe capital letters by using words. Using 

words is a method all synthesizers support. However, it is also possible 

with some synthesizers to use a sound to indicate capitals. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the Use Beeps for Capital Announcement" check box and press 

SPACEBAR to select this item. Note that this item will not be available if 

your current synthesizer does not support this option. 

5. TAB to the "Use sound" list and use the Arrow Keys to select the sound 

you want to use to indicate capitals. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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The following table describes how SuperNova indicates capitals when you 

are using words and when you are using sounds. 

Capital Announcements 

Description Words Sounds 

Reading a single capital letter Caps + letter 1x beep 

Reading a word with an initial 

capital 

Capital + word 1x beep 

Reading a word written using 

capital letters 

All Caps + word 2x beep 

Reading a word written with a 

mixture of lower case and 

upper case letters 

Mix caps + 

word 

2x beep 

 
  

7.15.4  Using a pitch change to indicate capitals when spelling 
characters 

You can indicate a capital letter by raising the pitch of your synthesizer's 

voice. This option is available when spelling characters. 

Examples when you are spelling characters: 

 You have Character Echo set to echo each character you type. 

 You move across a line of text a character at a time. 

 You delete a character. 

To indicate capitals with a change in pitch: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. This will 

open the "Voice Preferences" dialog box. 
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4. TAB to the "Increase voice pitch for spelt capitals" check box and press 

SPACEBAR to select this item. Note that this item will not be available if 

your current synthesizer does not support this option. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

7.16  Speak the keys you press 

You can add key announcements to your key presses. This can provide 

reassurance when using your keyboard. 

To use Key Echo: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Keyboard Announcements" and press ENTER. 

This will open the "Keyboard Announcements" dialog box. 

4. Press SPACEBAR to deselect the "Automatic key echo" check box. 

5. TAB to the "Selected key echo" group and select the key groupings you 

want spoken when pressed. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

7.17  Change what SuperNova tells you about each type of 
control 

 

You can control what SuperNova automatically tells you about a button, a 

check box, a menu item or any other type of control by changing your 
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Verbosity Level. The lower the Verbosity Level, the less information 

SuperNova automatically announces about the control. 

To change Verbosity Level: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW. 

A sub-menu opens. 

4. Use the Arrow Keys to select a menu item and press ENTER. 

The Verbosity Level changes and the menu closes. 

You can also change Verbosity Level using a SuperNova hot key. 

Speech Hot Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Verbosity Scheme cycle  CAPS LOCK + 

EQUALS 

CAPS LOCK + 

V 

 
  

7.18  Change how repeated characters are read 

You can change the way SuperNova reads repeated characters that may 

appear on a line. You can have characters like dashes or plus signs 

individually spoken, read as a numeric value or indicated with a sound. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 
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2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the "Repeats" button and press SPACEBAR. This will open the 

"Repeats" dialog box. 

5. Choose how SuperNova should read repeated characters by selecting 

from the options available. 

6. TAB to the "Close" button and press SPACEBAR. This will confirm your 

changes and closes the dialog box. 

To have SuperNova use your settings requires you to have "Repeats" 

check box selected in the "Text Style Announcements" dialog box. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Text Style Announcements" and press ENTER. 

This will open the "Text Style Announcements" dialog box. 

4. For each area you want your repeat settings used, TAB to the 

"Repeats" check box and press SPACEBAR to select this item. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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C H A P T E R  8  

Braille settings 

8.1  Turn Braille output off or on 

 

You can turn off or on Braille output using the "Braille" options in the 

SuperNova control panel or by using hot keys. 

To turn Braille output off or on: 

Press LEFT CONTROL + LEFT SHIFT + 0. 
  

8.2  Show capital letters 

Some versions of Literary Braille denote capital letters by prefixing the 

letter or contraction with a special sign called a Capital Sign. Other versions 

of Literary Braille permit the omission of any such notation, thus saving 

space. 

To show or hide the displaying of the capital letter sign in Literary Braille: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the Braille menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Options" and press ENTER. This will open the "Characters" 

dialog box. 
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5. In the "Literary" group box select "Show Capitals" to display the Capital 

Sign. Unselect this option to hide the Capital Sign. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

In addition to the selection of the "Show Capitals" check box and 

irrespective of Computer Braille and Literary Braille is the option to 

"Tremble capitals". This check box is also in the "Characters" dialog box. 

Choosing this check box will mean any capital letters will blink. You can 

control the rate of blinking by the "Blink rate" setting in the "Cursor" dialog 

box. Blinking capitals in 6-dot Braille is especially useful because Computer 

Braille often uses dots 7 or 8 to denote capital letters. 
  

8.3  Show cursor position 

You can indicate the cursor position on your Braille display. This can be 

useful in edit areas. 

To show the cursor position on the Braille display: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Cursor" and RIGHT ARROW to open its sub-menu. 

4. Select "Visible" and press ENTER to select this item. 

To turn off showing the cursor position, simply repeat the steps above and 

deselect the "Visible" menu item. 

You can also show or hide the cursor position by using a Braille button 

command. Please refer to your Braille display commands for further details. 
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8.4  Show enhanced characters (bold, italic, etc.) 

You can indicate any enhanced characters on your Braille display by 

adding dot 8 to the cell. An enhanced character is any character other than 

normal, like a bold character, an underlined character or a character in a 

different size font or different color font. 

One example where this can be useful is to find out the shortcut key for 

menu items and controls in dialog boxes. The underlined letter has dot 8 

added to it. 

To turn Enhanced Display Mode on: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Enhanced" and press ENTER to select. 

To turn off showing enhanced characters, simply repeat the steps above 

and deselect the "Enhanced" menu item. 

You can also show or hide Enhanced Characters by using a Braille button 

command. Please refer to your Braille display commands for further details. 

You set what is an enhanced character in the "Characters" dialog box. You 

open the "Characters" dialog box by selecting the "Options" item in the 

"Characters" sub-menu. This dialog box contains an "Enhanced 

Characters" group. 
  

8.5  Turn off focus tracking 

In normal operation, Braille output shows the focus. SuperNova calls this 

"tracking the focus". 
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You can turn tracking the focus off. This has the effect of leaving the Braille 

display "locked" on a particular area of the screen. For example, you could 

turn Tracking off and monitor the progress of an Internet download. 

To turn off Tracking: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu. 

4. Select "Tracking" and press ENTER to deselect this item. 

To turn on Tracking, simply repeat the steps above and select the 

"Tracking" menu item. 

You can also turn off or on Tracking by using a Braille button command. 

Please refer to your Braille display commands for further details. 

Notes: 

 Turning Tracking off switches you into Braille Physical Mode. You 

return to your previous Braille mode when you turn Tracking on again. 

 You can continue to move around with Tracking turned off. 
  

8.6  Show the physical make up of the screen 

There are two ways of positioning information on your Braille display. 

 Logical Mode.  

This is the default mode used by SuperNova. In this mode the Braille 

display will show the logical association of any incidental text with the 

focus. This is similar to the speech output. The nature of Logical Mode 

means that the Braille display will not show the position of items on 

the screen. 
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 Physical Mode. 

This mode provides the opportunity to determine the physical layout of 

objects on the screen. In Physical mode, you can either show the 

characters on the line and the gaps between them (useful for general 

layout), or show a more precise layout of the position of the 

characters on the line (useful for precise document formatting).  

To turn on Physical Mode: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu. 

4. Select "Physical Mode" and press ENTER to select this item. 

To turn on Logical Mode, simply repeat the steps above and deselect the 

"Physical Mode" item. 

You can also switch modes by using a Braille button command. Please 

refer to your Braille display commands for further details. 

You set how Physical Mode shows the make up of the screen in the 

"Layout" dialog box. You open the "Layout" dialog box by selecting the 

"Options" item in the "Layout" sub-menu. 
  

8.7  Choose Computer Braille or Literary Braille 

SuperNova supports two forms of Braille output: 

 Computer Braille. 

Computer Braille strictly uses one Braille cell per character, whatever 

that character is. It is of most use in applications where every 

character is of importance, you need to distinguish each possible 

character and space is not at a premium. 

 Literary Braille. 

Literary Braille takes advantage of letter combinations in a language 
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and forms them into contractions, thus saving space. The term 

Literary Braille covers both grade 1 and grade 2 Braille tables. Literary 

Braille is of most benefit reading ordinary text. 

To change to Literary Braille: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Literary" and press ENTER to select Literary Braille output. 

To change to Computer Braille, simply repeat the steps above and deselect 

the "Literary" menu item. 

You can also switch between Literary Braille and Computer Braille by using 

a Braille button command. Please refer to your Braille display commands 

for further details. 

To select which Braille output tables are used, for example, which Braille 

language, use the options in the "Braille General Preferences" dialog box. 
  

8.8  Input using your Braille display 

 

Some Braille displays have a group of six or eight buttons arranged like a 

Braille writer. You can use these to simulate typing on your computer 

keyboard. 

To turn Braille Input on or off: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 
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2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 

4. Select "Braille Keys" and press ENTER. Braille input is on when the 

menu item is checked. Deselect this menu item to turn off Braille input. 

You can input using either Computer Braille or Literary Braille. To use 

Literary Braille input you must also ensure the "Literary Input" item is 

selected in the same sub-menu. Computer Braille input is used when 

"Literary Input" is unselected.  

When you use Computer Braille input, you use 8 dots and each Braille 

character you type will type one character in your document. 

When you use Literary Braille input, you use 6 dots and use uncontracted 

or contracted Braille (depending on the chosen input language).  Please 

note that the Braille characters you type will only appear in your document 

when you press the Braille Space key, or another key which is not a 

combination of Braille dots. 

To select which Braille input tables are used, for example, which language, 

use the options in the "Braille General Preferences" dialog box. 
  

8.9  Change Braille table 

SuperNova supports two forms of Braille output: Computer Braille and 

Literary Braille. The term Literary Braille covers both grade 1 and grade 2 

Braille tables. 

To select which Braille tables are used, for example, which language, use 

the options in the "Braille General Preferences" dialog box. Here you can 

set a language for the "Unicode to Braille Conversion" (Computer Braille) 

table and a language for the "Unicode to Literary Braille Conversion" table. 

Tip: The "Literary" item in the Braille, "Characters" sub-menu 

switches you between Computer Braille and Literary Braille output. 

Deselect this menu item to choose Computer Braille output. For 
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more information go to the "Choose Computer Braille or Literary 

Braille" topic. 

  

8.10  Change Braille display 

SuperNova works with many different Braille displays. To see what Braille 

displays are supported please visit the Dolphin web site or contact your 

local Dolphin Dealer. 

To change to another Braille display: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "General Preferences" and press ENTER. This will 

open the "General Preferences" dialog box. 

4. CONTROL + TAB to the "Braille Configuration" tab. 

5. TAB to the "Select Braille Display" button and press ENTER. This will 

open a dialog box that lists all Braille displays currently detected by 

SuperNova. 

6. Use the Arrow Keys to select an alternative Braille display. 

7. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. You return to the "General 

Preferences" dialog box. 

Your new Braille display should now be in operation. 

If your new Braille display is not listed by SuperNova: 

 Check you have successfully connected your Braille display to your 

computer. 

 Check you have successfully followed any Braille display install and 

setup procedures recommended by the display manufacturer. 
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 Check Dolphin SAM detects the device. To check that Dolphin SAM is 

configured correctly go to the "General" menu in the SuperNova 

control panel and select the "Advanced Options" menu item. In the 

"General Advanced Options" dialog box open the "System 

Configuration" property sheet and then select the "SAM Setup" button. 

If problems persist please contact your Braille display supplier for 

assistance. 
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C H A P T E R  9  

Braille reading 

9.1  Learn what your Braille buttons do 

You can use the SuperNova Key Describer to help you get familiar with 

your Braille display. An application will not see or act on any keys pressed 

when you use Key Describer. 

To turn on or off "Key Describer": 

Press CAPS LOCK + SLASH. 
  

To view or download a copy of the latest default Braille display hot keys 

visit www.yourdolphin.com/braillekeys. 

http://www.yourdolphin.com/braillekeys 
  

9.2  Moving around the screen 

As you use your application the Braille output will automatically show the 

control you are currently on. If you are using Logical Mode, the Braille will 

also show any text associated with the control. 

You can use the navigation features to move the Braille display to show 

other information, or to move the Braille along if the contents of the current 

control will not fit. 

The most important keys are the Read Backwards and Read Forwards 

keys. These move the display along the line to show the previous and next 

portions of the text. 

Braille Navigation Hot Keys 



 

78 Braille reading 

 

Function Hot Keys Braille Buttons 

Move forward LEFT 

CONTROL + 

LEFT SHIFT + 

PERIOD 

FORWARD 

command 

Move backwards LEFT 

CONTROL + 

LEFT SHIFT + 

COMMA 

BACK 

command 

The distance the Braille will move is governed by a setting in the Control 

Panel called the Scroll Margin. This value is set in the "General 

Preferences" dialog box. 

Other navigation keys that are available and will typically have Braille 

Button assignments are: 

 Line Start 

This will move the Braille display to show the content at the beginning 

of the line. This will also move the display to the beginning of any 

incidental text when in Logical Mode. 

 Line End 

This will move the Braille display to show the content at the end of the 

line. This will also move the display to the end of any incidental text 

when in Logical Mode. 

  Width Left 

This will move the Braille display to show the content one full display 

width to the left. 

 Width Right 

This will move the Braille display to show the content one full display 

width to the right. 

 Half Width Left 
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This will move the Braille display to show the content half width to the 

left. 

 Half Width Right 

This will move the Braille display to show the content half width to the 

right. 

 Cell Left 

This will move the display to show the content one Braille cell to the 

left. 

 Cell Right 

This will move the display to show the content one Braille cell to the 

right. 

 Line Up 

This will move the display to show the content one line up. 

 Line Down 

This will move the display to show the content one line down. 

 Top 

This will move the Braille display to show the content at the top left of 

the window. 

 Bottom 

This will move the Braille display to show the content at the bottom 

left of the window. 

 Go to Focus 

Move the Braille display back to the position of the focus. 

The Go to Focus key will move the Braille back to the place where you 

started navigation, i.e. to the current control. This can be particularly useful 
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when you are editing a document and wish to move straight back to the 

cursor. Of course, if you type anything, the Braille will jump back 

automatically, but this key allows you to return to the focus without affecting 

your application. 

Notes: 

 If you move up or down, you will temporarily switch into Physical 

Mode. Logical Mode is restored when you press Go to Focus. 

 Any navigation from the Braille display is independent from the 

Speech and Dolphin Cursor. 
  

9.3  Change what SuperNova tells you about each type of 
control 

 

You can control what SuperNova automatically tells you about a button, a 

check box, a menu item or any other type of control by changing your 

Verbosity Level. The lower the Verbosity Level, the less information 

SuperNova automatically announces about the control. 

To change Verbosity Level: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW to open the 

sub-menu. 

4. Select a Verbosity Level and press ENTER to confirm your change and 

close the menu. 

You can also change Verbosity Level using a SuperNova hot key. 
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To change Verbosity Level: 

Press LEFT SHIFT + CAPS LOCK + EQUALS. 
  

9.4  Move the cursor using the Cursor Routing buttons 

Many Braille displays have buttons located above each cell, called Cursor 

Routing Buttons. If you press one of these buttons then SuperNova will 

generate a single mouse click at that corresponding position. 

Examples: 

 Pressing the Routing Button In an edit area has the effect of instantly 

moving the cursor to that point. 

 Pressing a routing button above a push button will activate the button. 

 Pressing a routing button above a check box will toggle the state of 

the check box. 

Some Braille displays have a second row of Routing Buttons. This second 

row can be used to describe the character at the corresponding position. 
  

9.4.1  Change what the Cursor Routing buttons do 

You can change what the Cursor Routing buttons do by changing settings 

in the SuperNova control panel. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 

4. Select "Routing Buttons" and press ENTER. This will open the "Routing 

Buttons" dialog box. 
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5. Select the action you want the Routing Buttons to perform. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

9.4.2  Change what the Cursor Routing buttons do while using the 
Dolphin Cursor 

You can change what the Cursor Routing buttons do while you are using 

the Dolphin Cursor by changing settings in the SuperNova control panel. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 

4. Select "Dolphin Cursor Options" and press ENTER. This will open the 

"Dolphin Cursor Options" dialog box. 

5. Select the action you want the Routing Buttons to perform. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

9.4.3  Change what the Cursor Routing buttons do above Status Cells 

You can set Routing Buttons above Status Cells to perform SuperNova 

commands.  

This provides a useful function for these buttons which otherwise would 

have no purpose because their position means they cannot be used to 

route the cursor. 

Use the "Keyboard and Hot Keys" dialog box to add a Routing Button to a 

command. 
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9.5  Check text attributes 

Every character has a series of properties (attributes) associated with it, 

such as its size, font and color.  

You can learn a characters attributes by switching to Attribute Mode. 

Two different Attribute Modes are available. 

 Cycle Attributes. 

 Describe Cell. 

 The Cycle Attributes function uses special dot combinations to show the 

attributes of every character on the Braille display at once.  By contrast, 

the Describe Cell function writes a full description of just one character on 

the Braille display. 

Braille Attributes Mode Hot Keys 

Function Hot Keys Braille Buttons 

Cycle the attributes of the 

characters shown on the 

display 

LEFT 

CONTROL + 

LEFT SHIFT + 

6 

CYCLE 

ATTRIBUTES 

command 

Describe the attributes of a 

single character 

LEFT 

CONTROL + 

LEFT SHIFT + 

7 

DESCRIBE 

CHARACTER 

command 

 
  

9.5.1  Cycle attributes 

The Cycle Attributes key will cycle through the various attributes of the 

characters currently shown on the Braille display. Each cell will indicate the 

attribute of the character that was at that position. 

The Cycle Attributes command is a multi action. 
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1. Pressing the key the first time will display the size of each character.  

2. Pressing the key again will display the style of each character.  

3. Pressing the key again will display the foreground and background 

colors of the characters. 

4. Pressing the key again will display the foreground color. 

5. Pressing the key again will display the font of the characters. 

6. A final press of the key will return to normal mode. 

As you cycle through the attributes and you press a key on the computer 

keyboard or the Go to Focus command on the Braille display, then you will 

return to the normal character display mode. 

An explanation on the Braille output for each attribute is described below. 

The precise meaning of the dots shown for some of the attributes displayed 

with Cycle Attributes key may not be immediately obvious.  The function is 

provided so that it is easy to find when an attribute changes.  You may 

also find the Enhanced Characters function helpful. 

Size 

The size of characters is shown as a two digit number representing the 

point size. The upper four dots of the Braille cell are the tens digit and the 

lower four dots are the units. For example, a ten point character is shown 

by dots 1678 (A above J). 

Style 

The styles of characters are shown as follows: 

 Dot 1: Italic. 

 Dot 4: Underline. 

 Dot 2: Struck out and/or non-normal color. 
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 Dot 5: Bold. 

 Dot 3: Light. 

 Dot 6: Selected. 

 Dot 7: Link. 

 Dot 8: Normal (i.e. not italic and not underlined and not struck out and 

not bold and not light). 

Color 

The foreground and background are shown with the upper four dots 

representing the foreground and the lower four dots representing the 

background. 

Foreground Color 

The foreground attribute mode shows just the character’s foreground color 

using all eight dots of the cell. The color is represented using the 

red/green/blue (RGB) method: dots 123 show the amount of red, dots 456 

show the amount of green and dots 78 show the amount of blue. White is 

shown as all eight dots and black is shown as an empty cell. 

Font 

Each cell displays a symbol representing the character's font name. As 

only a single character is used for the whole of the name, the symbol may 

not seem related to the name it represents, for example the Arial font is 

represented by dots 15678.  To find the full name of the font, use the 

Describe Character] function. 
  

9.5.2  Describe character 

The Describe Character key will display a full description of the character at 

the cursor position. This is useful if you want to find out what an unfamiliar 

dot combination represents.  



 

86 Braille reading 

 

For example, if you find a symbol you do not understand: 

1. Use the Cursor Route button to move focus to the character. 

2. Press Describe Character to describe the character's attributes. 

3. Use the Navigation keys to move along the description if it does not fit 

on your display. 

The description includes a description of the character itself together with 

all the attribute information available. The information is written out in full. 

You will see a description similar to the following: 

"(Dots 467) POUND, Arial, normal, 14PT, Black, White, 00a3" 

This shows: 

 The character being described. In this example it is dots 467. 

 The description of the character (the Pound sign). 

 The font name of the character. 

 The style. 

 The size ("PT" is an abbreviation for "point"). 

 The foreground color of the character. 

 The background color. 

 The Unicode value of the character. 
  

9.6  Show information on the Braille display Status Cells 

Many Braille displays have a special group of cells to the left of the main 

display area to display status information.  
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SuperNova can use these status cells to display extra information about the 

character under the cursor, for example, its size and color. 

You can show any of the following status information: 

 Features on display. 

 Cursor position across the line. 

 Type of the current focus. 

 Any of the attributes of the character under the cursor 

You can select as many options as you want, except that you will be limited 

to the number of status cells you have on your Braille display. 

Each option takes one cell. 

Notes: 

 Although your Braille display may not have dedicated status cells, you 

may be able to simulate status cells using the SAM driver. To check 

this, call up the Driver Configuration dialog box from the SAM Control 

Panel. SAM can be opened from the "General Advanced Options" 

dialog box. 
  

9.7  Show Braille output on the screen 

You can show what is being output to your Braille display inside a small 

fixed window on the screen. This is the "Show Braille On Screen" item in 

the "Braille" menu. 

To turn the "Show Braille On Screen" option off or on: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + B. This will open the "Braille" menu. 



 

88 Braille reading 

 

3. DOWN ARROW to "Show Braille On Screen" and press ENTER. This 

will confirm the change and close the menu. 

You can also show or hide the window with a hot key: 

Press LEFT CONTROL + LEFT SHIFT + 1. 

You can change the position and size of the window through options in the 

"Braille Advanced Options" dialog box. 
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Dolphin Cursor 

The Dolphin cursor is a special kind of cursor created by SuperNova. The 

Dolphin Cursor allows you to read the contents of the screen line by line, or 

word by word, or letter by letter using your keyboard. You can use the 

Dolphin cursor to review any part of your computer's screen. 
  

10.1  Turn on the Dolphin Cursor 

You can turn on the Dolphin Cursor and position it either at the last place it 

was located or at the current focus position. 

Dolphin Cursor Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on Dolphin Cursor NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn on Dolphin Cursor and 

position it at the current focus 

position 

NUMPAD 

ASTERISK 

CAPS LOCK + 

MINUS 

 
  

10.2  Turn off the Dolphin Cursor 

If you have turned on the Dolphin Cursor, then to turn off the Dolphin 

Cursor you must use the following hot key. 

 

Dolphin Cursor Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn Dolphin Cursor off NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn off the Dolphin Cursor 

and prevent the Dolphin 

Cursor being automatically 

turned on 

CONTROL + 4 No Assignment 

The Dolphin Cursor also turns off automatically if something happens on 

the screen, for example, a message window appears. 
  

10.3  Turn off the automatic Dolphin Cursor 

SuperNova will automatically turn on the Dolphin Cursor in certain places in 

certain applications. This default behavior will occur usually when it is not 

possible to read the text on the screen line by line using the keyboard 

commands available in the application. 

If you want to prevent this behavior because you do not wish to use the 

Dolphin Cursor then you must deselect the "Use Dolphin Cursor 

automatically" check box.  

To turn off the automatic use of the Dolphin Cursor: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Advanced Options" and press ENTER. This will 

open the "Advanced Options" dialog box. 

4. In the "Cursor" properties, press SPACEBAR to deselect the "Use 

Dolphin Cursor automatically" check box. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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6. Press ESCAPE to exit the SuperNova control panel. 

If you want this setting change only to apply to the current application then 

you must first create an Application Settings file. See "Create Application 

Settings" for more information. 
  

10.4  Select text using the Dolphin Cursor 

You can select text from the screen using the Dolphin Cursor. Text includes 

text from dialog boxes and message windows as well as text from web 

pages and documents. 

To select text using the Dolphin Cursor: 

1. Press SHIFT + Arrow Keys to make your selection or press CONTROL 

+ A to select all the text in the current window. 

2. Press CONTROL + C to copy your selection to the Clipboard. 

3. Go to the place you want to insert the selected text. 

4. Press CONTROL + V to paste the content from the Clipboard. 
  

10.5  Search using the Dolphin Cursor Find Command 

You can use the Dolphin Cursor Find Command to perform a basic search 

for text on the screen, in documents and on web pages. You will find more 

advanced Dolphin Cursor Find Commands available with some 

applications. 

To perform a basic search: 

1. Turn on the Dolphin Cursor. 

2. Press F3. This will place you in an invisible edit box. 

3. Enter your search string. The text you enter is case insensitive, you are 

always in Insert Mode and the keyboard layout will match your current 

application. 
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4. Press ENTER to start searching the current window. The Dolphin 

Cursor will move to the first match it finds. 

5. To find the next match, press F4. To find the previous match, press F2. 

Note that SuperNova will remember your last search string until you quit 

SuperNova. This means you can perform the same search without entering 

the search string again. You only need to turn on the Dolphin Cursor and 

press F4 or F2 to search for the next or previous match. 
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Line View 

 

Line View is a SuperNova reading mode. Line View shows the content of 

the screen as a single line scrolling across the screen. You can control the 

size, colors, font and the speed and position of the scrolling text. 
  

11.1  Start Line View 

You can start Line View from the "Visual" options in the SuperNova control 

panel or by using a hot key. Line View can start at the current focus 

position or it can ignore the current focus in favor of displaying the current 

window or screen. 

Line View Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Start Line View (restricted to 

document window) 

LEFT 

CONTROL + 

NUMPAD 

PERIOD 

No Assignment 

Start Line View (restricted to 

whole window) 

LEFT 

CONTROL + 

NUMPAD 9 

No Assignment 

Start Line View at current 

focus position (restricted to 

document window) 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 2 

ALT + SHIFT + 

L 
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Start Line View at current 

focus position (restricted to 

whole window) 

LEFT 

CONTROL + 

NUMPAD 2 

ALT + SHIFT + 

V 

 
  

11.2  Scroll text in Line View 

You use various hot keys to control how the content scrolls in Line View. 

Line View Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Go to the Focus NUMPAD 0 F5 

Start and Stop SPACEBAR SPACEBAR 

Go to the First line HOME HOME 

Go to the Last Line END END 

Previous Line PAGE UP PAGE UP 

Next Line PAGE DOWN PAGE DOWN 

Scroll Faster UP ARROW UP ARROW 

Scroll Slower DOWN 

ARROW 

DOWN 

ARROW 

Flip forward ENTER ENTER 

Move Forward RIGHT 

ARROW 

RIGHT 

ARROW 

Move Backwards LEFT ARROW LEFT ARROW 

Exit Line View mode ESCAPE ESCAPE 

Tip: Line View mode is restricted to what is visible on the screen. In some 

applications it is possible to change the application's view settings to 

increase the data visible at any one time. For example, in Microsoft Word 

Print Preview it is possible to set the page view to a maximum of 6 pages. 

All 6 pages will be scrolled in Line View mode. 
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11.3  Change the color, font and items displayed in Line View 

You can change the colors, fonts, objects and the size of the text shown in 

Line View. 

To go to the Line View options: 

1. Press Left control + SPACEBAR. This will open the SuperNova control 

panel. 

2. Press ALT + V. This will open the "Visual" menu. 

3. DOWN ARROW to "Advanced Options" and press ENTER. This will 

open the "Visual Advanced Options" dialog box. 

4. CONTROL + TAB to open the "Line View " tab. 

5. Make your changes. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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Doc Reader 

 

The Doc Reader lets you create your own reading environment, where the 

text, background and highlight can all be set to a value that makes reading 

comfortable for you. You can display text from documents, web pages or 

any other source showing text on the screen. 
  

12.1  Launch Doc Reader 

You can launch the Doc Reader by clicking the Doc Reader button on the 

"Visual" page of the SuperNova control panel or by pressing a SuperNova 

hot key. 

Doc Reader Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Launch Doc Reader CAPS LOCK + 

NUMPAD 

PLUS 

ALT + SHIFT + 

D 

Your text will be loaded into the Doc Reader. This may take a few seconds. 

In the Doc Reader, you can use the Arrow Keys to move the highlight 

through the text or press TAB to move through the Doc Reader toolbar 

options. 
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12.2  Control reading 

The items available on the Doc Reader toolbar control the reading 

environment. For advanced controls, including the color settings, fonts and 

reading speed please go to the "Doc Reader Settings" dialog box. 

After launching the Doc Reader, you can access the toolbar options by 

pressing TAB. Repeated presses of TAB will move you along the toolbar 

options and finally return you to the document window.  You can also use 

SHIFT + TAB to navigate back across the toolbar buttons. 

Doc Reader toolbar. 

 

You press this button to start or stop the reading of the document. You can 

also start or stop the reading of the document by pressing SPACEBAR. 

When reading, the Doc Reader highlights the current word and 

automatically scrolls the document window. 

 

You press this button to increase the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 
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You press this button to shrink the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 

 

You press this button to cycle through the highlighting options, where you 

can cycle between line, sentence and paragraph highlighting.  The item 

selected determines what is highlighted as a "unit" and the size of 

movement as you navigate up and down through your text. 

 

You press this button to cycle through a number of different color schemes. 

This is helpful if you find viewing the on screen document text difficult 

because of screen colors and contrast.  

 

You press this button to open the "Mode" menu, where you can choose 

between different viewing mode options such as "Word Wrap" and "Single 

Line". 
  

12.3  Exit Doc Reader 

To do this: 

Press ESCAPE. 

 



 

100 Doc Reader 
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Profiles 

SuperNova provides a number of ready-made profiles that allow you to 

quickly tailor the amount of speech feedback generated by SuperNova 

without having to make multiple individual setting changes in SuperNova’s 

control panel. 

To select a profile: 

1. Press LEFT CONTROL + SPACEBAR. The SuperNova control panel 

opens. 

2. Press ALT + F. The File menu opens. 

3. DOWN ARROW to "Profile…" and press ENTER. The "Profiles" dialog 

box opens. 

4. In the "Profile" list box select the name of the profile that you wish to 

use. (A description of what the currently selected profile is tailored to do 

is displayed in the "Description" box directly below.) 

5. Once your desired profile has been selected TAB to the "OK" button 

and press SPACEBAR. This will confirm your profile choice and close 

the dialog box. 

The status bar of SuperNova’s control panel will automatically update to 

display the name of your newly selected profile and any SuperNova control 

panel options that have been disabled by your currently selected profile will 

become grayed out. 

You can also RIGHT CLICK on the profile name in the status bar in order to 

quickly change profiles. 

Here is a list of the available profiles: 
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Note: Not all of the profiles listed below are available in every edition 

of SuperNova. 

 

Magnifier 

Magnification only for mouse users wanting the fastest performance. It will 

magnify, follow the mouse pointer and track the cursor as you type. This 

profile disables all speech and Braille. 

 

Magnifier & Speech with mouse 

Magnification with occasional speech, designed for mouse users. This 

profile enables speech on demand: it will speak text under the mouse and 

includes hotkeys to read the current line, sentence or paragraph. This 

profile disables automatic speech, Dolphin Cursor, reading tools and Braille 

output from a Braille display. 

 

Magnifier & Speech with keyboard 

Magnification with some automatic speech for mouse and keyboard users. 

This profile will speak as you type and read the item in focus, such as 

menus, list items etc. It switches on the Dolphin Cursor so you can read a 

web-page from the keyboard. Read From Here and Doc Reader are also 

included for hands-free reading with speech. This profile disables screen 

reading descriptions and Braille output from a Braille display. 

 

Magnifier & Screen Reader 
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This profile supports both mouse and keyboard users, offering 

magnification with full screen reading in speech and/or Braille via a Braille 

display. This profile is fully-featured and offers the greatest flexibility. 

 

Screen Reader 

Full speech and/or Braille screen reading designed for keyboard users with 

no useful sight. This profile disables all magnification and visual effects and 

enables Braille output via a Braille display. 

 

Screen Reader with visual effects 

Full speech and/or Braille screen reading for keyboard users. This profile 

disables magnification but enables visual effects including visual 

highlighting of the focus. This profile is recommended for those with a 

limited field of vision, or when sharing your screen with a sighted colleague 

or trainer. 
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Guest Mode and Emergency Mode 

The USB edition of SuperNova contains a special feature called Guest 

Mode. Guest Mode allows your USB edition to operate in environments 

where you don't have Administrator access on the computer, such as 

public libraries and hotel business centers. 

 

Startup 

To start your USB edition of SuperNova run the program Go.exe (located in 

the root folder of your USB drive). 

If you've previously installed the additional SuperNova USB components 

onto the computer then your USB edition is likely to auto-start when you 

insert it. 

If you insert your USB edition on a computer that has an existing copy of 

SuperNova already installed that's the same version (or higher) as your 

USB edition, or a computer that you have previously installed the additional 

USB edition components onto, then you will not have the Guest Mode 

option. Instead your USB edition will run in Normal Mode. 

When you start your USB edition of SuperNova on a new computer, or a 

computer without any additional components installed, you'll receive a 

dialog box with two options: 

 Continue in Guest Mode 

or 

 Install components and restart 
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If you choose the install components option a Windows' User Account 

Control dialog will appear requesting Administrator permissions. If you 

select "Yes" then the additional components will be installed. For Windows 

7 the computer will then be restarted. For Windows 8 and Windows 10 only 

SuperNova will restart and it should then run in Normal Mode. 

 

15.1  Limitations of Guest Mode 

 Magnification will not pan around quite as smoothly as in Normal 

Mode. The computer's CPU and GPU usage may also be a little 

higher than in Normal Mode even when doing nothing. Magnification 

may also be not as smooth if you have more than one monitor in use. 

 The Connect and View video stream is unlikely to update faster than 

30 frames per second. 

 Custom mouse pointers won't work. You can try to use the Windows 

control panel to set a custom mouse pointer, but this may also not 

work if you choose one of SuperNova’s custom mouse pointers (due 

to a bug in Windows). 

 There's no speech and magnification support at the Windows logon 

screen. (You can use Windows Narrator and/or Windows Magnifier 

here instead). 

 Windows' User Account Control dialog boxes will not magnify or 

speak. 

 Any application that runs as Administrator may not be accessible and 

may cause other problems, notably no SuperNova hot keys will work 

and you'll receive limited or no speech and braille output. This could 

also prevent the user interface in Connect and View and Line View 

Mode from working. If you get stuck in this scenario press ALT+TAB 

to switch away from the application. 

 The Internet Updater will continue to work for maps and scripts, but 

will not download product updates. 
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 Modern Windows 8/10 apps should speak and braille just as well as in 

Normal Mode. However, the image smoothing of magnified text may 

not work. 

 Pressing PRINT SCREEN or ALT+PRINT SCREEN will capture the 

magnified screen or the area of the magnified screen where the 

window would be if it wasn't magnified (respectively). To capture 

unmagnified screens toggle magnification off before pressing PRINT 

SCREEN.. 

 TeamViewer remote control sessions will capture the magnified 

screen not the unmagnified screen. 

 SuperNova's touch screen gestures will not work. 

 SuperNova's OCR features may not work. 

Please refer to the Dolphin web site for any other caveats. 

Emergency Mode 

If you run a copy of SuperNova that was installed on the computer's local 

hard disk, but some components are missing, then SuperNova will start up 

in Emergency Mode and you'll receive a dialog box with two options: 

 Continue in Emergency Mode 

or 

 Install components and reboot 

If you choose the install components and reboot option a Windows' User 

Account Control dialog will appear requesting Administrator permissions. If 

you select "Yes" then the additional components will be installed and the 

computer will be rebooted. 

Emergency Mode is functionally equivalent to Guest Mode. Please see the 

limitations listed above for further details. 
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Note: Currently Guest Mode and Emergency Mode are only 

available on Windows version 10 (and below). 
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Settings Files 

16.1  Types of Settings 

Settings can be grouped into the following broad categories: 

 Input Settings control what SuperNova understands about the 

environment it is currently in. Map files and Script files hold this data. 

 Output settings are the settings you can configure in SuperNova for 

an application. Application Settings files and Situation Settings hold 

this data. 

 Global Settings are settings you cannot configure on a per application 

basis. This includes hot keys, control panel settings, Update Settings 

and Window Settings. 

You can create, edit, import and export both the input and output settings. 

You do this by choosing items from the "File" menu in the SuperNova 

control panel. 
  

16.2  Create Application Settings 

If you find you regularly adjust SuperNova output settings when working in 

different programs, then using Application Settings can provide an 

automated solution. 

To create an Application Settings file: 

1. Run the application you want to create an Application settings file for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

3. Press ALT + F. This will open the "File" menu with "New" selected. 
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4. RIGHT ARROW into the "New" sub-menu. 

5. Select "Application settings" and press ENTER. This will open the 

"Select Settings file" dialog box. 

6. Select "Create a new settings file". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Create new Settings File" dialog box. 

8. Give the new Application Settings file a name, choose whether to create 

an empty settings file or copy an existing settings file and then TAB to 

the "OK" button and press SPACEBAR. This will close the dialog box 

and return you to the SuperNova control panel. 

Your Application Settings file will now be in use. You can check the 

Application Settings file currently in use by reading the Status Bar in the 

SuperNova control panel. 
  

16.3  Create Situation Settings 

If you find you regularly adjust SuperNova output settings when certain 

dialog boxes appear in an application then using Situation Settings can 

provide an automated solution. Situation Settings are a subset of 

Application Settings and are stored within the same file. 

To create a Situation Setting: 

1. Run the application and get into the situation you want to create a 

Situation Setting for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

3. Press ALT + F. This will open the "File" menu with "New" selected. 

4. RIGHT ARROW into the "New" sub-menu. 

5. Select "Situation settings" and press ENTER. This will open the "New 

Situation Settings" dialog box. 
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6. Select "Create new Situation". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Enter a name for the new Situation" dialog box. 

8. Give the new Situation Setting a name and then TAB to the "OK" button 

and press SPACEBAR. This will open the "Windows Name" dialog box. 

9. If required, adjust the Window Name and then TAB to the "OK" button 

and press SPACEBAR. This will close the dialog box and return you t 

the SuperNova control panel. 

Your Situation Setting will now be in use. You can check the Situation 

Setting currently in use by reading the Status Bar in the SuperNova control 

panel. 
  

16.4  Save setting changes 

SuperNova automatically saves the changes you make to SuperNova 

settings.  

To stop this behavior, deselect the "Always save user settings" check box. 

You can find the "Always save user settings" check box in the "Startup 

Preferences" dialog box, which you open through the "General" menu of 

the SuperNova control panel. 

After deselecting the "Always save user settings" check box, an additional 

"Ask user" check box becomes available. If you select this check box then 

you will receive a message window during the quitting of SuperNova that 

asks if you want to proceed without saving the changes you have made. 

You can also manually save settings at any time by choosing the "Save 

Settings" menu item. You can find this item in the "File" menu in the 

SuperNova control panel. 
  

16.5  Change Map file 

If you are using an application that does not have a specific Map file then 

SuperNova will use the "Default Application" Map file. 
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If you find SuperNova does not work well with your application using the 

"Default Application" Map file then it is worth trying another Map file. You 

can try as many Map files as you like. 

Tips: 

 Try using a Map file for a different version of the same application. 

You may find a Map file for an old version of an application will work 

just as well with a new version of the application. 

 Try using a Map file created for an application from the same 

manufacturer. You may find a Map file for a different application but 

created by the same manufacturer will work well with your application, 

for example, if you are using a Microsoft application try using the 

Microsoft Office Map file. 

 Try using the "MSAA Application" Map file if you know your application 

supports MSAA. 

To choose a different Map file: 

1. Run your application. 

2. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

3. Press ALT + F. 

The "File" menu opens with the "New" menu item selected. 

4. RIGHT ARROW to open the "New" sub-menu, DOWN ARROW to 

"Map" and press ENTER. 

The "Select Map file" dialog box opens. 

5. DOWN ARROW to select the "Use an existing Map file" option. 

6. TAB to the Map list and use the Arrow Keys to select a Map file. 

7. TAB to the "OK" button and press SPACEBAR. 

The dialog box closes. 
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8. Press ESCAPE. 

The SuperNova control panel closes and you go back to the application. 

The new Map file's detection settings will take effect immediately. If you 

continue to have problems accessing your application then please contact 

Dolphin or your local Dolphin Dealer for assistance. 
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Media 

You can use Media to search for and download books and magazines from 

online libraries and to browse news feeds, listen to radio stations and play 

popular podcasts. 

IMPORTANT: The options available in Media will differ depending 

on your SuperNova Control Panel language. 

  

17.1  Media Scan and Read 

You can use Media's "Scan and Read" option to convert printed material 

and image-based files into a format you can read on the computer.  

IMPORTANT: For SuperNova to successfully detect and work with a 

scanning device requires the device to be WIA compliant. Today, 

the majority of scanning devices are WIA compliant. Please refer to 

your manufacturer's support documentation for assistance. 

  

17.1.1  Scan and read a file 

You can use the Media "Scan and Read" option to convert image-based 

files into a format you can read on the computer. You do not require a 

scanner or digital camera connected to the computer to perform this task. 

To do this from the SuperNova Control Panel: 

1. Open the "Media" option, select "Scan and Read" and choose "From 

file". 

2. Select the file you want to convert. If you are using a keyboard you can 

do this by pressing SHIFT + TAB to move into the file list, use the Arrow 
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Keys to select the file and then press ENTER. If the file is in a different 

folder, use BACKSPACE to go one level up and use ENTER to open 

folders until you select the file and then press ENTER. 

3. Select your conversion settings. Note that you must choose to open the 

document in Microsoft Word if you want to edit the converted document. 

4. Select the "OK" button. A message window opens showing the 

progress of the conversion. When the conversion is complete the book 

opens in Microsoft Word or the SuperNova Reader. 
  

17.1.2  Scan and read printed material 

You can use the Media "Scan and Read" option to convert print material 

into a format you can read on the computer. 

IMPORTANT: For SuperNova to successfully detect and work with a 

scanning device requires the device to be WIA compliant. Today, 

the majority of scanning devices are WIA compliant. Please refer to 

your manufacturer's support documentation for assistance. 

To scan and read printed material from the SuperNova Control Panel: 

1. Ensure the scanning device is correctly connected to the computer. 

2. Open the "Media" option, select "Scan and Read" and choose "From 

scanner". 

3. Select your conversion settings. Note that you must choose to open the 

document in Microsoft Word if you want to edit the converted document. 

4. Select the "OK" button. A message window opens showing the 

progress of the conversion. When the conversion is complete a second 

message window opens asking if you want to stop or continue scanning 

pages.  

5. If you want to scan more pages, add the new page to the scanner and 

select the "Add More Pages" button. Repeat this process until all pages 

are scanned and you are ready to read the text. 



 

Media 117 

 

6. When done, select the "Stop Loading Pages" button. The book opens in 

Microsoft Word or the SuperNova Reader. 
  

17.1.3  Scan and read a clipboard image 

You can use the Media "Scan and Read" option to convert an image you 

copied to the Windows Clipboard to a format you can read. This feature 

works best with simple uncomplicated images. 

To scan and read an image you copied to the clipboard from the 

SuperNova Control Panel: 

1. Open the "Media" option, select "Scan and Read" and choose "From 

clipboard". Note that this option will be disabled if SuperNova does not 

detect an image present on the Windows Clipboard. 

2. Select your conversion settings. Note that you must choose to open the 

document in Microsoft Word if you want to edit the converted document. 

3. Select the "OK" button. A message window opens showing the 

progress of the conversion. When the conversion is complete The book 

opens in Microsoft Word or the SuperNova Reader. 

Tip: If you find the images you convert from the clipboard are 

unsatisfactory then try saving the image as a .JPEG file and using 

the Scan and Read "From file" option to improve the conversion 

quality. 

  

17.1.4  Adjust "Scan and Read" settings 

The "Scan and Read Settings" dialog box gives you options to choose an 

alternative scanning device, scanning language, level of color recognition, 

paper size and output folder. 

You can go to the "Scan and Read Settings" dialog box in the SuperNova 

Control Panel by opening the "Media" option, selecting "Scan and Read" 

and choosing "Scan and Read Settings". To learn more about the available 

options see the "Scan and Read Settings" dialog box. 
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17.2  Media Books 

You can use the "Books" option to search for, download and open books 

and magazines from online libraries. You can also use this option to open 

files on the computer. The books and files you select open in the 

SuperNova Reader. 
  

17.2.1  Open a file in the SuperNova Reader: 

You can use Media to open files on the computer. The file formats you can 

open include text files, ePub files, DAISY books, HTML files and PDF files. 

The files will open in the SuperNova Reader. 

To open a file from the SuperNova Control Panel: 

1. Open the "Media" option, select "Books" and choose "Open file in 

Reader". The "Open" dialog box opens. 

2. Select the file you want to open. If you are using the keyboard you can 

SHIFT + TAB into the file list, use the Arrow Keys to select the file and 

then press ENTER. If the file is in a different folder, use BACKSPACE 

to go one level up and use ENTER to open folders until you select the 

file and then press ENTER. 

3. Select your conversion settings.  

4. When done, select the "OK" button. A message window opens showing 

the progress of the conversion. When the conversion is complete the 

book opens in the SuperNova Reader. 

5. When you have finished reading the text, press ALT + F4 to close the 

window. 
  

17.2.2  Open a book from an online library 

You can use Media to download and open books from online libraries. The 

files will open in the SuperNova Reader. 

To open a book from the SuperNova control panel: 
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1. Open the "Media" option, select "Books" and choose "Online books". 

The Bookshelf dialog box opens showing a list of available libraries. 

Note that some libraries may require you to register with them before 

you can download a book. If you want to use the services of these 

libraries then you must first contact the library to register with them and 

obtain user account details. 

2. Select a library. Depending on the library, you will typically find a 

category list opens giving you further options to narrow down the list of 

books to be shown. This can sometimes be followed by a third and 

fourth list of subcategories. 

3. Browse the available categories and books. Alternatively, if you know 

the title of the book you want to read, type in a key word in the search 

box and press ENTER. SuperNova will search the library for matches 

and list the results. 

4. Select the book you want to read and choose the "Download" button. 

5. When the download is complete, do one of the following: 

If you want to read the book, select the "Read now" button. The book 

opens in the SuperNova Reader. When you have finished reading the 

text, press ALT + F4 to close the window. 

If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and select the "Send To" 

button. A dialog box opens listing the drives you can copy the book to. 

Select the drive and press ENTER. A confirmation message will appear 

when the process is complete. 

If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

17.2.3  Open the last book you were reading 

You can continue reading the last book you opened by opening the "Media" 

option, selecting "Books" and choosing "Continue reading...". The book 

opens in the SuperNova Reader. You will be positioned at the last place 

you were in the book. 
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17.2.4  Open a newspaper from an online library 

You can use Media to download and open newspapers and magazines 

from online libraries to which you have subscribed. The files will open in the 

SuperNova Reader. 

To open a newspaper or magazine from the SuperNova control panel: 

1. Open the "Media" option, select "Books" and choose "My Newspapers". 

The "My Newspapers" dialog box opens listing newspapers and 

magazines to which you are subscribed. If the list is empty then choose 

the "Add more" button and choose the library you want to subscribe to. 

If you are not subscribed to a library then please contact the library to 

register with them and obtain user account details. 

2. Select the newspaper and then the edition you want to read. The 

newspaper opens in the SuperNova Reader. 

3. When you have finished reading the text, press ALT + F4 to close the 

window. 
  

17.2.5  Open, copy or delete an existing book 

You can open, copy and delete books you download from online libraries. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option, select "Books" and choose "My Books.. A list 

opens showing available books. 

2. Select the book you want to open, copy or delete. A dialog box opens. 

3. Do one of the following: 

If you want to read the book, select the "Read now" button. The book 

opens in the SuperNova Reader. When you have finished reading the 

text, press ALT + F4 to close the window. 

If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and then select the "Send 

To" button. A dialog box opens listing the drives you can copy the book 
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to. Select the drive and press ENTER. A confirmation message will 

appear when the process is complete. 

If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

17.3  Media News, Radio Stations and Podcasts 

You can use Media's "News", "Radio Stations" and "Podcasts" to keep 

up-to-date with the latest news and entertainment available on the Internet. 

IMPORTANT: Some content requires RealPlayer to be installed. If 

you do not have support for this content then SuperNova displays a 

warning message. The message includes links to web sites where 

you can download the necessary files. 

  

17.3.1  Read a news article 

You can open, browse and read popular news articles available on the 

Internet using Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select "News". A list of popular news 

feeds opens. 

2. Select a feed. If you do not find a feed you are interested in reading, 

select the "Add" button to explore other available feeds, which you can 

add to the Favorites list. 

3. Select a headline. The dialog box closes and the news article opens in 

the default web browser. 
  

17.3.2  Listen to a radio station 

You can listen to popular radio stations available on the Internet using 

Media. 
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To do this from the  SuperNova control panel: 

1. Open the "Media" option and select "Radio". A list of popular radio 

stations opens. 

2. If you do not find a radio station you are interested in listening to, select 

the "Add" button to explore other available radio stations, which you can 

add to the Favorites list. 

3. Select a radio station. The dialog box closes and the radio station 

begins to play in an associated media player, for example, Windows 

Media Player. 
  

17.3.3  Listen to a podcast 

You can listen to popular podcasts available on the Internet using Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select "Podcasts". A list of popular 

podcasts opens. 

2. If you do not find a podcast you are interested in listening to, select the 

"Add" button to explore other available podcasts, which you can add to 

the Favorites list. 

3. Select a podcast and then choose an episode. The dialog box closes 

and the podcast begins to play in an associated media player, for 

example, Windows Media Player. 
  

17.3.4  Adjust the favorite news, radio station and podcast listings 

You can add, remove and organize the news, radio stations and podcast 

listings in Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select the web service you want to modify. 

A list opens showing available services. 
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2. Do one of the following: 

To add a service, select the "Add" button. This opens a new dialog box 

containing a list of the services you can add and a list of the currently 

available services. Select a service to add and then choose the "Add" 

button. Repeat the steps for each service you want to add. 

To remove a service, select the service, then choose the "Remove" 

button. Repeat the steps for each service you want to remove. 

To organize the list of services, select a service and then choose the 

"Up" or "Down" button. This will move the item higher or lower down the 

list of services. Continue to press the button until you position the item 

in the list where you want it to be placed. 

3. When done, select the "Close" button. 
  

17.4  SuperNova Reader keyboard commands 

The books you open from the Bookshelf appear as an HTML page in the 

SuperNova Reader. This allows you to read and navigate the book in the 

same way you read web pages. 

In addition, SuperNova includes the following keyboard commands: 

Function Hot key 

Move between document 

window and toolbar 

F6 

Move between the buttons on 

the toolbar 

TAB and SHIFT + TAB 

Play / stop (only available if book 

has audio content) 

F5 

Open Content ALT + C 

Open Settings ALT + S 

Zoom In ALT + I 

Zoom Out ALT + O 

Exit ALT + E (or ALT + F4) 
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C H A P T E R  1 7  

Connect and View 

 

SuperNova Connect and View lets you connect any high-definition (HD) 

camera to your computer and magnify items including newspapers, 

magazines, bills, labels and even objects onto your computer screen. 

You can also use SuperNova Connect and View to connect to other 

computers and view what is on their screen on your own computer screen. 

For example, you can connect to a teacher's interactive whiteboard or a 

trainer's computer and follow what they are presenting on your own 

computer screen. 
  

18.1  Camera Connect and View 

Camera Connect and View lets you connect any High-Definition (HD) 

Camera to your computer and magnify printed material and objects onto 

your computer screen. 

You can use any high-definition (HD) camera with SuperNova. For an 

official list of cameras that have been tested and are recommended by 

Dolphin, please visit the Dolphin web site or contact your local Dolphin 

dealer. 

Before you can use SuperNova Camera Connect and View you will need to 

acquire a suitable camera, setup your workstation and select the camera in 

SuperNova. 
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18.1.1  Acquiring a suitable camera and stand 

For best results you will need an HD camera with autofocus, delivering 

1080p video resolution with automatic low-light correction. This will require 

a USB 2.0 port connection to the computer. 

In addition to the camera, you should use a stand to hold the camera on 

the desk. The use of a stand makes sure the camera is secure and stable 

over the items you want to view. 
  

18.1.2  Setting up your workstation 

For best results, ensure you position the camera close to your computer 

screen to make it easy to adjust the items you want to view while still being 

able to view the computer screen. You should also make sure the camera 

is in a safe, clear, well lit area on your desk to avoid shadows falling across 

the items you want to view. 
  

18.1.3  Selecting the camera in SuperNova 

Once you have setup the camera on your desk and connected it to the 

computer, you must select the camera in the SuperNova "Connect and 

View Settings" dialog box. 

To do this in the SuperNova Control Panel: 

1. In the "Visual" option, open the "Connect and View" submenu and 

choose "Settings". The "Connect and View Settings" dialog box opens 

showing the "Camera" settings. 

2. Select your camera from the "Devices" list and choose the "OK" button. 

If your camera is not listed then ensure it is properly connected and 

switched on. 
  

18.1.4  Using your camera with SuperNova 

You can use the following options to enable, configure and adjust the 

camera image with SuperNova. 
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Switching on the Viewer 

After selecting the device in the "Connect and View Settings" dialog box, 

you can view its output by turning on "Connect and View". You can switch 

on or off "Connect and View" using the "Visual" options in the SuperNova 

control panel or by using a hot key. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Connect and View on off ALT + 

NUMPAD 

ENTER 

LEFT SHIFT + 

CAPS LOCK + 

0 

 

When you turn on "Connect and View" a portion of the screen begins to 

show the image from the camera or whiteboard. This area is called the 

Viewer. You can change the position of the Viewer on the screen and you 

can use the Viewer Toolbar to adjust the size, color and contrast of the 

image to make it easier to see. 

 
  

Switching between the Viewer and the desktop 

To access the Viewer toolbar and to make adjustments to the image 

requires you to place the focus in the Viewer area. 

You can switch between the Viewer and the desktop by pressing CAPS 

LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera 

and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE 

BUTTON cycles you between camera, whiteboard and desktop. 
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Adjusting the Viewer position and size 

By default, the Viewer appears on the top half of the screen. You can 

change the position and size of the Viewer through the "Connect and View" 

settings in the SuperNova Control Panel. You can dock the viewer to the 

top, bottom, left or right side of the screen and the Viewer can be set to fill 

80%, 50% or 20% of the screen area. 

While in the Viewer window you can press LEFT CONTROL + NUM PAD 7 

on your keyboard to cycle you between split screen mode and full screen 

mode. 

You can also do this using the following buttons in the Viewer window: 

 

 

 

While in Full Screen Mode, you can continue to use CAPS LOCK + 

MIDDLE MOUSE BUTTON to switch between the Viewer and the desktop. 
  

Showing and hiding the Viewer toolbar 

The Viewer Toolbar provides you with controls to modify the image you are 

viewing. The options available on the toolbar differ depending on whether 

you are connecting to a camera or connecting to a whiteboard. 

You can use the Show and Hide buttons to control the appearance of the 

Viewer Toolbar. If you hide the toolbar then you will be increasing the 

amount of information that appears in the Viewer. 
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The style of the Show and Hide buttons differs depending on where the 

Viewer is docked. For example, if the Viewer is docked to the top then the 

Show and Hide buttons appear as Arrows pointing to the left and right.  

    

 

If the Viewer window is docked to the left then the Show and Hide buttons 

appear as Arrows pointing up and down. 

    

In all cases, the position of the Hide button is always the last button on the 

Viewer Toolbar. 

Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and 

shows the Viewer Toolbar. 
  

Magnifying the image in the Viewer 

    

You can change the size of the image in the Viewer by using the 

magnification buttons in the Viewer Toolbar. If you are using a touchscreen 

device, you can also change magnification by doing a 2 finger pinch or 2 

finger stretch. 

You can also use the following hot keys: 
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Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 

Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

 
  

Viewing other parts of the image 

If you find the image you are looking at is larger than what is appearing in 

the Viewer then you can move the mouse pointer or use SuperNova's Pan 

feature to scroll the image with the keyboard. 

To pan across the screen press RIGHT CONTROL plus an Arrow Key. 

Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key 

repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. 

Press the opposite Arrow Key to slow down.  

To learn more about panning see "View other parts of the screen". 
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Rotating the image in the Viewer 

 

You can rotate the image in the viewer to present it in a way that is easiest 

for you to read. This avoids the necessity to rotate the text under the 

camera. With each press of this button the image rotates by 90 degrees 

clockwise. 

Pressing LEFT CONTROL + NUM PAD 1 on your keyboard will also rotate 

the image by 90 degrees clockwise each time you press this hot key 

combination. 
  

Changing the colors of the image 

 

If you are finding viewing the image difficult because of the colors and 

contrast, then you can use the Color Changer button to cycle through a 

number of different color schemes.  

Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles 

you through the available color schemes. 

SuperNova saves the Color Scheme you choose in the "Connect and View 

Settings" dialog box. 
  

Improving image quality 

SuperNova contains a number of optional image processing features, such 

as an Enhance High Contrast Colors option, that helps boost the contrast 

of images while using one of SuperNova's built in color schemes. This 
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option is particularly useful when viewing pages containing text and 

diagrams. 

SuperNova also contains an Auto Freeze Image option that attempts to 

remove "dancing dots" (also known as impulse noise) from the camera's 

video stream (especially noticeable in poorly lit environments). 

Note: Dancing dots, also known as "salt and pepper" (or impulse) 

noise, is more of a problem when light levels in your environment 

are low and your camera tries to boost the exposure of the image in 

order to capture as much light as possible. However, because the 

camera's image sensor has now been made more sensitive to light, 

its also now more sensitive to random interference too, and so this 

gives rise to increased impulse noise (that resemble dancing dots) in 

successive video frames. 

The individual settings for SuperNova's image processing features can be 

accessed from the Camera tab in Connect & View's Settings dialog box 

(accessible by going to Visual ->Connect & View ->Settings... in 

SuperNova's control panel. 
  

Controlling Auto Focus 

A camera's Auto Focus system, if it has one, is designed to automatically 

adjust the camera lens to give you the sharpest possible image of the 

subject. In some cases the camera may be regularly attempting to refocus 

on what it sees as a changing subject, which may be a distraction. If you 

find the Auto Focus regularly refocusing then you may wish to turn this 

feature off. 

Pressing LEFT CONTROL + NUM PAD 3 on your keyboard toggles Auto 

Focus off and on. 

Not all cameras include an Auto Focus feature. 
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Switching between digital and optical zoom 

If your camera is one that supports optical (sometimes also known as 

hardware) zoom your Connect & View viewer window will display an extra 

button that allows you to toggle your camera between digital zoom and 

optical zoom. 

The icon displayed directly below indicates that your camera is currently in 

digital zoom mode. 

Pressing this icon will toggle your camera from digital zoom mode into 

optical zoom mode: 

 

The icon displayed directly below indicates that your camera is currently in 

optical zoom mode. 

Pressing this icon (or LEFT CONTROL + NUMPAD 4) will toggle your 

camera from optical zoom mode into digital zoom mode: 

 
  

Locking the image 
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The Lock Image button lets you freeze the screen on the current image. 

This allows you to explore the image in more detail without the possibility of 

the image changing.  

Although available as a Viewer Toolbar button when using a camera, you 

may find this option more useful when viewing presentations as it will allow 

you to freeze the screen on a particular slide rather than relying on the 

teacher to stop the presentation at that point. When you unlock the image 

the Viewer refreshes the current camera image or shows the current 

presenter's computer screen. 
  

Capture Viewer image 

 

The Capture Image button lets you copy the image in the Viewer to the 

Windows Clipboard. The image SuperNova captures is the full image, 

irrespective of the size of magnification you are using in the Viewer. 

Pressing CAPS LOCK+P also copies the image in the Viewer to the 

Windows Clipboard. 
  

You can then copy the image into a document or you can convert the 

image you have captured to text by using the SuperNova "Scan and Read" 

options, or by pressing LEFT CONTROL+CAPS LOCK+O. 
  

OCR Viewer image 

 

The OCR button lets you OCR the image under the camera. The image 

SuperNova captures is the full image, irrespective of the size of 

magnification you are using in the Viewer. 
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Once the image has been OCR-ed the Viewer toolbar will update to provide 

you with additional buttons to read aloud the OCR-ed text and to change 

the view from recognized text, to original image, to recognized text and 

original image in a split-screen mode. 

Additional buttons 

 

Pressing the above button starts the reading of the OCR-ed image. You 

can also start the reading of the OCR-ed image by pressing SPACEBAR or 

NUM PAD PLUS. When reading, the Viewer window highlights the current 

word and automatically scrolls the document. You can also use your arrow 

keys to move by line and by word. 

 

Pressing the above button stops the reading of the OCR-ed image. You 

can also stop the reading of the OCR-ed image by pressing SPACEBAR or 

ESCAPE. 

The following four buttons cycle between four different viewing modes: 

 

Text-only viewing mode. 
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Text and original image size-by-side horizontally mode. 

 

Text and original image size-by-side vertically mode. 

 

Original image-only mode. 

The original image can be scrolled in both Original image-only mode and in 

side-by-side mode using your finger (on a touch-screen display), or by 

holding down your left mouse button and moving your mouse. 

 

Pressing the above button cycles through a number of different color 

schemes.  

 

Pressing the above button opens a Document Options menu that allows 

you to add more pages to your document, delete the current page (if more 

than one page currently exists), move between pages (if more than one 

page currently exists), and export your OCR-ed pages to Microsoft Word or 

Windows Notepad format. 

 

Pressing the above button in the Document Options menu allows you to 

add another page to your current document. When you press the Add Page 

button you'll be given the option to add another page to your current 
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document using either your camera (whereupon you'll be returned to the 

main Connect and View screen in order to select a new page for OCR-ing), 

or to another page from an image file or PDF document (whereupon a 

file-picker dialog box will appear allowing you to choose the image file or 

PDF document to OCR). 

 

Pressing the above button in the Document Options menu deletes the 

current page.  

 

Pressing the above button in the Document Options menu allows you to 

export your current document to Microsoft Word format (preserving text 

formatting), or Microsoft Word format (preserving document layout as well 

as text formatting), or just plain text formatting. When you press the Export 

Document button you will be presented with the following three buttons 

representing those choices: 

 

 

 

 

 

Your exported document will then be automatically opened in Microsoft 

Word or Windows Notepad (depending on your chosen format) and an 

original copy of your document will also be automatically placed in your 

Windows "My Documents" folder and named snova_clipboardXXX.xml 

(where XXX is a number with the highest number being your most recently 

exported document). 
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If you have more than one page in your current document pressing the 

above button in the Document Options menu will allow you to move to the 

next page in the current document. 

 

If you have more than one page in your current document pressing the 

above button in the Document Options menu will allow you to move to the 

previous page in the current document. 
  

Annotating scanned images 

Adding an annotation 

To add an annotation to your Connect & View scanned image: 

 Scan (or load an existing Connect & View scanned document you 

have previously saved in Dolphin DocReader .xml format). 

 From Connect & View's toolbar press the Document button. 

 

 From the Document drop-down menu that now appears press the Add 

Annotation button. 

 

An annotation will now be placed in the center of your screen. Its border will 

flash. The Connect & View toolbar will now be replaced with an Annotation 

toolbar. 
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Note: You can only add annotations in a viewing mode that supports 

graphics, e.g. in full image, or vertical split, or horizontal split viewing 

mode. You cannot view or add annotations in text-only viewing 

mode. 

The Annotation toolbar has the following buttons: 

 

Pressing the button pictured directly above exits Annotation mode and will 

restore the regular toolbar. 

The button pictured directly below lets you choose the type of annotation 

that you want to add. This defaults to the Sticky Note type of annotation. If 

you press this button a drop-down menu will appear with the following 

annotation types listed: Sticky Note, Highlight, Box, Circle, Line (minus the 

currently active annotation type, by default Sticky Note). 

 

Selecting a different annotation type from the Annotation type drop-down 

menu will change the annotation that you're adding to the document. 
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Note: The document background can be scrolled or panned 

independently of the annotation, thus allowing you to position the 

magnified document at the exact position that you want to add your 

annotation.  

 

The Color Changer button pictured directly above will cycle between the 

available colors for the current annotation. Each annotation has it’s own 

color options. For Sticky Notes: black on white, white on black, black on 

pink, black on light blue and black on yellow. For the Highlighter: yellow, 

green, pink and light blue. For the box, circle and line annotation types: red, 

green, blue and black. 

When you are happy with your annotation, press the Save button (pictured 

directly below) and the annotation will be added to your document. Another 

annotation is then made available for you to position and edit allowing you 

to easily add multiple annotations. When you’ve finished adding 

annotations, just press the Close button or press the ESCAPE key on your 

keyboard. 

 

Repositioning an annotation 

If you press and hold a finger inside the border of an annotation you'll be 

able to reposition the annotation by panning. 

Note: Pinch to zoom is disabled while you're repositioning an 

annotation 
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Resizing an annotation 

To resize an annotation: 

1. Press and hold (with one finger) one of the annotation's borders (left, 

right, top. or bottom). The border will start flashing.  

2. Keeping your finger held down you can now drag that border to the 

where you want it to be.  

3. If you release your finger the border will still flash. You can then use a 

panning gesture to resize the flashing border if you wish. e.g. If the 

bottom border is flashing, you can pan up or down to resize, whereas if 

the left border is flashing you can pan right or left. 

4. If you press and hold another border when you have one selected, this 

then becomes the selected border and will flash. Dragging and panning 

now changes this border. 

5. A single tap outside any of the black borders will exit resizing mode and 

stops the border flashing. 

For mouse users, moving your mouse pointer over an annotation's borders 

will change your mouse pointer to show you how you can resize it. You can 

resize the annotation by dragging its border while holding down the left 

mouse button while your mouse pointer is the left/right arrow pointer or 

up/down arrow pointer. 

For mouse users, you can reposition the annotation by dragging the top 

border when the regular mouse pointer is displayed. 
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Editing an existing annotation 

After you have added an annotation, if you want to reposition it or change 

its color, you can double-tap (or double-left click the annotation with your 

mouse) in order to edit it. The annotation's border will start flashing to 

indicate it's been selected. You can then reposition or resize it as described 

above. The Annotations toolbar will be shown again with an additional 

button, the Delete Annotation button (pictured directly below). 

 

Pressing the Delete Annotation will delete the currently selected annotation 

from the document. This will open a Connect & View dialog box with two 

buttons (pictured directly below). 

 

The Cancel button (the large red cross) cancels the deletion, while the 

other Delete Annotation button confirms the deletion and removes the 

annotation from the document. 

Exporting your annotations 

Your annotations are saved alongside your original document in a separate 

file. When you open your document in SuperNova's Doc Reader, your 

annotations will be automatically loaded as well, leaving you where you left 

off. 
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If you have any annotations in your document, an extra button (pictured 

directly below) is added to the toolbar's Document drop-down menu. 

 

Pressing this button takes a picture of your document with the annotations 

included. You should hear the normal Connect & View camera click noise 

to indicate that this has taken place. This picture is then placed onto the 

Windows clipboard so you can then paste it into Microsoft Word for printing 

out or insert it as a picture into an e-mail. 

You can also export your document with your annotations as a PDF file. To 

do this select the Export button (pictured directly below): 

  

And from the drop-down menu that appears select the PDF button (pictured 

directly below): 

 

A PDF file containing your scanned document complete with annotations 

will then be saved in the same folder as your original document was loaded 

from. 
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18.1.5  Camera settings 

You can find all the SuperNova Camera Connect and View settings in the 

SuperNova Control Panel. You can find these options through the Visual 

button bar or through the Connect and View menu. For further information 

see the Connect and View Settings dialog box. 
  

18.2  Whiteboard Connect and View 

Whiteboard Connect and View uses virtual network computing (VNC) to let 

you connect to another computer and magnify and track what appears on 

their screen on your computer screen. 

VNC is a type of software that makes it possible to view another computer 

over a network connection. There are a number of free and low cost VNC 

software programs available. These include tight VNC, Ultra VNC and Real 

VNC. The VNC software must be installed and running on the presenter's 

computer for SuperNova to make a connection. The VNC software does 

not need to be installed on your computer. 

For more information about VNC programs that have been tested and are 

recommended by Dolphin, please visit the Dolphin web site or contact your 

local Dolphin dealer. 
  

18.2.1  Connecting to the presenter's computer 

You can connect to the presenter's computer that is running VNC software 

by creating a whiteboard profile. A whiteboard profile will require you to 

enter specific information, which may only be available from your Network 

Administrator. This information includes the name of the computer and any 

security password set in the VNC software. 

To create a whiteboard profile, do the following in the SuperNova Control 

Panel:  

1. In the "Visual" option, open the "Connect and View" submenu and 

select "Settings". The "Connect and View Settings" dialog box opens. 



 

Connect and View 145 

 

2. If this is a new profile you want to create, select the "Whiteboard" page 

and choose the "New" button. The "Whiteboard Settings" dialog box 

opens. 

3. If this is a profile you want to edit, open the "Whiteboard" page, select 

the profile from the "Devices" list and choose the "Settings" button. The 

"Whiteboard Settings" dialog box opens. 

4. In the "Profile" box type a name for this profile. Give the profile a 

meaningful name, for example, the name of the classroom, teacher or 

trainer. 

5. Complete the remaining fields as provided to you by your Network 

Administrator. For further information see the Connect and View 

Settings dialog box section. 

6. Select the "OK" button. SuperNova saves the settings and goes back to 

the previous dialog box. 

7. Select the "OK" button. SuperNova saves the profile, adds it to the 

Devices list and closes the dialog box. 
  

18.2.2  Viewing the presenter's computer 

To see the presenter's computer screen requires you to select the profile in 

the "Connect and View Settings" dialog box and then to turn on the 

Connect and View feature. 

When you are connected to the presenter's computer, you can use the 

following options to enable, configure and adjust the Viewer. 
  

Switching on the Viewer 

After selecting the device in the "Connect and View Settings" dialog box, 

you can view its output by turning on "Connect and View". You can switch 

on or off "Connect and View" using the "Visual" options in the SuperNova 

control panel or by using a hot key. 

Magnifier Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Connect and View on off ALT + 

NUMPAD 

ENTER 

LEFT SHIFT + 

CAPS LOCK + 

0 

 

When you turn on "Connect and View" a portion of the screen begins to 

show the image from the camera or whiteboard. This area is called the 

Viewer. You can change the position of the Viewer on the screen and you 

can use the Viewer Toolbar to adjust the size, color and contrast of the 

image to make it easier to see. 

 
  

Switching between the Viewer and the desktop 

To access the Viewer toolbar and to make adjustments to the image 

requires you to place the focus in the Viewer area. 

You can switch between the Viewer and the desktop by pressing CAPS 

LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera 

and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE 

BUTTON cycles you between camera, whiteboard and desktop. 
  

Showing and hiding the Viewer toolbar 

The Viewer Toolbar provides you with controls to modify the image you are 

viewing. The options available on the toolbar differ depending on whether 

you are connecting to a camera or connecting to a whiteboard. 

You can use the Show and Hide buttons to control the appearance of the 

Viewer Toolbar. If you hide the toolbar then you will be increasing the 

amount of information that appears in the Viewer. 
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The style of the Show and Hide buttons differs depending on where the 

Viewer is docked. For example, if the Viewer is docked to the top then the 

Show and Hide buttons appear as Arrows pointing to the left and right.  

    

 

If the Viewer window is docked to the left then the Show and Hide buttons 

appear as Arrows pointing up and down. 

    

In all cases, the position of the Hide button is always the last button on the 

Viewer Toolbar. 

Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and 

shows the Viewer Toolbar. 
  

Magnifying the image in the Viewer 

    

You can change the size of the image in the Viewer by using the 

magnification buttons in the Viewer Toolbar. If you are using a touchscreen 

device, you can also change magnification by doing a 2 finger pinch or 2 

finger stretch. 

You can also use the following hot keys: 
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Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 

Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL DOWN 

 
  

Viewing other parts of the image 

If you find the image you are looking at is larger than what is appearing in 

the Viewer then you can move the mouse pointer or use SuperNova's Pan 

feature to scroll the image with the keyboard. 

To pan across the screen press RIGHT CONTROL plus an Arrow Key. 

Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key 

repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. 

Press the opposite Arrow Key to slow down.  

To learn more about panning see "View other parts of the screen". 
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Changing the colors of the image 

 

If you are finding viewing the image difficult because of the colors and 

contrast, then you can use the Color Changer button to cycle through a 

number of different color schemes.  

Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles 

you through the available color schemes. 

SuperNova saves the Color Scheme you choose in the "Connect and View 

Settings" dialog box. 
  

Tracking the presenter's movement 

 

You can control the tracking of the presenter's movement by using the 

Track Presenter button. When you turn on this feature, the image in the 

Viewer will automatically scroll to follow the movement of the presenter's 

mouse pointer around the screen. The tracking of the presenter's mouse 

pointer will temporarily stop if you begin to move your mouse pointer and 

tracking resumes again when you stop moving your mouse pointer. 

You can prevent the Viewer following the presenter's mouse pointer by 

turning this feature off. 
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Locking the image 

    

The Lock Image button lets you freeze the screen on the current image. 

This allows you to explore the image in more detail without the possibility of 

the image changing.  

Although available as a Viewer Toolbar button when using a camera, you 

may find this option more useful when viewing presentations as it will allow 

you to freeze the screen on a particular slide rather than relying on the 

teacher to stop the presentation at that point. When you unlock the image 

the Viewer refreshes the current camera image or shows the current 

presenter's computer screen. 
  

Capture Viewer image 

 

The Capture Image button lets you copy the image in the Viewer to the 

Windows Clipboard. The image SuperNova captures is the full image, 

irrespective of the size of magnification you are using in the Viewer. 

Pressing CAPS LOCK+P also copies the image in the Viewer to the 

Windows Clipboard. 
  

You can then copy the image into a document or you can convert the 

image you have captured to text by using the SuperNova "Scan and Read" 

options, or by pressing LEFT CONTROL+CAPS LOCK+O. 
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18.2.3  Whiteboard settings 

You can find all the SuperNova Whiteboard Connect & View settings in the 

SuperNova Control Panel. You can find these options through the Visual 

button bar or through the Connect & view menu. For further information see 

the Connect & View Settings dialog box. 
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Touchscreen 

19.1  Touchscreen terminology 

The following table provides a description of touchscreen gestures and 

what the gesture means. 

 

Gesture How to do it 

Tap Tap the screen to 

perform an action, for 

example, tap a button 

to activate the button. 

Some gestures may 

require you to tap the 

screen with 1, 2, 3 or 

more fingers multiple 

times. 

Press and hold Press a finger on the 

screen and continue to 

hold the finger against 

the screen. 

Swipe A flick of a finger 

across the screen. 

Slide A longer slower 

movement of a finger 

across the screen 

usually in a vertical or 

horizontal direction 

from the screen edge. 
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Pinch Press two fingers on 

the screen and move 

them together, as if 

you are pinching them 

together. 

Stretch Press two fingers on 

the screen and move 

them away from each 

other, as if you are 

stretching them apart. 

 
  

19.2  Touchscreen gestures 

The following table provides a list of the touchscreen gestures you can use 

to control SuperNova. 

 

Function Gesture 

Toggle magnification 3 finger double tap 

Increase magnification 2 finger stretch 

Reduce magnification 2 finger pinch 

Pan 1 finger swipe 

Show / hide the SuperNova 

Touch Bar 

3 finger single tap 

Announce text under the finger 

position 

1 finger press and hold 

 
  

More gestures. 

In addition to the SuperNova touchscreen gestures, here are some more 

touchscreen gestures to help you get around Windows. 
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Function Gesture 

Open the Charms (Search, 

Share, Start, Devices, Settings). 

Slide in from over the 

right edge with 1 finger 

Switch apps Swipe in from over the 

left edge with 1 finger. 

Open the App Menu. The App 

Menu shows commands like 

Save, Edit and Delete. 

Slide in from over the 

bottom edge with 1 

finger. 

Close the open app Slide in from over the 

top edge with 1 finger 

and continue the 

motion, dragging the 

app down to the 

bottom of the screen. 

Open the context menu (this is 

the same as performing a right 

click on a selected item) 

1 finger double tap, 

hold and release. 

Drag and drop objects around 

the screen, for example, when 

re-arranging the Start Screen or 

desktop. 

1 finger double tap and 

hold, then slide to 

move the object. Lift 

finger to release. 

 
  

19.3  SuperNova Touch Bar 

The SuperNova Touch Bar is a touchscreen toolbar that appears at the 

bottom of the screen when you do a 3 finger  single tap. The Touch Bar 

gives you access to the most common SuperNova actions including turning 

magnification on and off, changing magnification size and turning the 

SuperNova Color Scheme on and off. 
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19.4  Typing on a touchscreen 

SuperNova automatically shows an onscreen keyboard when you need to 

type and you do not have a keyboard connected to the device. The 

onscreen keyboard appears at the bottom of the screen and uses large 

print high contrast keys. 

You can also make the keyboard appear at any time by tapping the 

Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard 

button in the Windows Notification area. To hide the keyboard, tap the large 

"X" button in the bottom right corner of the onscreen keyboard. 

You can adjust the appearance of the onscreen keyboard in the 

Touchscreen Settings dialog box. 
  

19.5  Adjust touch sensitivity 

You can adjust how sensitive SuperNova is to your taps and swipes on the 

touchscreen.  

For example, If you find that SuperNova is interpreting a double tap gesture 

as two single tap gestures then you may need to increase the double-tap 

timeout”. In the same way, if you find that when attempting to drag and 

drop a desktop icon the icon is not being picked up, then you may need to 

increase the double-tap timeout or the pass-through timeout”. 

You make the changes to SuperNova's touchscreen settings in the 

Touchscreen dialog box. 
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Hot key conflicts 

Sometimes you can find SuperNova hot keys conflict with an application's 

hot keys. You can resolve this issue in a number of different ways. 
  

20.1  Tell SuperNova to ignore the next key press 

You can resolve a hot key conflict between SuperNova and your 

application by telling SuperNova to ignore the next key press. Once you 

have released the keys, SuperNova automatically turns on its hot keys 

again. 

Action Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Pass the next key press 

through to your application 

LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

 
  

20.2  Turn off SuperNova hot keys 

You can resolve a hot key conflict between SuperNova and your 

application by turning off SuperNova's hot keys. This disables all hot keys 

except for the hot key to turn on SuperNova's hot keys again. 

Action Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on hot keys LEFT 

CONTROL + 8 

SHIFT + CAPS 

LOCK + 3 
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20.3  Reassign a SuperNova hot key 

You can add, delete or reassign any SuperNova hot key. You can do this to 

resolve hot key conflicts between SuperNova and your application or to 

change a hot key command to a key combination you find easier to use. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + G. 

The "General" menu opens. 

3. DOWN ARROW to "Keyboard and Hot Keys" and press ENTER. 

A submenu opens. 

4. DOWN ARROW to "Hot Keys" and press ENTER. 

The "Hot Keys" dialog box opens. 

5. TAB through, using the "Hot Key Command Set" list and "Command" 

list to select the assigned hot key you want to change. 

6. Use the "Add key" button, "Replace key" button or "Remove key" button 

to change the hot key. 

7. TAB to the "OK" button and press SPACEBAR. 

SuperNova confirms the changes and closes the dialog box. 

Tip: If you find it difficult to locate your hot key from the categories 

and commands available then use the SuperNova Key Describer to 

help. 
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Hot Keys 

21.1  Actions 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Auto Train Graphic Objects LEFT 

CONTROL + 

RIGHT 

BRACKET 

CONTROL + 

CAPS LOCK + 

G 

Control Panel Pop Up Menu CAPS LOCK + 

SPACEBAR 

CAPS LOCK + 

SPACEBAR 

Doc Reader CAPS LOCK + 

NUMPAD 

PLUS 

SHIFT + ALT + 

D 

Exit Auto Train Graphic 

Objects 

ESCAPE ESCAPE 

Freeze The Screen PAUSE No Assignment 

SuperNova Help CAPS LOCK + 

F1 

or RIGHT 

CONTROL + 

RIGHT SHIFT 

+ FORWARD 

SLASH 

CAPS LOCK + 

F1 

SuperNova Hotkey Helper LEFT SHIFT + 

CAPS LOCK + 

F2 

SHIFT + CAPS 

LOCK + F2 

Hot Keys on / off LEFT 

CONTROL + 8 

SHIFT + CAPS 

LOCK + 3 

Open Control Panel LEFT 

CONTROL + 

SPACEBAR 

LEFT 

CONTROL + 

SPACEBAR 
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Pass next key to application LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

Quit CAPS LOCK + 

F4 

CAPS LOCK + 

F4 

Row / Column Mode Toggle LEFT 

CONTROL + 9 

No Assignment 

Screen Refresh LEFT 

CONTROL + 

SEMI COLON 

CAPS LOCK + 

ESCAPE 

Show TTS Language 

selection dialog 

No Assignment CONTROL + 

CAPS LOCK + 

L 

Show TTS selection dialog No Assignment CONTROL + 

CAPS LOCK + 

S 

OCR from your scanner, 

camera, or open PDF file 

CAPS LOCK + 

O 

CAPS LOCK + 

O 

OCR from the Windows 

clipboard 

LEFT 

CONTROL + 

CAPS LOCK + 

O 

LEFT 

CONTROL + 

CAPS LOCK + 

O 

Copy the image currently in 

the Connect and View Viewer 

window to the Windows 

clipboard 

CAPS LOCK + 

P 

CAPS LOCK + 

P 

Restore default user profile LEFT 

CONTROL + 

CAPS LOCK + 

P 

LEFT 

CONTROL + 

CAPS LOCK + 

P 

Unassigned Commands 

The following is a list of unassigned commands within this category. These 

commands can be manually assigned a key combination. 

 Application Help 

 Screen capture 
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 Show Speech Verbosity dialog 

 Start Script Editor 

 Train windows 

 Train windows with a delay 

 Windows Basics Help 
  

21.2  Speech 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Anti-stutter system on / off LEFT 

CONTROL + 6 

No Assignment 

Announce text under mouse 

pointer on / off 

CAPS LOCK + 

M 

CAPS LOCK + 

M 

Capitals on / off CAPS LOCK + 

QUOTE 

No Assignment 

Character Echo Cycle CAPS LOCK + 

SEMI COLON 

CAPS LOCK + 

2 

Key Describe Mode CAPS LOCK + 

FORWARD 

SLASH 

CAPS LOCK + 

1 

Language Down LEFT 

CONTROL + 

PERIoD 

No Assignment 

Language Up LEFT 

CONTROL + 

COMMA 

No Assignment 

Monitor Markers LEFT 

CONTROL + 5 

No Assignment 

Mute LEFT 

CONTROL 

LEFT 

CONTROL 
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Next Synthesizer LEFT 

CONTROL + 

LEFT SHIFT + 

RIGHT 

BRACKET 

No Assignment 

Previous Synthesizer LEFT 

CONTROL + 

LEFT SHIFT + 

LEFT 

BRACKET 

No Assignment 

Speed decrease LEFT 

CONTROL + 

LEFT SHIFT + 

MINUS 

LEFT 

CONTROL + 

ALT + PAGE 

DOWN 

Speed Increase LEFT 

CONTROL + 

LEFT SHIFT + 

EQUALS 

LEFT 

CONTROL + 

ALT + PAGE 

UP 

Verbosity Scheme Cycle CAPS LOCK + 

EQUALS 

CAPS LOCK + 

V 

Voice on / off LEFT 

CONTROL + 0 

LEFT 

CONTROL + 

ALT + 0 

Volume decrease LEFT 

CONTROL + 

MINUS 

LEFT 

CONTROL + 

ALT + MINUS 

Volume increase LEFT 

CONTROL + 

EQUALS 

LEFT 

CONTROL + 

ALT + EQUALS 

 

21.3  Speak Keys 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Additional Focus Information LEFT SHIFT + 

NUMPAD 0 

CONTROL + 

CAPS LOCK + 

UP ARROW 
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Character NUMPAD 4 CAPS LOCK + 

LEFT ARROW 

Control NUMPAD 

PERIOD 

No Assignment 

Describe Focus Position NUMPAD 8 No Assignment 

Describe Shortcut Key LEFT SHIFT + 

NUMPAD 

PERIOD 

CONTROL + 

CAPS LOCK + 

LEFT ARROW 

Focus NUMPAD 0 CAPS LOCK + 

UP ARROW 

From Cursor LEFT SHIFT + 

NUMPAD 2 

CAPS LOCK + 

END 

Headings NUMPAD 3 SHIFT + CAPS 

LOCK + LEFT 

ARROW 

Label Above CAPS LOCK + 

NUMPAD 8 

No Assignment 

Label To Left CAPS LOCK + 

NUMPAD 7 

No Assignment 

Line NUMPAD 6 No Assignment 

Paragraph NUMPAD 5 LEFT 

CONTROL + 

LEFT SHIFT + 

CAPS LOCK + 

P 

Paragraph Move To Next CAPS LOCK + 

RIGHT 

BRACKET 

No Assignment 

Paragraph Move To Previous CAPS LOCK + 

LEFT 

BRACKET 

No Assignment 

Repeat Last Speech CAPS LOCK + 

NUMPAD 9 

CAPS LOCK + 

BACK SLASH 

Selection NUMPAD 1 SHIFT + CAPS 

LOCK + DOWN 

ARROW 
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Sentence CAPS LOCK + 

NUMPAD 4 

LEFT 

CONTROL + 

LEFT SHIFT + 

CAPS LOCK + 

S 

Sentence Move To Next CAPS LOCK + 

PERIoD 

No Assignment 

Sentence Move to Previous CAPS LOCK + 

COMMA 

No Assignment 

Status NUMPAD 2 CAPS LOCK + 

PAGE DOWN 

Table Column CAPS LOCK + 

NUMPAD 6 

SHIFT + CAPS 

LOCK + RIGHT 

ARROW 

Table Column From Cell CAPS LOCK + 

NUMPAD 

PERIOD 

SHIFT + CAPS 

LOCK + PAGE 

DOWN 

Table Column To Cell CAPS LOCK + 

NUMPAD 3 

SHIFT + CAPS 

LOCK + PAGE 

UP 

Table Row CAPS LOCK + 

NUMPAD 0 

SHIFT + CAPS 

LOCK + UP 

ARROW 

Table Row From Cell CAPS LOCK + 

NUMPAD 2 

SHIFT + CAPS 

LOCK + END 

Table Row To Cell CAPS LOCK + 

NUMPAD 1 

SHIFT + CAPS 

LOCK + HOME 

To Cursor LEFT SHIFT + 

NUMPAD 1 

CAPS LOCK + 

HOME 

Where Am I? NUMPAD 7 CAPS LOCK + 

PAGE UP 

Window NUMPAD 9 CAPS LOCK + 

B 

Word NUMPAD 5 CAPS LOCK + 

RIGHT 

ARROW 

Unassigned Commands 
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The following is a list of unassigned commands within this keyboard hot 

key set category. These commands can be manually assigned a key 

combination. 

 Label Below 

 Label To Right 

 Word Move To Next 

 Word Move To Previous 
  

21.4  Read From Here 

Function 
Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Click and Read From Here MIDDLE 

MOUSE 

BUTTON 

MIDDLE 

MOUSE 

BUTTON 

Enhance Read From Here LEFT 

CONTROL + 

CAPS LOCK + 

1 

No Assignment 

Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Pause/Unpause Reading SPACEBAR SPACEBAR 

Stop Reading NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

Stop Reading and switch 

focus 

LEFT SHIFT + 

SPACEBAR 

LEFT SHIFT + 

SPACEBAR 

Read From Here next line DOWN 

ARROW 

DOWN 

ARROW 
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Read From Here previous 

line 

UP ARROW UP ARROW 

Read From Here next 

paragraph 

P P 

Read From Here previous 

paragraph 

LEFT SHIFT + 

P 

LEFT SHIFT + 

P 

Read From Here next 

sentence 

S S 

Read From Here previous 

sentence 

LEFT SHIFT + 

S 

LEFT SHIFT + 

S 

 
  

21.5  Dolphin Cursor (General) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Activate Down COMMA No Assignment 

Activate Press SPACEBAR SPACEBAR 

Activate Up PERIOD No Assignment 

Add Permanent PlaceMarker 

at Dolphin Cursor 

LEFT 

CONTROL + 

CAPS LOCK + 

A 

LEFT 

CONTROL + 

CAPS LOCK + 

A 

Add Temporary PlaceMarker 

at Dolphin Cursor 

LEFT 

CONTROL + 

SHIFT + A 

LEFT 

CONTROL + 

SHIFT + A 

Automatic Dolphin Cursor on 

/ off 

LEFT 

CONTROL + 4 

No Assignment 

Automatic Dolphin Cursor 

Restricted To Area on / off 

LEFT 

CONTROL + 2 

No Assignment 

Find with Dolphin Cursor F3 SHIFT + CAPS 

LOCK + F 

Find Next with Dolphin 

Cursor 

F4 CAPS LOCK + 

F3 

Find Previous with Dolphin 

Cursor 

F2 SHIFT + CAPS 

LOCK + F3 
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Forms Mode Toggle CAPS LOCK + 

ENTER 

CAPS LOCK + 

ENTER 

Interact with Control ENTER ENTER 

Mode Lock LEFT 

CONTROL + 1 

No Assignment 

Teach Graphic Object LEFT 

CONTROL + 

LEFT 

BRACKET 

CAPS LOCK + 

G 

Turn dolphin Cursor Off NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn dolphin Cursor On NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Window Lock LEFT 

CONTROL + 3 

No Assignment 

 
  

21.6  Dolphin Cursor (Movement) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Bottom of window / area LEFT 

CONTROL + 

END 

CONTROL + 

END 

Choose Dolphin Cursor 

restricted to area 

NUMPAD 

SLASH 

LEFT 

CONTROL + 

CAPS LOCK + 

Z 

Dolphin Cursor Page Down CAPS LOCK + 

PAGE DOWN 

LEFT 

CONTROL + 

PAGE DOWN 

Dolphin Cursor Page Up CAPS LOCK + 

PAGE UP 

LEFT 

CONTROL + 

PAGE UP 

End of line END END 
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Heading Next CAPS LOCK + 

DELETE 

H 

Heading Prev CAPS LOCK + 

INSERT 

SHIFT + H 

Left LEFT 

ARROWT 

LEFT ARROW 

Left Edge LEFT SHIFT + 

CAPS LOCK + 

HOME 

No Assignment 

Left Word LEFT 

CONTROL + 

LEFT ARROW 

LEFT 

CONTROL + 

LEFT ARROW 

Move Dolphin Cursor to first 

toolbar 

LEFT SHIFT + 

NUMPAD 

MINUS 

CAPS LOCK + 

F8 

Move Dolphin Cursor to next 

application 

LEFT 

CONTROL + 

SINGLE OPEN 

QUOTE 

No Assignment 

Move Dolphin Cursor to next 

window 

LEFT 

CONTROL + 

TAB 

No Assignment 

Move Dolphin Cursor to 

previous application 

LEFT 

CONTROL + 

LEFT SHIFT + 

SINGLE OPEN 

QUOTE 

No Assignment 

Move Dolphin Cursor to 

previous window 

LEFT 

CONTROL + 

LEFT SHIFT + 

TAB 

No Assignment 

Move Dolphin Cursor to 

Quick Launch bar 

LEFT SHIFT + 

NUMPAD 

STAR 

No Assignment 

Move Dolphin Cursor to 

System Tray 

LEFT SHIFT + 

NUMPAD 

SLASH 

No Assignment 
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Move Physical Down LEFT SHIFT + 

CAPS LOCK + 

DOWN 

ARROW 

SHIFT + ALT + 

DOWN 

ARROW 

Move Physical Left LEFT SHIFT + 

CAPS LOCK + 

LEFT ARROW 

SIFT + ALT + 

LEFT ARROW 

Move Physical Right LEFT SHIFT + 

CAPS LOCK + 

RIGHT 

ARROW 

SHIFT + ALT + 

RIGHT 

ARROW 

Move Physical Up LEFT SHIFT + 

CAPS LOCK + 

UP ARROW 

SHIFT + ALT + 

UP ARROW 

Move To Application Cursor NUMPAD 

STAR 

CAPS LOCK + 

MINUS 

Next Dialog F7 CONTROL + 

TAB 

Next Large Object PAGE DOWN PAGE DOWN 

Next Line DOWN 

ARROW 

DOWN 

ARROW 

Next Main Window F8 CONTROL + 

F6 

Next Object TAB TAB 

Physical Bottom LEFT SHIFT + 

CAPS LOCK + 

PAGE DOWN 

No Assignment 

Physical on off LEFT 

CONTROL + 

LEFT SHIFT + 

9 

No Assignment 

Physical Top LEFT SHIFT + 

CAPS LOCK + 

PAGE UP 

No Assignment 

Previous Dialog LEFT SHIFT + 

F7 

CONTROL + 

SHIFT + TAB 

Previous Large Object PAGE UP PAGE UP 

Previous Line UP ARROW UP ARROW 
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Previous Main Window LEFT SHIFT + 

F8 

No Assignment 

Previous Object LEFT SHIFT + 

TAB 

SHIFT + TAB 

Restrict Dolphin Cursor to 

selection 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 

MINUS 

No Assignment 

Right RIGHT 

ARROW 

RIGHT 

ARROW 

Right Edge LEFT SHIFT + 

CAPS LOCK + 

END 

No Assignment 

Right Word LEFT 

CONTROL + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

RIGHT 

ARROW 

Route Dolphin Cursor to 

Mouse 

MIDDLE 

MOUSE 

BUTTON 

MIDDLE 

MOUSE 

BUTTON 

Skip Ahead LEFT 

CONTROL + 

DOWN 

ARROW 

LEFT 

CONTROL + 

DOWN 

ARROW 

Skip Back LEFT 

CONTROL + 

UP ARROW 

LEFT 

CONTROL + 

UP ARROW 

Start of line HOME HOME 

Table Down CAPS LOCK + 

DOWN 

ARROW 

LEFT 

CONTROL + 

ALT + DOWN 

ARROW 

Table Left CAPS LOCK + 

LEFT ARROW 

LEFT 

CONTROL + 

ALT + LEFT 

ARROW 
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Table Next CAPS LOCK + 

END 

T 

Table Prev CAPS LOCK + 

HOME 

SHIFT + T 

Table Right CAPS LOCK + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

ALT + RIGHT 

ARROW 

Table Up CAPS LOCK + 

UP ARROW 

LEFT 

CONTROL + 

ALT + UP 

ARROW 

Top of Window / Area LEFT 

CONTROL + 

HOME 

CONTROL + 

HOME 

 
  

21.7  Dolphin Cursor (Mouse Control) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Drag with Left Mouse Button RIGHT 

CONTROL + 

HOME 

CONTROL + 

CAPS LOCK + 

8 

Drag with Right Mouse 

Button 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

HOME 

CONTROL + 

CAPS LOCK + 

9 

Drop RIGHT 

CONTROL + 

END 

LEFT 

CONTROL + 

CAPS LOCK + 

7 

Left Click at Dolphin Cursor INSERT CAPS LOCK + 

8 

Left Click at Dolphin Cursor 

and switch Dolphin Cursor off 

A No Assignment 
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Left Double Click at Dolphin 

Cursor 

Q No Assignment 

Middle Click at Dolphin 

Cursor 

S No Assignment 

Mouse Wheel Down at 

Dolphin Cursor 

X No Assignment 

Mouse Wheel Up at Dolphin 

Cursor 

W No Assignment 

Move Mouse to Focus RIGHT 

CONTROL + 

DELETE 

CAPS LOCK + 

EQUALS 

Right Click at Dolphin Cursor DELETE CAPS LOCK + 

9 

Right Click at Dolphin Cursor 

and switch Dolphin Cursor off 

D No Assignment 

Right Double Click at Dolphin 

Cursor 

E No Assignment 

 

 

Note: In some applications, for example, Internet Explorer and 

Adobe Reader, the above stated hot keys may conflict with a 

SuperNova Quick Navigation Key. Where a conflict exists the Quick 

Navigation key has priority. To use the above stated commands in 

an application with a conflicting Quick Navigation Key requires you 

to re-assign the associated Dolphin Cursor (Mouse Control) hot key. 

  

21.8  Dolphin Cursor Selection 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Bottom of window / area LEFT 

CONTROL + 

LEFT SHIFT + 

END 

LEFT 

CONTROL + 

LEFT SHIFT + 

END 
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Copy CONTROL + C CONTROL + C 

End of line SHIFT + END SHIFT + END 

Left SHIFT + LEFT 

ARROW 

SHIFT + LEFT 

ARROW 

Left word CONTROL + 

SHIFT + LEFT 

ARROW 

CONTROL + 

SHIFT + LEFT 

ARROW 

Next large object SHIFT + PAGE 

DOWN 

SHIFT + PAGE 

DOWN 

Next line SHIFT + 

DOWN 

ARROW 

SHIFT + 

DOWN 

ARROW 

Previous large object SHIFT + PAGE 

UP 

SHIFT + PAGE 

UP 

Previous line SHIFT + UP 

ARROW 

SHIFT + UP 

ARROW 

Right SHIFT + RIGHT 

ARROW 

SHIFT + RIGHT 

ARROW 

Right word CONTROL + 

SHIFT + RIGHT 

ARROW 

CONTROL + 

SHIFT + RIGHT 

ARROW 

Select all CONTROL + A CONTROL + A 

Skip ahead LEFT 

CONTROL + 

LEFT SHIFT + 

DOWN 

ARROW 

LEFT 

CONTROL + 

LEFT SHIFT + 

DOWN 

ARROW 

Skip back LEFT 

CONTROL + 

LEFT SHIFT + 

UP ARROW 

LEFT 

CONTROL + 

LEFT SHIFT + 

UP ARROW 

Start of line SHIFT + HOME SHIFT + HOME 

Top of window / area LEFT 

CONTROL + 

LEFT SHIFT + 

HOME 

LEFT 

CONTROL + 

LEFT SHIFT + 

HOME 
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21.9  Magnifier 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal 

Color Scheme on off LEFT 

CONTROL + 

NUMPAD 0 

SHIFT + ALT + 

C 

Create Hooked Area LEFT 

CONTROL + 

NUMPAD 5 

LEFT SHIFT + 

LEFT 

CONTROL + 

ALT + H 

Foci Highlights on off LEFT 

CONTROL + 

LEFT SHIFT + 

BACK SLASH 

LEFT SHIFT + 

LEFT ALT + O 

Hooked areas on off LEFT 

CONTROL + 

NUMPAD 3 

No Assignment 

Jump Down LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 2 

LEFT ALT + 

PAGE DOWN 

Jump Left LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 4 

LEFT ALT + 

HOME 

Jump Right LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 6 

LEFT ALT + 

END 

Jump Up LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 8 

LEFT ALT + 

PAGE UP 
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Magnification Decrease LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

LEFT ALT + 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Magnification Increase LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

LEFT ALT + 

EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

Magnification X Decrease RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Magnification X Increase LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Magnification Y Decrease RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Magnification Y Increase LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Magnifier on off LEFT 

CONTROL + 

NUMPAD 

ENTER 

ALT + 0 

Modify Hooked Areas LEFT 

CONTROL + 

NUMPAD 6 

LEFT SHIFT + 

ALT + H 
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Modify Primary Area LEFT 

CONTROL + 

NUMPAD 4 

LEFT SHIFT + 

ALT + A 

Move Down RIGHT 

CONTROL + 

RIGHT SHIFT + 

DOWN 

ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

DOWN 

ARROW 

Move Left RIGHT 

CONTROL + 

RIGHT SHIFT + 

LEFT ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

LEFT ARROW 

Move Right RIGHT 

CONTROL + 

RIGHT SHIFT + 

RIGHT 

ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

RIGHT 

ARROW 

Move to bottom left of screen RIGHT 

CONTROL + 

NUMPAD 1 

No Assignment 

Move to bottom of screen RIGHT 

CONTROL + 

NUMPAD 2 

No Assignment 

Move to bottom right of 

screen 

RIGHT 

CONTROL + 

NUMPAD 3 

No Assignment 

Move to left edge of screen RIGHT 

CONTROL + 

NUMPAD 4 

No Assignment 

Move to middle of screen RIGHT 

CONTROL + 

NUMPAD 5 

No Assignment 

Move to right edge of screen RIGHT 

CONTROL + 

NUMPAD 6 

No Assignment 

Move to top left of screen RIGHT 

CONTROL + 

NUMPAD 7 

No Assignment 
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Move to top of screen RIGHT 

CONTROL + 

NUMPAD 8 

No Assignment 

Move to top right of screen RIGHT 

CONTROL + 

NUMPAD 9 

No Assignment 

Move Up RIGHT 

CONTROL + 

RIGHT SHIFT +  

UP ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

UP ARROW 

Orientation Cycle LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Overview mode on off LEFT 

CONTROL + 

BACK SLASH 

No Assignment 

Pan Down RIGHT 

CONTROL + 

DOWN 

ARROW 

RIGHT 

CONTROL + 

DOWN 

ARROW 

Pan Left RIGHT 

CONTROL + 

LEFT ARROW 

RIGHT 

CONTROL + 

LEFT ARROW 

Pan Right RIGHT 

CONTROL + 

RIGHT 

ARROW 

RIGHT 

CONTROL + 

RIGHT 

ARROW 

Pan Up RIGHT 

CONTROL + 

UP ARROW 

RIGHT 

CONTROL + 

UP ARROW 

Primary Magnifier Type Cycle LEFT 

CONTROL + 

NUMPAD 7 

LEFT SHIFT + 

ALT + M 

Restore Position RIGHT 

CONTROL + 

NUMPAD 

PERIOD 

No Assignment 
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Save Position RIGHT 

CONTROL + 

NUMPAD 0 

No Assignment 

Switch monitors CAPS LOCK + 

MIDDLE 

MOUSE 

BUTTON 

CAPS LOCK + 

MIDDLE 

MOUSE 

BUTTON 

Cycle text smoothing (True 

Font/Standard/Off) 

LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 

Bold Fonts on off RIGHT 

CONTROL + 

NUMPAD 8 

No Assignment 

Sharpening on off RIGHT 

CONTROL + 

RIGHT SHIFT + 

NUMPAD 8 

No Assignment 

 
  

21.10  Magnifier Window Adjustment 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Alter hook with mouse LEFT MOUSE 

BUTTON 

LEFT MOUSE 

BUTTON 

Area Down DOWN 

ARROW 

DOWN 

ARROW 

Area Left LEFT ARROW LEFT ARROW 

Area Right RIGHT 

ARROW 

RIGHT 

ARROW 

Area Up UP ARROW UP ARROW 

Cancel Get Hook Area ESCAPE ESCAPE 

Contents Down LEFT SHIFT + 

DOWN 

ARROW 

LEFT SHIFT + 

DOWN 

ARROW 
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Contents Left LEFT SHIFT + 

LEFT ARROW 

LEFT SHIFT + 

LEFT ARROW 

Contents Right LEFT SHIFT + 

RIGHT 

ARROW 

LEFT SHIFT + 

RIGHT 

ARROW 

Contents Up LEFT SHIFT + 

UP ARROW 

LEFT SHIFT + 

UP ARROW 

Cycle Orientation LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Decrease Magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Decrement X Magnification RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Decrement Y Magnification RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Delete Hooked Area DELETE DELETE 

Exit Modification Mode ESCAPE ESCAPE 

Increase Magnification LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

Increment X Magnification LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 
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Increment Y Magnification LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Make narrower LEFT 

CONTROL + 

LEFT ARROW 

LEFT 

CONTROL + 

CLEFT 

ARROW 

Make shorter LEFT 

CONTROL + 

UP ARROW 

LEFT 

CONTROL + 

UP ARROW 

Make taller LEFT 

CONTROL + 

DOWN 

ARROW 

LEFT 

CONTROL + 

DOWN 

ARROW 

Make wider LEFT 

CONTROL + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

RIGHT 

ARROW 

Move area with mouse Z Z 

Move contents of area with 

mouse 

C C 

OK Get Hook Area ENTER 

or RIGHT 

MOUSE 

BUTTON 

ENTER 

or RIGHT 

MOUSE 

BUTTON 

Resize area with mouse X X 

Text Smoothing LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 

Tracking on off LEFT SHIFT + 

NUMPAD 8 

No Assignment 
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21.11  Line View 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Decrease magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Decrement X magnification RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Decrement Y magnification RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Exit Line View ESCAPE ESCAPE 

Exit Line View and click at 

character or route Dolphin 

Cursor to character 

NUMPAD 

ENTER 

ENTER 

or LEFT 

MOUSE 

BUTTON 

Flip forward ENTER ENTER 

Go to the first line HOME HOME 

Go to the focus NUMPAD 0 F5 

Go to the last line END END 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

ALT + EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 
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Increment X magnification LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Increment Y magnification LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Line View document LEFT 

CONTROL + 

NUMPAD 

PERIOD 

No Assignment 

Line View document area and 

go to focus 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 2 

No Assignment 

Line View document from 

cursor 

LEFT 

CONTROL + 

NUMPAD 2 

LEFT SHIFT + 

ALT + L 

Line View whole window LEFT 

CONTROL + 

NUMPAD 9 

LEFT SHIFT + 

ALT + V 

Move backwards LEFT ARROW LEFT ARROW 

Move forward RIGHT 

ARROW 

RIGHT 

ARROW 

Next line PAGE DOWN PAGE DOWN 

Previous line PAGE UP PAGE UP 

Scroll faster UP ARROW UP ARROW 

Scroll slower DOWN 

ARROW 

DOWN 

ARROW 

Start or stop SPACEBAR SPACEBAR 

Text smoothing LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 
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21.12  Item Finder 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Item Finder (multi tab dialog 

box) 

CAPS LOCK + 

TAB 

CAPS LOCK + 

TAB 

Links CAPS LOCK + 

1 

CAPS LOCK + 

F7 

Headings CAPS LOCK + 

2 

CAPS LOCK + 

F6 

Frames or Objects CAPS LOCK + 

3 

CAPS LOCK + 

F9 

Tables CAPS LOCK + 

5 

No Assignment 

Controls CAPS LOCK + 

6 

CAPS LOCK + 

F5 

Revisions or Comments CAPS LOCK + 

7 

LEFT SHIFT + 

CAPS LOCK + 

R 

Errors CAPS LOCK + 

8 

No Assignment 

 

 

Global Item Finder 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

System Tray items CAPS LOCK + 

0 

CAPS LOCK + 

F11 

For information on Custom Lists please refer to the SuperNova Help for the 

target application. Help information can be obtained from SuperNova by 

pressING CAPS LOCK + F1. 
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21.13  Text Input 

This category lists keys that become available in Forms Mode that are 

otherwise assigned when using the Dolphin Cursor. 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Cancel ESCAPE ESCAPE 

Delete previous character BACKSPACE BACKSPACE 

Delete this character DELETE DELETE 

Enter ENTER ENTER 

Left one character LEFT ARROW LEFT ARROW 

Move to end of line END END 

Move to start of line HOME HOME 

Phonetic character LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 4 

No Assignment 

Phonetic line LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 6 

No Assignment 

Read character NUMPAD 4 CAPS LOCK + 

LEFT ARROW 

Read character attributes (set 

1) 

LEFT SHIFT + 

NUMPAD 4 

No Assignment 

Read character attributes 

(Set 2) 

LEFT 

CONTROL + 

NUMPAD 4 

No Assignment 

Read line NUMPAD 6 CAPS LOCK + 

UP ARROW 

Right one character RIGHT 

ARROW 

RIGHT 

ARROW 

Spell line LEFT SHIFT + 

NUMPAD 6 

No Assignment 
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Verbose line LEFT 

CONTROL + 

NUMPAD 6 

No Assignment 

 
  

21.14  Braille 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Back LEFT 

CONTROL + 

LEFT SHIFT + 

COMMA 

No Assignment 

Cycle Attributes LEFT 

CONTROL + 

LEFT SHIFT + 

6 

No Assignment 

Describe Character on / off LEFT 

CONTROL + 

LEFT SHIFT + 

7 

No Assignment 

Forward LEFT 

CONTROL + 

LEFT SHIFT + 

PERIOD 

No Assignment 

Go To Focus LEFT 

CONTROL + 

LEFT SHIFT + 

FORWARD 

SLASH 

No Assignment 

Hooks on / off LEFT 

CONTROL + 

LEFT SHIFT + 

2 

No Assignment 
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Literary Braille on / off LEFT 

CONTROL + 

LEFT SHIFT + 

8 

No Assignment 

Monitor on / off LEFT 

CONTROL + 

LEFT SHIFT + 

1 

No Assignment 

Braille Output on / off LEFT 

CONTROL + 

LEFT SHIFT + 

0 

LEFT 

CONTROL + 

CAPS LOCK + 

0 

Physical / Logical Mode LEFT 

CONTROL + 

LEFT SHIFT + 

9 

No Assignment 

Verbosity Scheme Cycle LEFT SHIFT + 

CAPS LOCK + 

EQUALS 

LEFT 

CONTROL + 

CAPS LOCK + 

V 

Unassigned Commands 

The following is a list of unassigned commands within this category. These 

commands can be manually assigned a key combination or may already 

have an assigned Braille display button combination. Please refer to your 

Braille display hot key list for more information. 

Bottom Half Width Left 

Braille Document Read Back Half Width Right 

Braille Document Read Back 

(Dolphin Cursor) 

Input on / off 

Braille Document Read 

Forward 

Layout on / off 
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Braille Document Read 

Forward (Dolphin Cursor) 

Line Down 

Cell Left Line Down (Dolphin Cursor) 

Cell Right Line End 

Cursor on / off Line Start 

Cursor style Line Up 

Display Characters Line Up (Dolphin Cursor) 

Display Font Colors Routing Button Action 

Display Font Foreground Color Routing Button Action in 

Dolphin Cursor 

Display Font Name Second Routing Button Action 

Display Font Size Second Routing Button Action 

in Dolphin Cursor 

Display Font Style Top 

Eight Dot Six Dot Tracking on / off 

Enhance on / off Tremble Capitals on / off 

Expand Gaps on / off Width Left 

Flush Input Width Right 
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21.15  Quick Navigation Keys for web browsers 

SuperNova coding includes the following list of hot keys for web page 

navigating. The keyboard commands are available using the Dolphin 

Cursor in supported web browsers. The keyboard commands cannot be 

removed or reassigned. 
  

21.15.1  Quick Navigation Keys 

To move to the previous element use Shift + Key 

Move to Hot key 

PlaceMarker A 

Button B 

List box C 

Different element D 

Edit area E 

Form F 

Graphic G 

Heading H 

List item I 

Link K 

List L 

Frame M 

Text block N 

Paragraph P 

Block Quote Q 

Radio R 

Table T 

Unvisited link U 

Visited link V 

Check box X 

Heading level 1 - 6 1 - 6 

Landmark ; (SEMI COLON) 
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21.16  Quick Navigation Keys for Microsoft Word 

SuperNova coding includes the following list of hot keys for supported 

versions of Microsoft Word. You cannot remove or reassign these keyboard 

commands. 
  

21.16.1  Quick Navigation Keys 

To move to the previous element use Shift + Caps Lock + Key 

Move to Hot key 

Bookmark CAPS LOCK + A 

Button CAPS LOCK + B 

Comment CAPS LOCK + C 

Different paragraph style CAPS LOCK + D 

Edit form field CAPS LOCK + E 

Footnote or Endnote CAPS LOCK + F 

Graphic CAPS LOCK + G 

Heading style CAPS LOCK + H 

List item CAPS LOCK + I 

Link CAPS LOCK + K 

List CAPS LOCK + L 

Text box CAPS LOCK + Y 

Normal style paragraph CAPS LOCK + N 

Object (including graphics) CAPS LOCK + O 

Paragraph CAPS LOCK + P 

Revision CAPS LOCK + R 

Table CAPS LOCK + T 

Check box CAPS LOCK + X 

Section break CAPS LOCK + Z 

Note that you may find various Quick Navigation Keys failing when working 

in a protected document. 
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ZoomText to SuperNova product terminology 
guide 

The following table provides a helpful terminology conversion guide for 

ZoomText users transitioning to SuperNova. 

 

ZoomText term SuperNova equivalent 

AppReader Read From Here (see "Read 

continuously" page 44) 

Camera Connect and View (page 105) 

Color Enhancements Color Schemes (see "Make 

the screen easier to see" 

page 29) 

Command Keys Hot Keys (see "Actions" page 

133) 

Cursor Enhancements Highlighting Options ->Cursor 

(page 170) 

DocReader Doc Reader (page 81) 

Dual Monitors Multiple Monitors (see "Visual 

Multiple Monitors dialog box" 

page 177) 

Dye Tint (see "Visual Configure 

Custom Color Scheme dialog 

box" page 166) 

Finder Item Finder (page 154) 

Focus Enhancements Highlighting Options ->Focus 

(see "Make the focus easier 

to see" page 30) 

Font Enhancements Font Smoothing (page 181) 

Freeze Window Hooked Area (see "Create 

static magnified windows to 

display information" page 25) 
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Mouse Echo Announce Text Under Mouse 

(see "Read using the mouse" 

page 46) 

Pointer Enhancements Highlighting Options ->Mouse 

(see "Make the pointer easier 

to see" page 30) 

Pointer Scheme Mouse Pointers (see "Visual 

Mouse Pointers dialog box" 

page 172) 

Text Finder Find with Dolphin Cursor (see 

"Search using the Dolphin 

Cursor Find Command" page 

75) 

Text Processing Text Style Announcements 

(see "Speech Text Style 

Announcements dialog box" 

page 189) 

Text Reading Commands Speak Keys (page 136) 

Typing Echo Character Echo (see "Change 

what is spoken when typing" 

page 47) 

View mode Overview mode (see "Get an 

overview of the magnified 

window position" page 25) 

Window Type Magnifier View (see "Change 

Magnifier view" page 20) 

Web Finder Item Finder (see "Reference" 

page 163) 

Zoom Level Magnification Size (see 

"Change magnification size" 

page 19) 

 

 

 





 

 193 

 

C H A P T E R  2 1  

Reference 

23.1  New Situation Settings dialog box 

Menu: File > New > Situation Settings 

You can create or choose an existing Situation by using options in the 

"New Situation Settings" dialog box. 

Options: 

 Create New Situation radio button. 

You can create a new Situation Setting by selecting this radio button 

and then choosing the "OK" button. This will move you to the next 

step in the creation process. To review all steps in this process please 

refer to the "Create Situation Settings" topic. 

 Use an existing Situation radio button. 

You can change to another Situation by selecting this option and then 

selecting from the available list. Note the Situation list will show only 

those Situation Settings available in the current Application Settings 

file. 
  

23.2  New Application Settings dialog box 

Menu: File > New > Application Settings 

You can create or choose an existing Application Settings file by using 

options in the Application Settings dialog box. 

Options: 

 Create a new settings file radio button. 

You can create a new Application Settings file by selecting this option 

and then choosing the "OK" button. After selecting the "OK" button, 
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you will go to the next step in the creation process. To review all steps 

in this process please refer to the "Create Application Settings" topic. 

 Use an existing settings file radio button. 

You can change to a different settings file by selecting this option and 

then by selecting a file from the available list. You confirm your 

selection by choosing the "OK" button. The settings will apply 

immediately unless you select the option "Use Default Settings in the 

control panel". If you do select this option then your new settings will 

apply when you go back to your application. 
  

23.3  New Map dialog box 

Menu: File > New > Map 

You can create or choose an existing Map file by using options in the 

"Select New Map" dialog box. 

Options: 

 Create a new Map file radio button. 

You can create a new Map file by selecting this radio button and then 

choosing the "OK" button. This will move you to the next step in the 

creation process. To review all steps in this process please refer to 

the "Mapping Guide". This is available through the SuperNova "Help" 

menu. 

 Use an existing Map file radio button. 

You can change to an alternative Map file by selecting this option and 

then selecting a file from the available list. To learn more about the 

reasons why you might change a Map file please refer to the "Change 

Map file" topic. 
  

23.4  New Script menu item 

Menu: File > New > Script 

You can create a new Script file for the current application by selecting this 

menu item. The new Script file will open in the Dolphin Script Editor. The 
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Dolphin Script Editor includes a "Help" menu with options linking to the 

Scripting Guide. 

Note: If a Script file exists for the current application then this menu 

item will be disabled. To view and edit an existing Script file, go to 

the "File" menu, "Edit" sub-menu and select "Script". 

  

23.5  Edit Situation Settings dialog box 

Menu: File > Edit > Situation Settings 

You can delete or change the properties of your Situation Settings by using 

options in the "Situation Management" dialog box. Note that you must be 

using the Application Settings file that has the Situation Settings to be able 

to edit the Situations in that file. 

 Situation list. 

You can choose the Situation you want to edit or delete from this list. 

 Edit Rules button. 

You can edit the rules of a Situation by selecting this  button. This will 

open the "Define Situation Rules" dialog box. In this dialog box you 

can change the name of the Situation, change the title and class 

details of the Situation rule and add and remove Situation rules. 

 Delete button. 

You can delete the current Situation from your Application Settings file 

by selecting this button. After selecting the button you will receive a 

warning message asking you to confirm that you want to proceed. To 

proceed select the "Yes" button or to cancel select the "No" button. 
  

23.6  Edit Application Settings dialog box 

Menu: File > Edit > Application Settings 

You can delete or change the properties of your Application Settings file by 

using options in the "Settings File Management" dialog box. 

 Application Settings file list. 

You can choose the Application Settings file you want to edit or delete 
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from this list. Note that you cannot delete the "Default Application" 

settings file because this is a SuperNova system file. 

 Properties button. 

You can edit the properties of an Application Settings file by selecting 

this  button. This will open the "Settings File Properties" dialog box. 

In this dialog box you can change the name and version number of 

the settings file and add and remove any the applications associated 

with the file. 

 Delete this settings file button. 

You can delete the current Application Settings file by selecting this 

button. After selecting the button you will receive a warning message 

asking you to confirm that you want to proceed. To proceed select the 

"Yes" button or to cancel select the "No" button. 
  

23.7  Edit Map dialog box 

Menu: File > Edit > Map 

You can edit the properties and rules of a Map file by selecting this menu 

item. To learn more about Map files please refer to the Mapping Guide 

available from the "Help" menu of the SuperNova control panel. 

This dialog box also contains Script options. You can create, reload, edit 

and delete Script files and Extension Script files. To learn more about 

Script files please refer to the Scripting Guide. You can open the Scripting 

Guide from the SuperNova control panel "Help" menu. 
  

23.8  Edit Script menu item 

Menu: File > Edit > Script 

You can edit the Script file for the current application by selecting this menu 

item. The Script file will open in the Dolphin Script Editor. The Dolphin 

Script Editor includes a "Help" menu with options linking to the Scripting 

Guide. 
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Note: If no Script file exists for the current application then this menu 

item will be disabled. To create a new Script file, go to the "File" 

menu, "New" sub-menu and select "Script". 

  

23.9  Visual Configure Custom Color Scheme dialog box 

Menu: Visual > Color Schemes > Configure. 

You can create your own color scheme by using options in the "Configure 

Custom Color Scheme" dialog box. 

Note: To open this dialog box you must choose "Custom" as your 

Color Scheme and then choose "Configure" from the list of Color 

Schemes. 

You can create a custom scheme in this dialog box using one of the 

following options: 

 Classic 

 Tint 

 Dual Tint 

 Triple Tint 

 Quad Tint 

 Color Replacement 

The controls available in this dialog box change depending on the custom 

setting you have chosen. 
  

23.9.1  Classic custom color scheme options. 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 
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dark on light screen to a light on dark screen. This option does not 

affect the amount of color on the screen. 

 Contrast slider. 

The "Contrast" slider controls color definition, making light colors 

lighter and dark colors darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colors appear on the 

screen, making light colors more luminous and dark colors darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The luminance Split is the position in the color spectrum where light 

and dark colors divide. Moving the slider to the left means more of the 

colors in the spectrum are classified as being in the lighter spectrum. 

This influences the contrast and brightness values. 

 Color Adjust slider. 

The "color adjust" slider allows you to make general changes to 

screen colors with the exception of white and black. You can use the 

color palette to view the changes that occur as you move the slider. A 

slider position of 0% means screen colors are unchanged. 

 Color slider. 

The "Color" slider allows you to control how much color is on the 

screen. Changing this value means colors either become paler or 

more intense. You can use the color palette to view the changes that 

occur as you move the slider. A slider position of 50% means screen 

colors are unchanged. 

 Preview these color settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
  

23.9.2  Tint, Dual Tint, Triple Tint and Quad Tint custom color options: 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 
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dark on light screen to a light on dark screen. This option does not 

affect the amount of colors on the screen. 

 Contrast slider. 

The "Contrast" slider controls color definition, making light colors 

lighter and dark colors darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colors appear on the 

screen, making light colors more luminous and dark colors darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The Luminance Split is the position in the color spectrum where light 

and dark colors divide. Moving the slider to the left means more of the 

colors in the spectrum are classified as being in the lighter spectrum. 

This influences the contrast and brightness values. When using Triple 

Tint and Quad Tint, additional contrast boundary sliders are available 

to define the boundary for the colors in the middle color ranges. 

 Level slider. 

The "Level" slider allows you to control how intense the tint color is 

applied to the screen. A value of 100%, where the slider is positioned 

to the right, means the tint colors completely replace the current 

screen colors. A value of 25% means the tint colors will be blended 

with the original screen colors at a ratio of 25:75, which creates a 

screen with more shades. 

 Tint color list boxes. 

You will be able to choose from one to four different colors depending 

on whether you have chosen "Tint", "Dual Tint", "Triple Tint" or "Quad 

Tint". The colors you choose become the primary colors for the color 

spectrum relative to the Luminance Split. 

 Preview these color settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
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23.9.3  Color Replacement custom color scheme options: 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 

dark on light screen to a light on dark screen. This option does not 

affect the amount of colors on the screen. 

 Contrast slider. 

The "Contrast" slider controls color definition, making light colors 

lighter and dark colors darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colors appear on the 

screen, making light colors more luminous and dark colors darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The Luminance Split is the position in the color spectrum where light 

and dark colors divide. Moving the slider to the left means more of the 

colors in the spectrum are classified as being in the lighter spectrum. 

This influences the contrast and brightness values. 

 From and To list boxes. 

The "From" and "To" list boxes allow you to replace one color with 

another color. Use the list boxes to make one or multiple color 

replacements. 

 Preview these color settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
  

23.10  Visual Highlighting Options dialog box 

Menu: Visual > Highlighting > Settings 

You can make different types of focus easier to see by adding a highlight 

indicator. You can choose the style, color and behavior of the highlight in 

the "Highlighting Options" dialog box. 
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Mouse tab. 

 Highlight the mouse check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note that 

selecting "On hot key" means you control the highlight using the Foci 

Highlights hot key and selecting "Dynamic tracking" means the mouse 

highlight stays visible until you press a key on the keyboard. 

 Effects group. 

You can choose from different color options. Depending on the option 

you choose you can also control the color(s) and/or the transparency. 
  

Cursor tab. 

 Highlight the Cursor check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note that 

selecting "On hot key" means you control the highlight using the Foci 

Highlights hot key and selecting "Dynamic tracking" means the Cursor 

highlight stays visible until SuperNova is tracking a different type of 

focus, for example, the mouse. 

 Effects group. 

You can choose from different color options. Depending on the option 

you choose you can also control the color(s) and/or the transparency. 
  

Line tab. 
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 Highlight the Line check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note that 

selecting "On hot key" means you control the highlight using the Foci 

Highlights hot key and selecting "Dynamic tracking" means the Line 

highlight stays visible until SuperNova is tracking a different type of 

focus, for example, the mouse. 

 Effects group. 

You can choose from different color options. Depending on the option 

you choose you can also control the color(s) and/or the transparency. 
  

Focus tab. 

The term "Focus" refers to the focus used in dialog boxes and menus. 

 Highlight the Focus check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note that 

selecting "On hot key" means you control the highlight using the Foci 

Highlights hot key and selecting "Dynamic tracking" means the Focus 

highlight stays visible until SuperNova is tracking a different type of 

focus, for example, the mouse. 

 Effects group. 

You can choose from different color options. Depending on the option 

you choose you can also control the color(s) and/or the transparency. 
  

Read From Here tab. 
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Read From Here is a SuperNova reading mode. You can change 

highlighting options for the current word and the current line being read. 

 Word group. 

You must select "Highlight the spoken word" check box to turn on this 

highlighting option. Use the available settings to set how the spoken 

word is highlighted.  

 Line group. 

You must select "Highlight the line" check box to turn on this 

highlighting option. Use the available settings to set how the current 

line being spoken is highlighted. 
  

Dolphin Cursor tab. 

The Dolphin cursor is a special kind of cursor created by SuperNova. The 

Dolphin Cursor allows you to read the contents of the screen line by line, or 

word by word, or letter by letter using your keyboard. You can use the 

Dolphin cursor to review any part of your computer's screen. 

 Current Character group. 

You must select "Highlight the character" check box to turn on this 

highlighting option. Use the available settings to set how the character 

is highlighted. 

 Current Line/Object group. 

You must select "Highlight the line" check box to turn on this 

highlighting option. Use the available settings to set how the current 

line is highlighted. 
  

23.11  Visual Mouse Pointers dialog box 

Menu: Visual > Mouse Pointers 

Available with SuperNova are mouse pointers that are larger and easier to 

see than the usual Windows mouse pointers. The pointers are available in 

a range of different colors and sizes. 

Options: 
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 Scheme list. 

You can choose an existing Mouse Pointer scheme from this list. If no 

existing scheme is suitable, use the other options to create a new 

scheme or modify an existing scheme. 

 Type list and Pointer Image list. 

The "Type" list shows the different pointers in Windows and the 

"Pointer Image" list shows the different images you can apply to the 

selected pointer type. To change a pointer, select the type of pointer 

and then choose a pointer from the images provided. 

 New button. 

Pressing the "New" button will open the "Create New Scheme" dialog 

box. In this dialog box, you enter a new name for the scheme. The 

new scheme name appears in the "Scheme" list. 

 Restore to defaults button. 

If you have modified a default SuperNova scheme, then selecting this 

button will return the scheme back to the SuperNova default pointers 

for the scheme. 

 Delete button. 

If you have created a new scheme, then pressing this button will open 

a message window asking you to confirm that the scheme is to be 

deleted. Choose "Yes" to delete the scheme or "No" to cancel. 

 Custom pointer size group. 

The options in this group allow you to adjust the size of the mouse 

pointers in the current scheme, relative to their default size. 

Use custom pointer size check box. 

If you select this check box the value in the "Size" list will apply to all 

pointers in the current scheme. 

Size list. 

The "Size" list contains a range of values you can apply to the pointers 

in your current scheme. You can choose a fixed size, for example 8, 

which will increase the pointers to 8 times their original size. When a 

fixed value is chosen, the pointers will remain at the same size 

regardless of what magnifier size you have set. Alternatively, you can 

choose a value relative to your magnification level, for example 150%. 

With a relative value, the pointer size will adjust as you increase or 
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decrease your magnification size. At higher magnification levels you 

may find the fixed pointer size occupies too much of the screen, so you 

may benefit from choosing a relative pointer size smaller than the 

original size. 

Use custom pointer in magnified areas only check box. 

If you select this check box then the custom pointer size is only visible in 

magnified areas. It is not visible when you turn off the Magnifier or view 

the unmagnified screen in Views such as Split Screen. 
  

23.12  Visual Doc Reader Settings dialog box 

Menu: Visual > Doc Reader Settings 

The options available in the "Doc Reader Settings" dialog box control the 

Doc Reader reading environment. You can open this dialog box by 

selecting the item in the "Visual" menu or by selecting the "Settings" button 

from the Doc Reader toolbar. 

Options: 
  

 Font settings. 

In the Doc Reader you can define the font that is used to display the 

text within the document window.  You can also state the font size to 

use. 

 Color settings. 

You can define the colors to use in the document window. There are 

three categories to which you can apply a foreground and background 

color too. 

Document colors sets the background and foreground colors used in the 

document window.  However, if "Use document colors" is selected then 

this setting will not be applied. 

Word highlight colors sets the background and foreground colors 

used by the Doc Reader for the current focus.  This shows the 

currently selected word as the Doc Reader reads through the document.  

However, if "Invert word" is selected then this setting will not be applied.  

Instead the highlight will be inverted based on the custom color settings. 
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Unit highlight colors sets the background and foreground colors for 

your specified unit of movement.  This is what is highlighted as you 

cursor down through a document. 

 Fetch whole document check box. 

With the "Fetch whole document" check box selected you will load the 

complete document into the Doc Reader.  Depending on the size of 

the document, this may take a few seconds.  This option is only 

supported in DOM enabled applications such as Microsoft Word, 

Adobe Acrobat Reader, Internet Explorer, NotePad, WordPad, etc. 

It is also possible to specify the number of lines you want to fetch by 

unselecting the "Fetch whole document" check box and then 

specifying the number of lines from the available spin control.  This 

will allow you to load a section of a document faster. 

If you are working in an application that does not include DOM 

support then the Doc Reader will load the content from the current 

screen.   

 Invert word check box. 

With the selection of the "Invert word" check box the focus highlighting 

will be an inverted highlight based on the document colors specified or 

based on the actual document's colors depending on what is currently 

enabled. 
  

 Doc Reader speech check box. 

With this option selected the document will be read using your 

selected "Read From Here voice" stated in the "Voice and language" 

dialog box. You can disable speech output in the document window 

by deselecting this check box. 
  

 Use document colors check box. 

Selecting this check box will mean that the Doc Reader will use the 

colors specified in the document instead of its own custom colors.  

 Use document styles check box. 

Selecting this option will mean styles used in the document will 

appear in the Doc Reader. 

 Wrap line to. list. 

The "Wrap line to" option can be used to insert a line break on a line if 

it exceeds a particular length. This can be useful if lines are scrolling 
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outside the current window. 

To disable this feature set the "Wrap line to" value to 0. 
  

23.13  Visual Connect and View Settings dialog box 

Menu: Visual > Connect and View > Settings 

The "Connect and View Settings" dialog box contains options you can use 

to change how SuperNova works with a camera and a whiteboard. 
  

Cameras tab. 

 Devices list and controls 

Use this list to select a camera to use with SuperNova. Set the value 

to "Off" if you want to prevent the selection of a camera when you 

switch between devices. Use the "Settings" button to optimize the 

camera performance. These options will differ between camera 

models. The following options are available: 

Resolution list 

This lists available resolutions for your connected camera. Increasing 

the Resolution should improve the picture quality shown in the viewer. 

Frame Rate list 

This is listed as frames per second (FPS). The higher FPS means 

frequently changing images appear smoother whereas lower FPS can 

decrease the amount of camera wobble detected, which may bring a 

better document reading experience. 

Anti Flicker list 

This lists 50Hz which is usually selected for Europe and the UK and 

60Hz usually selected for America and Japan. Selecting the correct Hz 

will eliminate flicker caused by florescent lighting that can interfere with 

a camera image.  

Automatic Focusing check box. 

If you find the Auto Focus regularly refocusing then you may wish to 

turn this feature off. Not all cameras include an Auto Focus feature. 

SuperNova will only make the Auto Focus check box available if the 

camera supports this feature. 

 Color Scheme list 

Use this option to apply a default color scheme to the camera viewer. 
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Additional options are also available in the camera viewer to control 

the color Scheme setting. 

 Use Camera Hardware Zoom check box 

Use this option to enable hardware optical zooming for cameras that 

support it (rather than digital zooming). This results in an improved 

magnified image. 

 Use Camera Color Changer check box 

Use this option to enable hardware color changing options for 

cameras that support it (rather than software color changing). 

 Enhance High Contrast Colors check box 

Use this option to boost the contrast of viewed images while using 

one of SuperNova's built in color schemes. (This option is particularly 

useful when viewing pages containing text and diagrams). 

 Auto Freeze Image check box 

Use this option to remove "dancing dots" (also known as "salt and 

pepper" or "impulse" noise) from the camera's video stream 

(especially useful in poorly lit environments) 
  

Whiteboards tab. 

 Devices list and controls. 

Use this list to create, edit or delete a device profile. Set the value to 

"Off" if you want to prevent switching to a whiteboard device. Use the 

"New" button to create a new profile. Use the "Settings" button to edit 

a profile. The following additional options are available when you 

create or edit a profile: 

Profile box. 

Use this box to give the device a meaningful name. You may want to 

name the device after the classroom, teacher or trainer to make it easy 

to select it in the future. Note that the remaining options in this dialog 

box may require information from a Network Administrator. 

Machine Name box. 

Use this box to enter in the name of the host computer as it appears on 

the network. Alternatively, you can also enter in the host computer's IP 

address, however, this is not recommended because of the dynamic 

assignment of IP addresses under most network configurations. 
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Port box. 

By default, Virtual Network Computing (VNC) uses port 5900. You 

should only change this setting if directed to do so by your Network 

Administrator. 

Password box. 

Use this box to enter in the password that allows you to connect to the 

host computer. The assignment of a password is optional and is set in 

the VNC software. Your Network Administrator will be able to provide 

you with this information. 

Connection Type radio buttons. 

Use these controls to select the option that matches your type of 

network connection. You can choose between a local area network 

(LAN) connection and a wireless connection. 

Protocol list. 

There are a number of Remote Frame Buffer (RFB) protocols available 

that are supported by VNC. You should only change this setting if 

directed to do so by your Network Administrator. 

Show Mouse check box. 

Use this setting to control whether the mouse pointer on the host 

computer appears in your viewer. You may want to enable this option if 

you want to see where the mouse pointer is being positioned on the 

screen. You may want to disable this option if the presence of the 

mouse pointer is a distraction. 

The additional options in the "Connect and View Settings" dialog box are 

general settings and apply to all whiteboard interaction, irrespective of the 

chosen device. 

 Color Scheme list. 

Use this option to apply a default color scheme to the whiteboard 

viewer. Additional options are also available in the whiteboard viewer 

to control the Color Scheme setting. 

 Track presenter's position on whiteboard check box. 

Use this option to control the tracking of the focus on the host 

computer. The disabling of this option means that you control the 

movement around the window. You can move around the window by 

using the mouse pointer or by panning around the screen with the 

keyboard. 
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23.14  Visual Multiple Monitors dialog box 

Menu: Visual > Multiple Monitors 

You choose the multiple monitor options in the Multiple Monitors dialog 

box. 

To use multiple monitors, SuperNova requires a graphics card attached to 

the computer motherboard, such as an AGP/PCI or PCIe graphics card. 

The use of USB graphic card adapters is not supported. 

Options: 

 Display mode for extended desktop group. 

You can use the options in this group to choose the most appropriate 

setup for computers where the desktop has been extended onto 

additional monitors. 

Span radio button. 

You can choose this option if you wish to use two monitors to behave as 

one large monitor. In this scenario, one single desktop will span across 

both monitors. 

Side by side applications radio button. 

You can use this mode to display different applications on different 

monitors. When working with side by side applications the following hot 

keys are of help: 

 

Function Hot key 

Jump mouse pointer to the 

middle of the next monitor 

CAPS LOCK + 

MIDDLE MOUSE 

BUTTON 

Move application to right monitor WINDOWS Logo Key 

+ SHIFT + RIGHT 

ARROW 

Move application to left monitor WINDOWS Logo Key 

+ SHIFT + LEFT 

ARROW 
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Presentation Mode check box. 

You use this option to have one monitor showing a magnified screen 

and all the remaining monitors showing an unmagnified screen. For 

example, this will allow you to work on a magnified screen while an 

audience viewing a presentation slide show on the second monitor will 

see an unmagnified screen. 

 Mouse Buffer check box. 

You can use this option to prevent the accidental movement of the 

mouse pointer onto another monitor when you are using an extended 

desktop. You achieve this by creating a level of resistance at the 

screen edge, which means you require additional force to move the 

mouse pointer onto another monitor. You can adjust the level of 

resistance the buffer creates by using the "Resistance" slider. 

 Resistance slider. 

You control the mouse buffer resistance using this slider. The higher 

the level the greater the resistance, which means you have to hold the 

mouse pointer against the edge of the screen for longer to move from 

monitor to monitor. 

 Switch monitor hot key list. 

When working with "Side by side" applications on an extended 

desktop, you may wish to move the mouse pointer quickly from one 

monitor to the next, without panning the magnification away from the 

area of the screen you are currently viewing. To do this, you can use 

the "Switch Monitor" hot key. The default hotkey to switch between 

monitors is CAPS LOCK + MIDDLE MOUSE BUTTON. 

 Add Key, Replace Key and Remove Key buttons. 

You can use these buttons to change the "Switch monitor" hot key. 

 Allow different magnification levels on each monitor check box. 

This option allows you to have independent magnification levels on 

each of your monitors. This is useful for instance when you have two 

monitors of different sizes and you need a little extra magnification on 

the smaller monitor, or when magnifying smaller text in an application 

on one of your other monitors. 
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 Independent colors check box. 

This option allows you to have independent color schemes on each of 

your monitors. This is useful for instance when you have applications 

on each monitor that require different color adjustments to make 

easier to view for you. 

 

When you make your SuperNova magnification level and colors 

independent, in SuperNova's control panel the monitor number that the 

magnification level and color settings belong to will be displayed in the 

"Visual" property sheet (directly underneath the magnification size control). 

 

(Don't forget that you can also make your SuperNova settings 

application-specific). 
  

23.15  Visual Advanced Options dialog box 

Menu: Visual > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Visual Advanced Options" dialog box. 
  

General Preferences tab 

 Highlight Hot Key Action group. 

Visual Highlights can be set to appear in a number of different ways. 

One of these ways is to show the selected Highlights when a hot key 

is pressed. How the hot key behaves when pressed is determined by 

the "Show Highlight" list box. This can be set to "Until Hot Key 

pressed again" or "Until Hot Key released". 

 Fractional Magnification group. 

The "Allow fractional magnification" check box determines whether 

increases in the size of magnification will include fractional values. If 

you turn fractional magnification off, nothing will immediately change. 

Only after the next magnification adjustment will the factor move to 
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the nearest linear factor. 

If you experience issues when using fractional magnification sizes 

then options are available to try and improve performance. 

 Overview Mode group. 

The settings in this group determine how the Magnifier position is 

displayed on the screen when in Overview Mode. The magnified area 

can be inverted or the background can be inverted. In this group 

settings also determine the behavior of the Overview Mode hot key. 

This can be set to "Until Hot Key pressed again" or "Until Hot Key 

released". 

 Video Compatibility button. 

This button will open the "Video Compatibility" dialog box. This dialog 

box contains a number of check boxes for optimizing the speed of the 

magnification and resolving screen corruption problems caused by 

non-compliant video drivers. 

 Mouse Buffer check box. 

The "Mouse Buffer" check box when enabled helps prevent the 

accidental movement of the mouse pointer into or out of your Connect 

and View viewer window when the "Allow mouse pointer to move 

between camera window and desktop" check box is enabled. This is 

achieved by creating a level of resistance at the window border, which 

means you require additional force to move the mouse pointer into the 

other window. You can adjust the level of resistance the buffer creates 

by using the "Resistance" slider. 

 Resistance slider. 

You control the mouse buffer resistance using this slider. The higher 

the level the greater the resistance, which means you have to hold the 

mouse pointer against the edge of the window for longer to move from 

window to window. 

 Allow mouse pointer to move between camera window and desktop 

check box. 

The "Allow mouse pointer to move between camera window and 

desktop" check box when enabled allows your mouse pointer to move 

freely between the Connect and View viewer window and any 

application currently running on your Windows desktop, such as your 

word processor. If this option is unchecked the mouse can be 
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switched between the Connect and View viewer window and your 

Windows desktop using the hot key CAPS LOCK + MIDDLE MOUSE 

BUTTON. 
  

Magnifier tab. 

 Lock Aspect check box. 

If the "Lock Aspect" check box is unselected then you will have two 

spin controls that will allow you to adjust the horizontal and vertical 

magnification size independently. If you turn lock aspect ratio back on, 

the magnification factor will change to the average of the horizontal 

and vertical factors. Note that True Fonts is unsupported when  

working with a different horizontal and vertical magnification size. 
  

 Font Smoothing group. 

Font smoothing improves the legibility of the text on the screen when 

you use magnification. Options include: 

None radio button. 

Choose "None" to turn off Font Smoothing. 

Standard radio button. 

Choose "Standard" for basic font smoothing. Use this option if you are 

experiencing performance issues using True Fonts. 

True Fonts radio button. 

Choose "True Fonts" for perfect clarity at all magnification sizes. You 

may wish to experiment with the True Font Settings if you are using a 

magnification size of 3x or lower or you are using an LCD monitor. 

 True Fonts Settings group. 

Standard radio button. 

Using "Standard" renders text in a non- antialiased mode. This is the 

default and fastest method, especially when using a magnification size 

of 4x or greater. 

Antialiased radio button. 

This setting renders  the text and smooth's the text edges. If you 

experience jagged effects using True Fonts at a low magnification size 

then you should select this option. 
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You can switch between "None", "Standard" and "True Fonts" by using a 

SuperNova hot key. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Font Smoothing LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 

Note that True Fonts is unavailable if you are using a different vertical and 

horizontal magnification ratio. You can independently change the vertical 

and horizontal magnification size by deselecting the "Lock Aspect" check 

box in the "Visual Advanced Options" dialog box. 
  

Tracking tab. 

 Mouse tracking group. 

In this group the "Track mouse pointer" check box controls whether 

SuperNova follows the mouse pointer. When tracking the mouse 

pointer the window will scroll whenever the mouse is moved beyond 

the mouse frame. The distance that it moves will normally be just 

enough so that the mouse ends up at the edge of the screen or 

margin. To adjust the mouse frame, press the mouse frame button. 

This takes you to the Mouse and Foci Frame Dialog Box. 

The "Move mouse pointer into view" check box determines what 

happens when the mouse pointer is currently not visible inside the 

magnified window. With this option selected, when the mouse pointer 

is initially moved, the mouse pointer will be brought to the center of 

the magnified window. If this option is unselected then the magnified 

window will be moved to the mouse pointer's location on the screen. 

If the "Stay in window" check box is selected, artificial mouse 

boundaries are created around the currently selected window. This 

places a restriction on the mouse pointer so the display does not 

easily move away from the current window. These mouse boundaries 

are removed if you move the pointer beyond the edge of the window. 
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 Cursor tracking group. 

The "Track Cursor" check box controls whether the Magnifier follows 

the beam cursor inside edit areas. If this checkbox is selected, the 

magnified window will move to show the area around the cursor as it 

moves. The Cursor Frame (the minimum distance between the beam 

and the edge of the screen) can be set in the Caret Frame dialog box 

by pressing the "Cursor Frame" button. 

 Focus tracking group. 

In this group you can control whether the Magnifier tracks other types 

of Windows controls. Available options are menus, controls and 

windows. 

The "Keep focus in center" check box sets whether any controls that 

are being tracked such as menus and small dialog boxes are to be 

centerd in the magnified window if they fit. If "Keep focus in center" is 

not selected the display will move the minimum amount possible to 

make the object completely visible. 

The "Track Narrator" check box controls whether Windows Narrator's 

focus highlight is tracked when Narrator is running. (Requires 

Windows 10 build 17763 or greater). 
  

Line View tab. 

Line View is a SuperNova reading mode. In this mode the content of the 

visible screen is shown as a single line scrolling across the screen. Line 

View lets you control background and text color, text size and what font to 

use. 
  

Hooked Areas tab. 

Hooked Areas allow you to keep a particular area of the screen 

permanently displayed. This lets you keep an eye on important information 

that may frequently change as you use your application. 
  

23.15.1  Enhancement tab 

Enhancement tab 
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 Font Enhancement group. 

The "True Fonts Bold" check box adds boldness to True Font 

magnified text. 

The "Standard Bold" check box adds boldness to non-True Font 

magnified text, such as the text found in the Windows 10 Start menu 

and in the content pane of Google Chrome and Mozilla Firefox. 

The "Low", "Medium" and "High" radio buttons control the amount of 

boldness added to the magnified text. 

 Image Enhancement group. 

The "Sharpen" check box controls whether SuperNova sharpens 

magnified images (including photographs) as well as non-True Font 

text. 

If the "Sharpen" check box is enabled SuperNova will sharpen 

magnified images and non-True Font text by exaggerating the 

brightness difference along any edges on your screen, thus making 

those edges appear more pronounced. The sharpening process 

works by subtracting a slightly blurred version of your screen image 

from your original screen image in order to detect the presence of 

edges, creating what's known as a "mask". Using this mask the 

contrast along the detected edges is then selectively increased 

leaving behind a sharper image. 

The "Contrast" slider controls the minimum brightness difference  

sharpened. This can be used to sharpen more pronounced edges, 

while leaving more subtle edges untouched. It's especially useful to 

avoid sharpening noise. 

The "Size" slider controls the size of the edges you wish to enhance, 

where a smaller size enhances smaller detail. You'll usually want a 

size setting that's comparable to the size of the smallest detail within 

your image. The key to effective sharpening is finding the right 

settings for making edges appear sufficiently pronounced while 

minimizing sharpening "halos". 

 

Note: The Standard bold and Sharpen options are not available on 

Windows 7. 
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23.16  Speech Voice Preferences dialog box 

Menu: Speech > Voice Preferences 

You can change various Voice settings in the "Voice Preferences" dialog 

box. 
  

General tab. 

 Volume spin control. 

Use the "Volume" spin control to change how loud the voice sounds. 

This value is independent to the computer's own volume setting. 

 Speed spin control. 

Use the "Speed" spin control to change how fast the voice reads. 

 Spelling Speed spin control. 

Use the "Spelling Speed" spin control to select how fast characters 

are spelt. You may wish to set this to a speed lower than your normal 

reading speed to make the spelling of words easier to understand. 

 Increase voice pitch for spelt capitals check box. 

Select this check box to have your reading voice rise in pitch when 

spelling a capital letter. Examples when you are spelling characters 

include when you have Character Echo set to echo each character 

you type, when you move across a line of text a character at a time 

and when you delete a character. Note that this item will not be 

available if your current synthesizer does not support this option. 
  

Synthesizer Configuration tab. 

 Select Synthesizer button. 

Choose this button to open the "Select Synthesizer" dialog box. This 

dialog box lists all synthesizers detected by SuperNova. 

If the only option in the list is 'no Speech Device' then this means 

there are no configured speech synthesizers to choose from. Check 

that your synthesizer is configured correctly and make sure it is 

detected by Dolphin SAM. This is done by choosing "SAM Setup" in 

the "General Advanced Options" dialog box. 
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 Configure button. 

The configure button will open the Driver Configuration dialog box for 

the synthesizer currently in use. 

 Language Configuration list box and Set Language for button. 

Not all speech synthesizers are able to return information about which 

language or languages they have available. If SuperNova determines 

that this is the case, you can use the language configuration box to 

set the language. If SuperNova detects the language then the options 

will be disabled. 
  

Voice and Language Configuration tab. 

The "Voice and Language Configuration" property sheet lets you choose 

different voices for different speech contexts. A speech context is a special 

attribute of the text to be spoken which indicates where it came from or 

what SuperNova feature you are using. 

You may find it useful to have different voices for different contexts. This 

can help remind you what feature you are using or the type of control 

currently being used. 

The set of voices that are chosen here, and which are currently defined are 

saved automatically on a per-synthesizer basis. This means that if you 

change synthesizer you will have a different set of voices, but the voices for 

your first synthesizer are saved and will be used again if you switch back to 

your original synthesizer. 

The options in this property sheet are: 

 Screen Reader group. 

In this group you set the Screen Reader "Language" and "Voice". This 

reflects the language and voice SuperNova will use to speak prompts. 

A prompt is something that is spoken which is not taken from the 

screen. Usually, your screen reader language will match your Access 

System Language. 

 Screen group. 

This group lets you set the synthesizer language and voice that is to 
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be used to read text from the screen. 

You can choose which voice is to be used to read the text from the 

screen when you are in an edit area, prompt area (e.g. dialog box), a 

menu, or when reading text under your mouse. 

You can also use a different voice when a SuperNova feature is being 

used. This will override any other voice chosen for any other area. 

Each of the individual voice list boxes also contains a "No Voice" 

option if you wish to disable speech output for that particular type of 

area. 

 Automatic language switching group. 

The options in this group lets you control automatic language 

switching. Automatic language switching changes the synthesizer 

language to match particular alphabetic scripts; making screen 

reading a more fluent experience.  

If you have the appropriate synthesizer language installed, you can 

automatically switch between many languages including Latin, Arabic, 

Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and Russian 

(Cyrillic) scripts. 

Note that not all synthesizers support this feature. To learn more 

about available synthesizer languages please contact Dolphin or your 

local Dolphin dealer. 

 Load All Default Voices button. 

Pressing the "Load all Default Voices" button sets all voices back to 

the synthesizer's default value. 

 Voice Exceptions. 

Voice Exceptions are a pronunciation correction feature that allows 

you to correct the mispronunciation of certain words by a specific 

speech synthesizer voice. Those pronunciation corrections may 

involve technical words or words originating from a different language. 

When you press the "Edit" button the Voice Exceptions dialog box will 

be displayed, listing any existing pronunciation correction rules for the 

currently selected speech synthesizer voice. In the Voice Exceptions 

dialog box you're able to add, edit and remove pronunciation 

correction rules for the selected speech synthesizer voice. Each 

individual pronunciation correction rule consists of a "Source word", 

e.g. "Dr", and a "Replacement word", e.g. "doctor". A pronunciation 

correction rule can be made case-sensitive by enabling the "Case 

sensitive matching" check box. Examples of case-sensitive rules in 
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English could be: 

 IT; US; VAT; WHO; Polish 

In the above examples, words with uppercase letters are pronounced 

differently if they were written in lowercase. 

 
  

User defined voices tab. 

This property sheet is used to create and modify the speech synthesizer 

voices. You can define your own voices or edit the existing ones. Each 

voice consists of a name and number of synthesizer parameters. The 

actual number of synthesizer parameters, their meaning and possible 

range of values depend upon your synthesizer. 

The options in this property sheet are: 

 Language list box. 

Use this list box to state what language the new voice is to be based 

upon or what language the existing voice that you want to modify can 

be found in. 

 Voice list box. 

The Voice pull-down list box displays a list of all the currently available 

speech synthesizer voices. Choose the voice that you wish to edit or 

delete from this list. 

 Add, Delete and Rename buttons. 

These buttons let you either create a new voice, delete the currently 

selected voice or rename the currently selected voice. 

 Parameters group box. 

The options in this group box set the basic speech characteristics of 

the voice. This is the pitch and intonation. 

 Other Speech Parameters group box. 

This group box contains other more synthesizer-dependent settings. 

These parameters are in a pull-down list entitled "Parameter". Each 

parameter has a value that can be adjusted in the "Value" list box. 
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 Test text edit area. 

The test text is an edit area which contains some text. This text is 

read out every time you change the value of a voice parameter. You 

can edit this text and put in anything you like. This test text lets you 

change parameters and hear what they sound like without the risk of 

changing the voice to something that you can't understand, which 

could occur if you were editing the same voice you were using. 

 Load Default Voices for Current Language button. 

This button loads the default set of voices from the synthesizer. The 

actual set of voices depends upon your synthesizer. The voice names 

used will depend upon your current access system language. 

The voices defined here are unique to SuperNova. They will not appear in 

any other program that uses the same synthesizer. 
  

23.17  Speech Character Echo dialog box 

Menu: Speech > Character Echo 

The "Character Echo" dialog box sets what is to be spoken as you type. 

You can have characters, words, both characters and words or nothing 

spoken. 
  

23.18  Speech Keyboard Announcements dialog box 

Menu: Speech > Keyboard Announcements 

The "Keyboard Announcements" dialog box lets you add key press 

announcements to SuperNova spoken output. 
  

23.19  Speech Text Style Announcements dialog box 

Menu: Speech > Text Style Announcements 

You can specify settings for punctuation announcement, number 

announcement and text attribute announcement by selecting options in the 

"Text Style Announcements" dialog box. This dialog box has multiple tabs, 

dividing settings into different contexts. 
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Contexts: 

 Edit Areas tab has settings you can apply to text in any control 

designed for text input; where you can view, enter, or edit text or 

numbers. Examples include the document window in a wordprocessor, 

a text box on a web page or an entry field in an address book. 

 Prompt Areas tab has settings you can apply to all areas with the 

exception of edit areas and menus. Examples include field labels in 

dialog boxes, message windows and worksheets. 

 Menus tab has settings you can apply to menus. 

 Read From Here tab has settings you can apply to this SuperNova 

continuous reading mode. 

 Dolphin Cursor tab has settings you can apply to this SuperNova 

screen reviewing mode.  

Settings: 

 Punctuation Level list. 

SuperNova groups punctuation characters into specific categories. 

You can change how much punctuation is announced by SuperNova 

by changing the punctuation level. 

 Number Announcement group. 

You can read numbers as digits, pairs or words. If you select "Digits" 

then SuperNova will spell each number, for example, one, two, three, 

four. If you select "Pairs" then SuperNova will read numbers as a two 

digit value, for example, twelve, twenty three. If you select "Words" 

then SuperNova will read numbers in full, for example, one thousand, 

two hundred and twenty three. 

 Announce group 

Blank lines check box. 

You can have SuperNova tell you when the focus is on a blank line by 

selecting this check box. This option applies specifically to edit areas. 
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Capitals check box. 

You can have SuperNova tell you when a capital letter is being used by 

selecting this check box. You choose how SuperNova indicates capitals 

by choosing settings in the "Voice Preferences" dialog box and "General 

Announcements" dialog box. 

Repeats check box. 

You can change how SuperNova reads repeating characters by 

selecting this check box. This applies to punctuation characters and 

symbols and excludes letters and numbers. You control the method 

SuperNova uses to indicate repeated characters by choosing settings in 

the "Repeats" dialog box. 

Color change check box. 

You can have SuperNova tell you about changes in the font color by 

selecting this check box. 

Back color change check box. 

You can have SuperNova tell you about changes in the background 

color by selecting this check box. 

Point size change check box. 

You can have SuperNova tell you about changes in the font size by 

selecting this check box. 

Font change check box. 

You can have SuperNova tell you about changes in the font type by 

selecting this check box. 

Selected check box. 

You can have SuperNova tell you about selection changes by selecting 

this check box. For example, if you select one word in a line of text and 

then press the Read Line hot key, SuperNova will announce the 

selection change. 

Links check box. 

You can have SuperNova tell you when links are part of the text you are 

reading by selecting this check box. Note, this option does not apply to 

web pages. To change the announcement of links on web pages 

requires changes to your verbosity scheme. 

Meaning change check box. 

You can have SuperNova tell you when text is marked as an 

abbreviation, acronym, citation, emphasis, shortquote, strong and 
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monospace by selecting this check box. This option applies to HTML 

content. 

Underline change check box. 

You can have SuperNova tell you when text is underlined by selecting 

this check box. 

Weight change check box. 

You can have SuperNova tell you when text is bold by selecting this 

check box. 

Italics change check box. 

You can have SuperNova tell you when text is italic by selecting this 

check box. 

Strikethrough change check box. 

You can have SuperNova tell you when text is strikethrough by 

selecting this check box. 

Spelling Error check box. 

You can have SuperNova tell you when text is marked as a spelling 

error by selecting this check box. This option applies to Microsoft Office 

and requires you to be showing errors in your document by using 

Office's wavy underline option. 

Grammar Error check box. 

You can have SuperNova tell you when text is marked as a grammar 

error by selecting this check box. This option applies to Microsoft Office 

and requires you to be showing errors in your document by using 

Office's wavy underline option. 

Script change check box. 

You can have SuperNova tell you when text is subscript or superscript 

by selecting this check box. 

Heading change check box. 

You can have SuperNova tell you when a heading style change occurs 

by selecting this check box. 

Text Effect change check box. 

You can have SuperNova tell you about a text effect change by 

selecting this check box. A text effect is a character attribute like 

emboss, shadow or engrave. 

Text Animation change check box. 

You can have SuperNova tell you about a text animation change by 

selecting this check box. A text animation is a character attribute like 
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"Blinking Background", "Las Vegas Lights" and "Marching Red Ants". 

This option applies to Microsoft Office. 
  

23.20  Speech General Announcements dialog box 

Menu: Speech > General Announcements 

You can specify settings for a variety of SuperNova features by selecting 

options in the "General Announcements" dialog box. The availability of 

some options depends on the synthesizer you are using. 
  

 Announce Braille changes check box. 

You can announce the changes you are making to Braille settings 

when you are using hot keys by selecting this check box. This 

includes turning on Braille output, turning on Literary Braille, turning 

on Physical Braille, turning on Enhanced Braille and  your Routing 

button actions. 
  

 Announce magnification changes check box. 

You can announce the changes you are making to magnification 

settings when you are using hot keys by selecting this check box. This 

includes turning on the Magnifier, changing Magnifier View, changing 

Split Screen orientation, Magnifier Size and turning on your Color 

Scheme. 
  

 Announce 'no focus detected' check box. 

You can have SuperNova announce when an application loses focus 

by selecting this check box. An example when an application might 

lose focus is when closing a foreground window fails to place the 

focus in the background window. You can usually resolve this loss of 

focus by pressing ALT + TAB to switch to an open application or by 

pressing WINDOWS KEY + D to place focus on the Desktop. 
  

 Announce text under mouse check box. 

You can have SuperNova read the text under the mouse pointer by 

selecting this check box. To read the text requires you to move the 

mouse pointer to the place where the text is on the screen. 
  

 Announce clipboard actions check box. 

You can have SuperNova announce the results of your cut, copy and 

paste key commands by selecting this check box. SuperNova bases 
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the clipboard announcements on the use of CONTROL + C to copy, 

CONTROL + X to cut and CONTROL + V to paste. If you use different 

keyboard commands then use the options in the "Clipboard key 

mapping" dialog box to define alternative key presses. 
  

 Announce line count when selecting text check box. 

You can count the number of lines you are selecting by selecting this 

check box. Note that this option is only available in areas with a 

supporting Document Object Model (DOM) like NotePad, WordPad 

and Microsoft Word. 
  

 Announce capitals when reading lines check box. 

You can include capital announcements when you read a line of text 

by selecting this check box. You are reading a line of text when you 

are moving focus to a new line, for example, by using keys like UP 

ARROW, DOWN ARROW, PAGE UP and PAGE DOWN. 

Note: To turn on capital announcement you must select the "Capitals" 

check box in the "Edit Areas" tab of the "Text Style Announcements" 

dialog box. 
  

 Use Beeps for Capital Announcement check box. 

By default, SuperNova will describe capital letters by using words. 

Using words is a method all synthesizers support. However, it is also 

possible with some synthesizers to indicate capitals with a sound. If 

this option is available, you can use beeps to indicate capitals by 

selecting this check box. 
  

 Uses sound list. 

If you select the "Use Beeps for Capital Announcement" check box 

then you can choose the sound you would like to use to indicate 

capitals from this preset list. 
  

 Repeats button. 

You can open the "Repeats" dialog box by selecting this button. The 

"Repeats" dialog box lets you control how SuperNova reads repeating 

characters. 
  

 Clipboard key mapping button. 

You can open the "Clipboard key mapping" dialog box by selecting 
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this button. The "Clipboard key mapping" dialog box lets you define 

what keys Windows uses for cut, copy and paste commands. 
  

23.21  Speech Advanced Options dialog box 

Menu: Speech > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Speech Advanced Options" dialog box. 
  

Cursor tab. 

 Use Dolphin Cursor automatically check box. 

This setting lets you turn the automatic Dolphin Cursor on or off. 

The automatic Dolphin Cursor is a special feature that may be 

programmed in as part of a Map file. The Map file can set areas to 

automatically use the Dolphin Cursor when the keyboard focus moves 

to certain parts of your application. This is useful when no application 

focus exists in the designated window. 

You can turn on and off the automatic Dolphin Cursor behavior with a 

hot key. To toggle automatic Dolphin Cursor on and off press LEFT 

CONTROL + 4. 

 Restrict Dolphin Cursor to current area CHECK BOX. 

The Dolphin Cursor can be restricted in its movement so that it cannot 

move outside the current area. This behavior is set in a Map file. This 

check box determines whether the Dolphin Cursor should be 

restricted to the current area or not. 

You can use a hot key to turn on and off this restriction. To toggle this 

option on and off press LEFT CONTROL + 2. Note that this setting will 

only become active the next time you turn the Dolphin Cursor on. 

 Use Automatic Forms Mode check box. 

When this check box is selected you will be automatically switched 

into Forms Mode when you TAB onto an input Field. This enables you 

to fill in forms more easily using the Dolphin Cursor. A hot key can 

also be used to toggle this feature. Press CAPS LOCK + ENTER to 

toggle automatic Forms Mode on and off. 
  

Verbosity tab. 
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SuperNova comes with a number of default Verbosity Schemes. A 

Verbosity Scheme controls what SuperNova tells you about the current 

control type, like a button or check box. In this property sheet you can 

modify an existing Verbosity Scheme or even create your own custom 

schemes. 

You can learn more about modifying or creating your own verbosity 

schemes by visiting the Tutorial pages on the Dolphin web site. 
  

Monitor Markers tab. 

Monitor Markers monitor certain areas of the screen for change. When a 

change occurs then the Monitor Marker will perform a designated action. 

The Monitor Marker and action are set in a Map file. Where a monitor 

marker has been implemented within a map then this should be explained 

in the accompanying support documentation. 

The "Monitor Markers" property sheet can be used to switch individual 

Monitor Markers on or off. 

 Set of markers list box. 

Use this pull down list box to choose a set of Monitor Markers to be 

listed below. You can either list all Monitor Markers for areas that are 

currently displayed on the screen, or a list of Monitor Markers for all 

currently running applications or you can choose to list all the Monitor 

Markers for a specific map file.  

 Marker Action list view. 

This list shows all the Monitor Markers in the selected set. Use the 

check boxes in front of each list item to switch the Monitor Marker on 

or off. 

A hot key can also be used to turn on and off all Monitor Markers. To 

do this press LEFT CONTROL + 5. 
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23.22  Braille General Preferences dialog box 

Menu: Braille > General Preferences 

You can change various Braille settings in the "General Preferences" dialog 

box. 
  

Translation Tables tab. 

 Unicode to Braille Conversion list box. 

Choose from this list the Computer Braille table SuperNova uses to 

translate text to Braille. The language you select is used for both 

Computer Braille output and Computer Braille input. Computer Braille 

strictly uses one Braille cell per character, whatever that character is. 

It is of most use in applications where every character is of 

importance, you need to distinguish each possible character and 

space is not at a premium.  

 Unicode to Literary Braille Conversion list box. 

Choose from this list the Literary Braille table SuperNova uses to 

translate text to Braille. The language you select only applies to 

Literary Braille output. The term Literary Braille covers both grade 1 

and grade 2 Braille tables. Literary Braille is of most benefit when 

reading ordinary text 

 Literary Braille Input list box. 

Choose from this list the Literary Braille table SuperNova uses to 

convert Braille input to text. The language you select only applies to 

Literary Braille input. When you use Literary Braille input, you use 6 

dots and use uncontracted or contracted Braille (depending on the 

chosen input language).  Please note that the Braille characters you 

type will only appear in your document when you press the Braille 

Space key, or another key which is not a combination of Braille dots. 
  

Braille device tab. 

 Select Braille display button. 

Choose this button to open the "Select Braille display" dialog box. This 

dialog box lists all Braille devices detected by SuperNova. 

If no options are in the list then this means there are no configured 
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devices to choose from. Check that your Braille display is configured 

correctly and make sure it is detected by Dolphin SAM. This is done 

by choosing "SAM Setup" in the "General Advanced Options" dialog 

box. 

 Configure button. 

The configure button will open the Driver Configuration dialog box for 

the Braille display currently in use. 

 Scroll Margin spin box. 

The Scroll Margin determines the amount the Braille display will move 

when you press the Read Back or Read forward keys. It is also used 

to scroll the display when a cursor moves beyond the left or right 

edges of the display. 
  

23.23  Braille General Announcements dialog box 

Menu: Braille > General Announcements 

 Braille Changes group. 

Select the SuperNova changes to be output to your Braille display. 

 Delimiters group. 

These two lists allow you to place various shaped Braille characters 

around different types of objects in Physical Mode. Choose the type of 

object from the first list then the characters to use to mark that object 

from the second. 
  

23.24  Braille Input menu and dialog box 

Braille menu > Input 

The Input menu allows you to change the options for the braille input. 

Braille Input controls the action that the braille routing buttons perform. In 

addition certain braille displays allow "Braille Key Input", i.e. using the keys 

on the braille display for typing text.  
  

 Braille keys item. 

This option allows you to type characters by using six or eight buttons 
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on your Braille Display.  The buttons you use to type depend on your 

display, and not all displays have this capability. Six key input can be 

useful if you wish to type without removing your hands from the Braille 

display. Computer code is used for this type of input. 
  

 Literary Input item. 

This option allows you to type characters by using six or eight buttons 

on your Braille Display.  The buttons you use to type depend on your 

display, and not all displays have this capability. It is also restricted to 

supported Braille tables. 
  

23.24.1  Routing Buttons 

The "Input from Display" dialog box allows you to set what the routing 

buttons do on your Braille display and select whether the Braille Input Mode 

is on. 
  

 Routing Button Action group. 

These radio buttons determine what happens when you press a 

routing button on your Braille display. The choices are to perform a 

left mouse click, double click, right click or describe the character at 

that point. 
  

 Second Routing Button Action group. 

These radio buttons determine what happens when you press a 

secondary routing button on your Braille display. The options are to 

perform a left mouse click, double click, right click or to describe the 

character at that point. Not all Braille displays have a second row of 

routing buttons. 
  

23.24.2  Dolphin Cursor Options 

The "Input from Display in Dolphin Cursor Mode" dialog box allows you to 

set what the routing buttons do on your Braille display when using the 

Dolphin Cursor. 
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23.25  Characters 

Braille menu > Characters 

The Characters menu allows you to change various Braille settings to do 

with how characters are shown on the Braille display. This includes the 

Literary Braille Mode and Enhanced Display Mode. 
  

 Literary item. 

 This setting turns the Literary Braille option on or off.  If you turn this 

on, your Braille display will show the Braille in literary Braille, 

otherwise it will use Computer Braille. We use the term "Literary 

Braille" as it covers both grade 1 and grade 2 Braille. 
  

 Enhanced item. 

Use this setting to turn the Enhanced Braille feature on or off. When 

on, any characters which have an attribute other than "normal" will be 

marked, usually by adding a dot 8. 
  

23.25.1  Options 

Characters dialog box. 

The Characters dialog box allows you to change various Braille settings to 

do with how characters are shown on the Braille display. This includes the 

Literary Braille Mode and Enhanced Display Mode. 

Options: 
  

 Cursor Word Contracted check box. 

When in Literary Mode you can choose to have the word containing 

the cursor contracted or uncontracted. This check box toggles this 

setting. If this option is turned off, the word containing the cursor will 

be written using Computer Braille. Having the cursor word 

uncontracted may make editing documents easier. 
  

 Show Capitals check box. 

Some versions of Literary Braille denote capital letters by prefixing the 

letter or contraction with a special sign called a Capital Sign. Other 
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versions of Literary Braille permit the omission of any such notation, 

thus saving space. 
  

 8-dot Braille check box. 

The ‘8 Dot Braille check box’ toggles between using eight-dot or 

six-dot Braille. This is mainly useful when using Computer Braille, 

where, for example, the lower two dots can be used to show capital 

letters and other special symbols. For example, in several Computer 

Codes, capital letters are denoted by adding a dot 7 to the regular 

Braille symbol for the letter. You may prefer to use six-dot Braille if 

you have difficulty reading the eight-dot version. 
  

 Tremble Capitals check box. 

This option, which is particularly useful when in six-dot Braille, makes 

capital letters on your Braille display blink. The blink rate of any such 

characters is governed by the Blink Rate setting in the Cursor Dialog 

Box. 
  

 Enhanced group. 

The Enhanced Characters options determine what exactly constitutes 

an "Enhanced" character. Select those attributes you want to be 

shown. 

 Style list. 

Style allows you to select how the enhanced characters are shown. 

By default dot 8 is added to the character. Other options include dot 7 

and dot 7 and 8.  
  

23.26  Braille Layout menu and dialog box 

Braille menu > Layout 

The options in this menu allow you to configure the Layout of the Braille 

display. 
  

 Physical Mode item. 

This option switches between Physical Mode and Logical Mode. 

Physical mode provides the opportunity to determine the physical 

layout of objects on the screen.  Logical mode shows the logical 

association of any incidental text with the focus. This is similar to the 
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speech output. This mode is particularly useful for working with dialog 

boxes, as the screen reader will associate the text labels in a dialog 

box with their corresponding controls. 
  

 Tracking item. 

This check box determines whether the Braille display follows the 

movement of the focus in Physical Mode as you use your application. 

Normally, you would have Tracking turned on, but you might want to 

turn it off, for example, when you want to monitor a certain region on 

the screen. 
  

23.26.1  Options 

Layout dialog box. 

The options in this dialog allow you to configure the Physical Mode of the 

Braille display.  They include options such as whether lines of text are 

wrapped as you navigate forward and back, whether start and end of line 

markers are shown and whether the physical layout of the screen is 

displayed. 
  

 Forward and Back Wrapping check box. 

This check box sets whether the Read Forward and Read Back keys 

will move through the lines on the screen when in Physical Mode. If 

this option is turned off, these two hot keys are limited to the current 

line. However, if wrapping is turned on, you will be able to read 

through the whole window by using just the Read Back and Read 

Forward keys. 
  

 Show complete words only check box. 

Typically, lines of text on the screen are longer than the length of 

Braille displays, meaning that a Braille display can only show a portion 

of a line at a time. To see the next portion, you press the Braille Move 

Forward key. This can result in words being split over the end and 

beginning of the Braille display as you move forward. 

Selecting "Show Complete Words Only" will prevent words being 

truncated because they do not fit on the Braille display. This is 

especially helpful if you use contracted Braille codes such as UK 

Grade 2 Braille. This option means the scroll margin position is 

adjusted based on the positions of words. 
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If you move forward but the next word does not fit on the Braille 

display then a gap will be shown after the last character in the last 

word on the display. This makes it easier for you to click beyond the 

end of the last word shown. It also gives more of a clue that this is the 

end of the word. 

When there are multiple spaces or gaps that span multiple Braille 

cells, it may be the case that when moving forward or back that the 

text does not begin in the extreme left hand cell. 

Where the word exceeds the total number of Braille cells then the 

word will appear truncated on the Braille display, that is, it will behave 

as if "Show Complete Words Only" is unselected. It is also possible 

that large amounts of the display can appear blank. 
  

 Start and End Marker check boxes. 

These two check boxes determine whether there is a marker symbol 

placed at the start and end of lines of text when in Physical Mode. 

This can be useful when Wrapping is on and you wish to know when 

you move from one line to another. 
  

 Show Layout check box. 

This check box turns the Layout option on and off for Physical Mode. 

With Layout on, the characters on the line are placed on the Braille 

display as closely as possible to their screen layout. This may result in 

some compression or expansion. If Layout is turned off, the Braille 

display will just show the characters and the gaps (for example 

between columns), but the layout may not correspond exactly to the 

screen layout. 
  

 Expand Gaps check box. 

When Show Layout is turned off, this setting determines whether gaps 

in a line of text are shown on the Braille display. 
  

 Pixels per Cell in Gaps list. 

With Show Layout turned off, this option determines how many Braille 

cells should be used for gaps in lines of text. 
  

 Layout methods check boxes. 

The Phrases, Words and Characters check boxes determine the way 

the characters are positioned on your Braille display in Physical Mode 

when Show Layout is turned on.  Each item (a phrase, word or 

character) is positioned in the cells that it occupies. 
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 Expand into Gaps check box. 

This check box allows a set of characters to flow into the gap that 

follows it, if Show Layout is turned on. This may result in slightly less 

compression of the characters being necessary, but the gaps between, 

say, two columns of text, will not be the correct width. 
  

 Display Dashes check box. 

In Physical Mode, with Show Layout turned on, if any expansion is 

necessary, the extra space the text should occupy will be filled with 

dashes. This check box determines whether these dashes are shown 

or not. 
  

 Layout Length list. 

The Layout Length is the number of Braille cells to distribute across 

the entire width of the screen. The amount of space one Braille cell 

represents is the total screen resolution divided by this number. 

For example, if you had an 800-pixel screen resolution, and a Layout 

Length of 80, each cell on the Braille display would represent 10 

pixels. 
  

23.27  Braille Status Cells dialog box 

Menu: Braille > Status Cells 

The "Status Cells" dialog box sets what is to be shown on your Braille 

display Status Cells. 

Select the items you want displayed. Each option takes one cell. 
  

 Features on Display check box. 

This status cell shows the current setting of various modes of the 

Braille system, including the Attribute Modes, Literary Braille, Physical 

Mode and Tracking. 

The top four dots show which of the Attribute modes is active: If this is 

blank, the display is showing characters (normal). Letters A to E 

represent the five attribute displays available using the Cycle 

Attributes key. Letter F represents the Describe Character mode. 

The lower four dots show other settings, as follows: 

- Dot 3: Raised if in Literary Braille, otherwise Computer Braille. 

- Dot 6: Raised in Physical Mode, otherwise Logical Mode. 
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- Dot 7: Raised if the display currently shows the focus. 

- Dot 8: Raised if Tracking is on. 
  

 Cursor Position check box. 

This status cell shows the position of the cursor along a line of text 

when in an edit area.  

The upper four dots represent the tens and the lower four dots show 

the units. For example dots 245678 show that the cursor is at position 

0 (the extreme left).  Please note that the number of characters 

which will fit on a line depends on the font size and size of the 

window. 
  

 Focus Type check box. 

This status cell indicates the type and state of the focus control. This 

is particularly useful in Physical Mode. 
  

 Attributes check box. 

The various Attribute check boxes display the attributes of the 

character under the cursor in an edit area. The information is exactly 

the same as for the Attribute Modes function. 
  

23.28  Braille Cursor menu and dialog box 

Braille menu > Cursor 

The Cursor menu allows you to change how the cursor appears on the 

Braille display. Most of these settings only apply when editing text in an edit 

area. 

Options: 

 Visible item. 

This setting determines whether the cursor is shown on the Braille 

display. In an edit area, the Braille cursor is a single cell, which 

appears superimposed on the character at the insertion point. 

When not in an edit area and the Braille display is set to Physical 

Mode, the "cursor" is taken to be the current focus. All the characters 

in the focus are underlined with dots 78. 
  



 

Reference 239 

 

23.28.1  Style 

The "Cursor Style" dialog determines the appearance of the cursor. The 

settings include the shape and blink rate to be used to indicate the cursor 

position and the style to be used when in physical Braille mode. 

  Shape list. 

This pull down list box determines the shape of the cursor when in an 

edit area. Available options include: Dot 8; Dots 7 and 8; All Dots; 

Blinking Dot 8; Blinking Dots 7 and 8; Blinking All Dots. 

The cursor is superimposed on the current character. Thus, the larger 

the cursor, the easier it is to find, but the harder it is to read the 

character under it. 

 Blink rate list. 

The Blink Rate listbox sets the speed of the blinking cursor and any 

blinking text on your Braille display.  The higher the number, the 

faster the blink rate. 

 Physical Focus Style list. 

The "Physical Focus Style" pull down list box allows you to select how 

SuperNova indicates the position of the focus when you are in 

physical braille mode. Available options include: Dot 8; Dots 7 and 8; 

Dot 7; Blinking Dot 8; Blinking Dots 7 and 8; Blinking Dot 7. 
  

23.29  Braille Advanced Options dialog box 

Menu: Braille > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Braille Advanced Options" dialog box. 
  

On screen Braille tab. 

You set the size and position of the window for the "Show Braille On 

Screen" option here. 
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This small window mirrors the content of the Braille display. 
  

23.29.1  Verbosity tab (Braille) 

Verbosity tab. 

SuperNova comes with a number of default Verbosity Schemes. A 

Verbosity Scheme controls what SuperNova tells you about the current 

control type, like a button or check box. In this property sheet you can 

modify an existing Verbosity Scheme or even create your own custom 

schemes. 

You can learn more about modifying or creating your own Verbosity 

Schemes by visiting the Tutorial pages on the Dolphin web site. 
  

23.29.2  Hooked Areas tab (Braille) 

Hooked Areas tab. 

Braille Hooked Areas can monitor certain areas of the screen and output 

this data to the Braille display. A Braille Hooked Area is set in a Map file 

and is commonly configured for bespoke applications like Telephony 

programs. Where a Braille Hooked Area has been implemented within a 

map then this should be explained in the accompanying support 

documentation. 

The "Hooked Areas" property sheet can be used to switch individual Braille 

Hooked Areas on or off. 

 Set of Hooked Areas list box 

Use this pull down list box to choose a set of Hooked Areas to be 

listed below. You can either list all areas currently displayed on the 

screen or available in the currently running applications. 

 Braille Hook Action list view. 

This list shows all the Hooked Areas in the selected set. Use the 

check boxes in front of each list item to turn the Hooked Area on or off. 
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A hot key can also be used to turn on and off all Braille Hooked Areas. 

To do this press LEFT CONTROL + LEFT SHIFT + 2. 
  

23.30  Media Scan and Read Settings dialog box 

Menu: Media > Scan and Read > Scan and Read Settings 

The "Scan and Read Settings" dialog box contains options you can use to 

change how SuperNova saves and converts scanned documents. 

Options. 

 Scanner list. 

The "Scanner" list shows the list of scanners available on the 

computer. You must ensure the selected scanner matches the 

scanner you are using with SuperNova. 

 Language list. 

The "Language" list refers to the language of the text you are 

scanning. If you are scanning text in a foreign language then, for best 

results, you must ensure this setting matches the language of the text 

being scanned. 

 Color list. 

The "Color" list allows you to change the color setting for the scanner. 

For best results, ensure the value as closely matches the print color 

being scanned, for example, if you are scanning a plain letter then 

using "Black and white" will bring the most accurate recognition. 

 Paper list. 

The "Paper" list relates to the size of paper you are scanning. For best 

results, ensure the paper size matches the size you are scanning. 

 Scan and Read Output Folder box. 

This edit box states the location where SuperNova saves the 

converted documents. Use the browse button to change the folder 

location. 
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23.31  General Startup Preferences dialog box 

Menu: General > Startup Preferences 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Startup Preferences" dialog box. The availability of some 

options depends on the synthesizer you are using and whether you are 

running a local, network or USB edition of SuperNova. 

Options 
  

 Launch SuperNova after logon check box. 

You can set your computer to automatically run SuperNova after you 

log into your user account by selecting this check box. 
  

 Disable splash screen at startup check box. 

You can stop the SuperNova splash screen showing by selecting this 

check box. A splash screen is an image that appears while a 

computer program is loading. 
  

23.31.1  Disable sounds at startup 

 Disable sounds at startup check box. 

Enabling this check box stops SuperNova from playing a startup 

sound every 5 seconds until it finishes loading (so that you know the 

program is still loading). 
  

 Magnifier at user logon check box. 

You can magnify the Windows Logon Screen by selecting this check 

box. After selecting this check box, the next time you restart your 

computer you will have a SuperNova toolbar showing on the Windows 

Logon Screen. You can use the mouse to click the toolbar buttons to 

adjust magnification or press F7 to reduce magnification and F8 to 

increase magnification. 

Note: Magnification at the Windows Logon Screen is only possible by 

having a SuperNova component running as a Windows service. You 

cannot run a full program at the Windows logon screen because of 

Windows security restrictions. 
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 Show magnification buttons at logon check box. 

You can hide the SuperNova toolbar that appears at the Windows 

Logon Screen by deselecting this item. 
  

 Announce when loaded check box. 

You can announce "SuperNova loaded" when SuperNova finishes 

loading by selecting this check box. 
  

 Load all SAM drivers at startup check box. 

You can have SAM check for all supporting devices each time it starts 

by selecting this check box. Note that this can make the launching of 

SuperNova slower because it waits for SAM to complete its detection 

process. You should only select this check box if you are regularly 

changing your output devices. 
  

 Always save user settings check box. 

By default, SuperNova will automatically save changes you make to 

SuperNova settings. You can prevent this behavior by deselecting the 

"Always save user settings" check box. When this check box is 

unselected then you must manually save the changes you make. You 

can do this by selecting the "Save Settings" option in the "File" menu. 

  

 
  

 Ask user check box. 

The "Ask user" check box becomes available when you deselect the 

"Always save user settings" check box. If you select the "Ask user" 

check box, then SuperNova will ask you if you want to save the 

changes you have made when you quit SuperNova. 
  

Braille at user logon check box. 

You can add Braille support to the Windows Logon Screen by selecting this 

check box. To successfully use a Braille display at the user logon screen 

requires you to initially configure SuperNova to detect the display. 
  

 Voice at user logon check box. 

You can add speech support to the Windows Logon Screen by 

selecting this check box. After selecting this check box, at the 
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Windows Logon Screen you can use the following hot keys to control 

speech: 

Press F1 to announce the available hot keys. 

Press F2 to mute the voice. 

Press F3 to repeat the last speech output. 

Note: Speech at the Windows Logon Screen is only possible by 

having a SuperNova component running as a Windows service. You 

cannot run a full program at the Windows logon screen because of 

Windows security restrictions. 
  

23.32  General Update Settings dialog box 

Menu: General > Update Settings 

The "Update Settings" dialog box sets when SuperNova automatically 

checks for updates. SuperNova can check daily, weekly, monthly or never. 

You can also keep SuperNova up-to-date by selecting "Check for Updates" 

from the "Help" menu. 
  

23.33  General Control Panel dialog box 

Menu: General > Control Panel 

The "Control Panel" dialog box contains global settings to control the 

SuperNova user interface. 
  

 Access System Language list. 

This list box lets you change the SuperNova system language. This 

includes all of the text in the SuperNova control panel, synthesizer 

output language and help files. 
  

 Enable helpful warnings check box 

This checkbox switches the helpful warnings on or off. An example for 

a helpful warning is the graphics training: If you press the hot key for 

graphic training but graphic training is switched off you can get a 

warning. 
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 Enable help messages check box. 

Help messages can appear to guide you through specific tasks.  If 

this option is unselected then these messages will not appear.  It is 

also possible to disable specific help messages when they appear by 

unselecting the "Do not show this message again" check box within 

the message window itself. 
  

 Use Default Settings in the control panel check box. 

By default, you will use the current SuperNova settings when going 

through the SuperNova control panel. This lets you experience the 

effects of change to settings as they happen. 

In some cases, settings you wish to use in your application may not 

be suitable for the SuperNova control panel. Selecting this check box 

means SuperNova will switch to use the Default Application settings 

and not your custom Application Settings. 
  

 Hide when minimized check box. 

You can prevent the SuperNova control panel being on the Taskbar 

and part of the "Switch To" dialog box by selecting this check box. 

You can continue to access the SuperNova control panel with the 

"Open control panel" hot key or through the System Tray. 
  

 Menu bar and Button Bar Style radio buttons. 

You can show the SuperNova control panel only as a menu bar or as 

a menu bar and button bar. The Button Bar Style includes large 

graphical buttons which offer easy access to the main SuperNova 

settings. 
  

 Status bar check box. 

You can hide the status bar that is part of the SuperNova control 

panel by deselecting this check box. 

The status bar contains information about the application and the 

current settings file in use. All changes you make in the control panel 

apply to this settings file. 
  

 Always on top check box. 

If this setting is enabled then the SuperNova control panel will always 

be on top of other windows.  
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 Start with panel ... radio buttons. 

You can control the appearance of the SuperNova control panel when 

SuperNova starts. You can set the control panel to be showing, 

minimized or at the same position when you last closed SuperNova. 
  

23.33.1  Control Panel Theme 

 Control Panel Theme list. 

This list box lets you change the colors displayed in SuperNova’s 

control panel by allowing you to select one of a number of pre-defined 

color schemes. The default setting is "System Colors", which makes 

SuperNova use the colors of your currently chosen Windows color 

scheme. 
  

23.34  General Keyboard dialog box 

Menu: General > Keyboard and Hot Keys > Keyboard 

You can specify what keyboard layout and hot key set you want to use in 

the "Keyboard" dialog box. 

Options: 

 Keyboard list. 

The "Keyboard" list box sets the keyboard type. This does not have to 

be a true reflection of the keyboard you are using. 

 Language list. 

The "Language" list box should match your Windows keyboard layout. 

The value relates to Keyboard Announcements and hot key 

assignments. 

 Set list. 

The "Set" list box specifies the hot key set to be used. The sets 

available will be restricted by the selections in the "Keyboard" list and 

"Language" list. 

 Restore default hot keys button. 

You can restore any changes you may have made to a hot key set by 

selecting this button. 
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 Num Lock On enables Number Pad keys check box. 

You can enter numbers using your keyboard's Number Pad by 

selecting this check box. If you do select this option then turn the Num 

Lock Off to use SuperNova hot keys that use the Number Pad. 
  

23.35  General Hot Keys dialog box 

Menu: General > Keyboard and Hot Keys > Hot Keys 

 You can add, replace or remove any hot key assignments to SuperNova 

commands by using options in the "Hot Keys" dialog box. Note that the list 

of commands are global commands. Hot keys defined in Scripts and Maps 

cannot be changed using this dialog box. 

To learn more about modifying hot keys, see the "Resolve Hot Key 

Conflicts" topics in this user guide. 
  

23.36  General Touchscreen Settings dialog box 

Menu: General > Touchscreen Settings 

The "Touchscreen Settings" dialog box contains options that you can use 

to adjust the SuperNova touchscreen experience. 
  

General tab. 

 Double tap timeout slider. 

This setting controls the duration between first and second taps for 

the gesture to be considered a double tap action. You can increase 

the time allowed between the first and second taps by moving the 

slider to the right. 

 Jitter Margin slider. 

The Jitter Margin is The distance an initial touch can wander before 

SuperNova thinks you are performing a swipe gesture. You can 

increase the allowable distance by moving the slider to the right. 
  

Magnification tab. 
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 Display Touch Bar check box. 

The SuperNova Touch Bar is a touchscreen toolbar that appears at 

the bottom of the screen when you do a 3 finger  single tap. As well 

as using the gesture, you can also control the appearance of the 

Touch Bar by adjusting the status of this check box. 

 Flick Inertia slider. 

Performing a single finger swipe moves the magnified screen with 

inertia. The faster you perform the swipe the further the SuperNova 

magnified screen travels. This slider controls the level of resistance 

SuperNova applies to the motion. You can reduce the level of 

resistance by moving the slider to the right. 

 Auto-Scroll Zone Width slider. 

The "Auto-Scroll Zone Width" is the distance your finger needs to be 

from the edge of the screen before SuperNova starts automatically 

scrolling the rest of the screen into view. You can increase the size of 

the margin by moving the slider to the right. 

 Auto-Scroll Zone Speed slider. 

The "Auto-Scroll Zone Speed" sets how fast SuperNova starts 

automatically scrolling when your finger enters the auto-scroll zone. 

You can increase the auto-scrolling speed by moving the slider to the 

right. 

 Pass-Through Timeout slider. 

The "Pass-Through Timeout" is the duration before which a press 

turns into a pass-through gesture. 

 Automatically Scroll applications check box. 

This setting controls whether a swipe gesture automatically scrolls the 

content within an application window when the magnified window is at 

the edge of the screen. For example, if you are reading a web page 

and the magnified window is at the bottom of the screen, performing a 

swipe will automatically scroll the web page, bringing more content 

into view. Applications that support this feature include the Start 

Screen, Internet Explorer, Adobe Reader and Microsoft Word. 
  

On Screen Keyboard tab. 
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 Automatically Open in Desktop Apps check box. 

SuperNova automatically shows the onscreen keyboard when you 

need to type and you do not have a keyboard connected to the device. 

You can turn off the automatic appearance of the onscreen keyboard 

when you are using desktop applications by deselecting this setting. 

With this setting turned off, you can still make the keyboard appear at 

any time by tapping the Keyboard button in the SuperNova Touch Bar 

or by tapping the Keyboard button in the Windows Notification area. 

 Color Scheme list. 

You can change the appearance of the SuperNova onscreen 

keyboard by choosing an alternative color scheme from this list. The 

color schemes available offer large print high contrast color 

combinations to make it easy to view the keyboard. 
  

23.37  General Web Settings dialog box 

Menu: General > Web Page Settings 

You can change how SuperNova interacts with a web page by changing 

web page settings. The settings you choose can apply to a single web 

page, a web site or to all web pages. 
  

 General settings. 

You can set how SuperNova detects elements on a web page by 

changing "General" settings. For example, the detection of a table can 

be disabled by deselecting the "Announce tables ..." check boxes. 
  

23.38  General Advanced Options dialog box 

Menu: General > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "General Advanced Options" dialog box. 
  

System Configuration tab 
  

 Windows Settings button. 

SuperNova makes some changes to your system to ensure best 
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accessibility. You can disable any of the changes made by selecting 

this button to open the "Windows Settings" dialog box and deselecting 

any listed item. 
  

 SAM Setup button. 

You access the "Configure SAM" dialog box by selecting this button. 

SAM allows you to turn on or turn off the detection of speech and 

Braille devices and to configure the SAM driver for each device. 

 Close SAM on exit check box. 

Dolphin SAM is a separate component of SuperNova. You can quit 

Dolphin SAM when you quit SuperNova by selecting this check box. 
  

Detection Settings tab 
  

 

 Actions button. 

This button will open the "Action list" dialog box. The Action List dialog 

box lets you adjust the global actions. You can also edit and delete 

actions. For more information please refer to the Mapping Guide 

support documentation. 

 Graphic Objects button. 

This button will open the "Graphics Database" dialog box. This dialog 

box lists any graphics that you have manually trained. You can edit 

and delete graphics from this dialog box. 
  

 Allow remote mapping check box. 

You can enable remote mapping by selecting this check box. This 

allows computers running the Dolphin remote training utility to connect 

to your computer. 

For security reasons, if you enable this option it will be automatically 

turned off when you quit SuperNova. 

 Read in columns if present check box. 

You can organize the screen into columns based on SuperNova's 

internal detection system by selecting this check box. This influences 

the reading options in SuperNova in areas with no Document Object 

Model (DOM). 
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23.39  Item Finder dialog box 

Menu: General > Item Finder 

You can use the Item Finder to list certain objects in an application window. 

You can then select the objects and perform actions upon them. Examples 

include clicking a link on a web page or moving to a heading in a 

document. 

You can use the item finder in programs like Microsoft Office and Windows 

Internet Explorer. 

If you are in an application that does not support the Item Finder then the 

Item Finder is disabled. 

To learn more about the Item Finder and the support it offers for your 

application see the SuperNova Help available for your application. 
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